Tekla Structures 2017
Advanced modeling

March 2017

©2017 Trimble Solutions Corporation
## Contents

1 Organizer .......................................................................................................................... 9

1.1 View object properties in Organizer ........................................................................... 10

View the objects selected in the model or the objects of a category ......................... 11
View another property template ................................................................................. 12
Set the default property template .............................................................................. 12
Pin the current template in Object Browser .............................................................. 12
Group object properties ............................................................................................ 13
Show assembly content ............................................................................................ 13
Combine identical rows ............................................................................................ 14
Show calculated results of object property values in the sum row .............................. 14
Use colors to visualize Object Browser groups in the model ................................. 15
View categories, and unions and intersections of categories ..................................... 15
List the categories of objects ...................................................................................... 16
Hold the current view in Object Browser and remove objects and categories from the view .......................................................... 16
Select the command buttons shown in Object Browser ............................................... 16
Change the order of columns..................................................................................... 17
Change the sorting direction ..................................................................................... 17
Group object properties in Organizer ....................................................................... 17
Calculate property values in Organizer .................................................................... 19
Set the units in Organizer .......................................................................................... 20

1.2 Report object property values from Organizer ....................................................... 21

1.3 Create a property template in Organizer .................................................................. 25

Create a custom property in Organizer ..................................................................... 28
Create a custom formula in Organizer ...................................................................... 29
Create a color set in Organizer .................................................................................. 31
Delete a property template in Organizer ................................................................... 32

1.4 Import a property template to Organizer ............................................................... 33

1.5 Export a property template from Organizer .......................................................... 33

1.6 Categories in Organizer ......................................................................................... 34

Create location categories in Organizer .................................................................... 36
Create location categories manually in Organizer .................................................... 41
Create a property category in Organizer ................................................................... 42
Create a custom category in Organizer .................................................................... 46
Create automated subcategories in Organizer .......................................................... 49
Modify a category in Organizer ................................................................................ 50
Delete a category in Organizer .................................................................................. 55
Customized default setup for Organizer .................................................................... 55
Excluding object types from Organizer ..................................................................... 58

1.7 Synchronize Organizer with the model ................................................................. 58

Synchronize Organizer .............................................................................................. 59
Update the whole Organizer database ....................................................................... 59
Reload Object Browser ............................................................................................... 60
Synchronize a category .............................................................................................. 60
2.5 Export tasks and task types from Task Manager ........................................ 126
2.6 Print a task schedule from Task Manager .................................................. 126
2.7 Example: Visualize a Task Manager schedule in the model ..................... 127

3 Phase Manager .................................................................................... 130
3.1 Divide the model into phases ................................................................. 130
3.2 Lock and unlock objects in specific phases .......................................... 131
3.3 Custom phase properties ...................................................................... 132

4 Lotting .................................................................................................. 133
4.1 Create a lot .......................................................................................... 134
4.2 Remove parts from a lot ..................................................................... 134
4.3 Add parts to a lot ................................................................................ 135
4.4 Delete a lot ........................................................................................ 135

5 Sequencer .......................................................................................... 136
5.1 Create a sequence................................................................................ 136
5.2 Add parts to a sequence ..................................................................... 137
5.3 Check the sequence of a part ............................................................... 138
5.4 Modify the sequence number of a part .............................................. 138
5.5 Delete a sequence ............................................................................. 139

6 Project Status Visualization ................................................................. 140
6.1 Create a visualization .......................................................................... 140
6.2 Copy visualization settings to another model .................................... 141
6.3 Delete visualization settings ............................................................... 141
6.4 Project status visualization example: Visualize the erection schedule of a project .......................................................... 142
   Project status visualization example: Define an erection schedule ............. 142
   Project status visualization example: Select objects for the visualization ... 143
   Project status visualization example: Define the color and transparency of selected objects .......................................................... 144
   Project status visualization example: Define a time period for visualization ... 144
   Project status visualization example: View the erection schedule ............. 145

7 Profiles ............................................................................................... 149
7.1 Profile types ...................................................................................... 149
7.2 Manage profiles .................................................................................. 150
   Important buttons in the profile catalog .................................................. 150
   Group profiles together ......................................................................... 151
   Add a rule to the profile catalog ........................................................... 151
   Modify a rule in the profile catalog ......................................................... 152
   Add user attributes to profiles ............................................................... 153
   Example: Add a user attribute to a profile and use it in a rule .............. 154
   Associate profile types with a certain material ..................................... 156
   Delete a profile from the profile catalog .............................................. 157
7.3 **Import and export profiles** ................................................................. 158
  Import profile catalog items...................................................................... 159
  Export an entire profile catalog............................................................... 160
  Export a part of the profile catalog......................................................... 160
  Example of profile export file................................................................... 161
  Units used in import and export............................................................... 163
  Import and export sketched profiles....................................................... 164
    Import sketched profiles................................................................. 164
    Export sketched profiles................................................................. 165

7.4 **Create your own profiles** ............................................................... 165
  Create user-defined cross sections......................................................... 166
    Define a cross section using polygon.................................................. 166
    Define a cross section using a plate.................................................... 168
    Define a cross section using a DWG file............................................. 170
    Modify a user-defined cross section.................................................... 171
  Create fixed profiles............................................................................... 172
    Create a fixed profile.......................................................................... 172
    Create a fixed profile by copying....................................................... 174
    Create a fixed profile based on a parametric profile.......................... 175
    Modify a fixed profile.......................................................................... 175
  Create parametric profiles using .clb files................................................ 176
    How the .clb, components.clb and profitab.inp files work together.......... 176
    Define the shape and point coordinates of the profile....................... 177
    Create the .clb file............................................................................ 180
    Add profile definitions to the profitab.inp file....................................... 182
    Properties used in profitab.inp............................................................ 183
  Create parametric profiles by sketching.................................................. 184
    Open the sketch editor........................................................................ 184
    Sketch the outline of a profile............................................................ 187
    Refine the shape of a sketched profile................................................. 189
    Add dimensions to a sketched profile.................................................. 193
    Define positioning planes for a sketched profile............................... 197
    Check a sketched profile..................................................................... 202
    Save a sketched profile....................................................................... 203
    Modify a sketched cross section........................................................... 204
    Use sketched profiles in a model......................................................... 206
      Example: Create a symmetric C-shaped profile.................................. 207
  Create parametric profiles with variable cross sections.......................... 213
    Create a profile with variable cross sections....................................... 214
    Modify a profile with variable cross sections..................................... 216

7.5 **Define standardized values for parametric profiles** ......................... 216

7.6 **Create an image of a profile** ............................................................ 217

7.7 **Predefined parametric profiles available in Tekla Structures** ............... 218
  I profiles......................................................................................... 219
  I beams (steel).................................................................................... 220
  L profiles......................................................................................... 220
  Z profiles......................................................................................... 221
  U profiles......................................................................................... 221
  C profiles......................................................................................... 222
  T profiles......................................................................................... 223
  Welded box profiles............................................................................. 223
  Welded beam profiles........................................................................... 223
  Box profiles....................................................................................... 225
Organizer is a daily tool for managing model information, object property queries, and object classification. Using Organizer, you can access all model information, including IFC information, in one place, and manage your model information effectively. Organizer is an efficient tool at any stage in the construction and design process for designers, detailers, managers, estimators, contractors, or anybody using the model information.

For example, construction managers can view and report on key properties of parts and groups of parts of the Tekla Structures model, such as the quantities of purchasing packages. Designers can instantly check object, assembly, or cast unit properties during design to ensure that the properties are as they are intended to be. For example, by creating categories it is easy to automatically track precast or steel elements that are too heavy, reinforcing bars that are too long, and status info.

You can synchronize Organizer with the model to get instant feedback on what is changing in the model and create reports on demand.

Organizer consists of two tools:

- Use **Object Browser** to instantly view and create reports on model information based on the selections you make.

- Use **Categories** to define building locations to automatically arrange model objects and visualize the locations in the model. You can also create categories based on different properties and write user-defined attributes to objects based on the categories the objects belong to. You can use filters to automatically update the category content whenever there are changes in the model. You can also manually change the content of categories.

See also

- View object properties in Organizer (page 10)
- Report object property values from Organizer (page 21)
- Create a property template in Organizer (page 25)
- Import a property template to Organizer (page 33)
- Export a property template from Organizer (page 33)
1.1 View object properties in Organizer

You can view the properties of selected model objects in Object Browser. Object Browser lists the objects that you have selected in the model or the objects of the categories you have selected. The object properties are shown in columns. You can change the order and sorting direction of the columns, and group the properties to view the object data in a structured way.

Click Reload the view in Object Browser when you want to view the latest property values from the model. Once you have viewed a property of any object, the property will be updated in the Organizer database at synchronization.

NOTE  Synchronizing Organizer updates all properties of the changed objects in the Organizer database. You do not need to reload Object Browser if you change the selection in the model, or select another category or another property template. When you have synchronized Organizer, the object properties are up to date until you make changes in the model.
You can use Tekla Structures selection switches to select the needed objects in the model, select assemblies, for example.

To view object properties in Organizer:

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Select model objects in the model, or a category in Categories.

Object Browser may not automatically show the selected objects. There is a predefined limit for the number of objects shown in Object Browser. If the number of objects you have selected is above the limit, Object Browser shows you how many objects you have selected and what the limit for showing the objects is.

Do any of the following:

- Click to show the objects.
  
  Object Browser shows the objects and the object properties stored in the Organizer database.

- Click to reload the object properties and to show the objects.
  
  Object Browser shows the objects and the object properties that have been updated in the model.

- Change the predefined limit by entering a number in the box, for example 6000. Then click .
  
  The number you enter in the box becomes the default limit for showing objects in Object Browser.

- Make another selection.

You can also set the limit in Organizer Settings.

3. Reload Object Browser to show the latest object property values.

View the objects selected in the model or the objects of a category

On the Object Browser toolbar, the automatic selection is selected by default. Object Browser automatically shows objects either from the model or from the categories. If you have a category selected, Object Browser only
shows the objects that are in the category. If you have selected objects in the model, **Object Browser** only shows these objects.

You can switch off the automatic selection if you want to control whether objects are shown from the model or from the categories:

1. Click to activate the other selection buttons.
2. Select the option you want to use:
   - Click to show objects from the model.
   - Click to show objects from the categories.

Note that the objects of a selected category are by default not highlighted or selected in the model.

To view the objects of a selected category in the model, select either **Select objects in the model** or **Highlight objects in the model** from the list at the bottom of the categories.

**View another property template**

Select another template from the template list to view the same object selection with a different template.

![Object Browser](image)

**Set the default property template**

1. Click **Settings**.
2. Select a template from the property template list and click **Set as default**.
3. Click **Modify** to save your selection.

The **Set as default** button is hidden when you have the default template open. When you select another template, the button is shown again.

**Pin the current template in Object Browser**

Pinning a template holds the selected template visible in **Object Browser**.

When you pin a template and select different categories to view the model objects in **Object Browser**, the pinned template is shown even if the selected
category has another template defined for it. This is useful if you want to compare different categories using a certain template.

1. Click to pin the current template in **Object Browser**.
   You can still select another template from the template list. Pinning always keeps the latest selected template visible.

Click to release the template.

**Group object properties**

1. Click and select **Group**.
   **Object Browser** displays a grouping row.

2. Select a property column heading and drag the column to the grouping row.

3. Click and select **Group** to hide the grouping row.

For more information, see **Group object properties in Organizer (page 17)**.

**Show assembly content**

1. Click and select **Show content** to show the objects in the assemblies, cast units or pours that are currently listed in **Object Browser**.
   The assembly, cast unit or pour hierarchy levels are shown in different shades of blue.

2. Click and select **Show content** to hide the assembly content.
   The assembly and cast unit hierarchy levels are also removed when you sort and group objects in **Object Browser**. The objects shown in **Object Browser** remain the same.
Combine identical rows

You can combine the rows that have the same property values in the Object Browser view. When you combine the rows, Object Browser displays a Count column that shows how many rows have been combined.

You can also select whether to show a single property value or the sum of the property values in a column. The sum of the values is the single value multiplied by the number of combined rows.

1. Click \(\text{Combine identical rows}\) and select Combine identical rows.
   
   Combined rows are shown even if you select another category in Categories.

2. If needed, click Modify to include the combined rows in the property template.

3. To show the sum of the property values in a column, go to Settings, locate the property under Columns and set the In combined row show option to Result.

4. Click \(\text{Combine identical rows}\) and select to remove the combined rows.

Show calculated results of object property values in the sum row

1. Select whether Object Browser calculates the results from all or selected rows.

2. Select whether Object Browser shows the calculated total, average, minimum or maximum values.

For more information, see Calculate property values in Organizer (page 19).
Use colors to visualize Object Browser groups in the model

1. Click  and select Group .
2. Select a property column heading and drag the column to the grouping row.
3. Click  and point the Color set command. Object Browser lists the color sets that are available.
4. Click the Color set command to select the current set, or select a suitable color set from the sets that are available.
5. Click  and select a command other than Color set to remove the colors.

Organizer assigns colors to the groups shown in Object Browser. The objects on the lowest group levels are shown in the model using the assigned color. For more information, see Create a color set in Organizer (page 31).

View categories, and unions and intersections of categories

1. Select more than one category in the category tree.
2. Click  and select any of the following:
   • Automated is the default. Automated shows the union of the object content of categories that are under the same category root and the intersection of the object content of categories that are in different category roots.
   • Separate categories shows the objects per category. Separate categories adds the category structure to Object Browser.
   • Union of categories
     Object Browser shows the union of the object content of the selected categories.
   • Intersection of categories
     Object Browser shows the intersection of the object content of the selected categories.
You can also click at the bottom of Categories. The selection pane shows either a union or an intersection of the selected categories, depending on what you have selected. Drag categories between the boxes to modify the unions and intersections.

When you view unions and intersections using the selection pane, ensure that the Show categories in Object Browser button is not active.

**List the categories of objects**
1. Select one or more rows in Object Browser.
2. Right-click and select List categories.
   The category list shows all the categories that contain at least one of the selected objects.
3. Click a category in the list to highlight the category in Categories.

**Hold the current view in Object Browser and remove objects and categories from the view**
1. Click and select to hold the current view.
   Your new selections in the model or in the categories are added to the Object Browser view.
2. Remove objects and categories from the view:
   • To remove an object, right-click a row and select Remove from the view.
   • To remove a category, click and select Separate categories. Right-click the category and select Remove from the view.
3. Click and select to release the view.

**Select the command buttons shown in Object Browser**
1. Open Settings and go to the Toolbar tab.
2. Select the buttons that you want to show on the Object Browser toolbar.
3. Close Settings.

Change the order of columns
Select a property column heading and drag it on the column heading row to the desired location.

Change the sorting direction
1. Click a column heading to show the sorting direction.
   The default direction is ascending. You can change the default direction in Settings.
2. Click the column heading again to change the sorting direction.

See also
Set the units in Organizer (page 20)
Categories in Organizer (page 34)

Group object properties in Organizer
You can sort the objects shown in Object Browser by grouping the objects based on their properties. You can group object properties both in Object Browser and in Settings. The grouping you define in Settings is used in a property template when you save the template.
1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Select objects in the model or select a category to view the objects in **Object Browser**.

3. Click and select **Group**.

4. Drag one or more property columns to the grouping row.
   
The objects are grouped according to the order of properties in the grouping row, from left to right.

   In **Settings** the grouping row is always available.

   When you group object properties in **Settings**, the grouping is simultaneously shown in **Object Browser** if the grouping row is visible.

   In the example below, the first grouping level is **Name**, the second level is **Material**, and the third level is **Profile**.

5. Do any of the following:
   
   a. Drag the object properties in the grouping row to change the grouping order.
b. Click an object property in the grouping row to change the sorting direction.

c. Click Remove grouping \(\times\) to remove an object property from the grouping row.

You can also drag the object property back to the column headings row. When you drag the property, it is placed to the location where you drag it to.

6. Click Modify to include the grouping to the template.

7. To permanently save the grouping to the template, save the Tekla Structures model.

**TIP**  When you have grouped objects in **Object Browser**, you can create a pie chart to view the ratio of the number of the objects included in the groups. Press Alt + F12 to create the pie chart. You can copy the pie chart to any document by using the Ctrl+C and Ctrl+V copy commands.

See also

Create a property template in Organizer (page 25)
View object properties in Organizer (page 10)

**Calculate property values in Organizer**

**Object Browser** shows the calculated total, average, minimum or maximum object property values in a sum row. You can select which values are shown, and whether the values are calculated from all the rows or from the rows you have selected in **Object Browser**.

Click Reload the view \(\circ\) in **Object Browser** when you want to view the latest property values from the model. Once you have viewed a property of any object, the property will be updated in the **Organizer** database at synchronization.

**NOTE**  Synchronizing **Organizer** updates all properties of the changed objects in the **Organizer** database. You do not need to reload **Object Browser** if you change the selection in the model, or select another category or another property template. When you have synchronized **Organizer**, the object properties are up to date until you make changes in the model.

1. To open **Organizer**, click Manage on the ribbon and then click **Organizer**.

2. Select objects in the model or select a category to view the objects in **Object Browser**.
3. Select whether Object Browser calculates the results from all or selected rows.

All is the default.

4. If you select Selected, select the rows in Object Browser.

5. Select a value option from the list:

The values are shown at the bottom in the sum row. The value is the rounded result of the precise object property values.

**NOTE** By default, Object Browser shows the calculated values of properties for which it is useful to calculate results. If you do not want to show the calculated value of a property, go to Settings and set the In sum row show option to -. Reload the Object Browser view.

**See also**

View object properties in Organizer (page 10)

Set the units in Organizer (page 20)

**Set the units in Organizer**

The default units in Tekla Structures depend on the settings in File menu --> Settings --> Options --> Units and decimals. You can change these default
settings in **Organizer** to view a different unit system, unit type, and precision in **Object Browser** and in **Categories**.

1. To open **Organizer**, click **Manage** on the ribbon and then click **Organizer**.
2. Click **Settings**.
3. Go to the **Units** tab.
4. Select a unit system from the list.
5. Select a unit from the list.
6. Select a precision from the list.

Use the precision option for **Others** if you want to define the precision for quantities other than distance, area, volume, or weight.

---

**NOTE** You can set the unit of an individual property column in **Settings** by clicking **Unit** in the column. These individual settings override the **Units** tab settings. Individual settings are useful if you want to show the length in imperial and metric units in one template, for example.

---

**See also**

- View object properties in Organizer (page 10)
- Calculate property values in Organizer (page 19)

### 1.2 Report object property values from Organizer

You can export object property values from **Object Browser** to Microsoft Excel for further processing. The property columns in **Object Browser** are exported exactly as they are shown. You can use default Excel templates or you can create your own Excel templates for the export.

Ensure that you have Microsoft Excel installed on your computer.

You can use a predefined Excel template in the export, or you can define your own Excel template. If you want to place the object properties to a certain location in the Excel template, modify the template by typing %&O%& to the cell from which you want data placement to start, and save the template.

1. To open **Organizer**, click **Manage** on the ribbon and then click **Organizer**.
2. Select objects either in the model or in categories to view the objects and their properties in **Object Browser**.
3. Select a suitable property template.
4. Click and select **Export**.
5. Select an Excel template from the list of available templates or click **Browse** to select some other template.

If you do not select a template, a default Excel template is used in the export.

**Object Browser** lists all the Excel templates that are available for the export in the following folders:

- Current model folder
- Project folder (**XS_PROJECT**)
- Firm folder (**XS_FIRM**)
- System folder (**XS_SYSTEM**)

6. Select one or more export options:

- **Update object properties from the model** is selected by default.
  The latest object properties from the model are updated to **Object Browser** for the export.

- **Export without column headers**
  Select whether to export without the **Object Browser** column header line.
  This option is useful if you have predefined column headings in the Excel template.

- **Export only summary rows**
  Select whether to only export **Object Browser** summary rows.

7. Click **Export**.

Microsoft Excel opens automatically. Grouping, combined rows, and calculated values (total, average, minimum and maximum) are also exported.

**Example: Export project properties**

You can automatically include any project property to the object property export. You can do this by creating a separate property template for the project properties and naming it as **W_Project_data**.

1. Define the project properties in **File menu -- Project properties**. In this example, you enter the project name, project builder, and a project comment in the user-defined attributes.
2. In Organizer, create a property template (page 25) for the project properties you defined above. In this example, you only add the project properties to the template.

   a. Click to open the settings and click Template.
   b. Name the template as W_Project_data and select Blank template. Note that you must use W_Project_data as the name of the template.
   c. Click Create.
   d. Drag the PROJECT.NAME, PROJECT.BUILDER and PROJECT.USERDEFINED.PROJECT_COMMENT project properties to the property columns.
   e. Click Modify to save the template.
3. Add the project properties to the Excel template that you are going to use in the export and save the template.

You can copy the properties from the property template and add them anywhere in the Excel template, for example, as shown in the image below.

![Excel template with project properties](image)

4. Export object properties and project properties from Organizer.
   a. Select objects in the model or categories to view the objects in Object Browser.
   b. Select a property template that you want to use in the export, for example, Default or Rebar.
   c. Click and select Export.
   d. Select the Excel template you modified previously and click Export.

The values of the project properties that you added to the Excel template are shown in the exported Excel.
1.3 Create a property template in Organizer

You can create property templates in Organizer to view the properties of selected model objects in Object Browser. For example, you can create templates for different object types and object groups, and include the needed object properties in the template. You can group and sort the properties in the template. You can also modify existing templates.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click Settings.

3. If you want to create the new property template based on a current template, select the template from the list of templates.

   You can modify an existing template by selecting it from the list of templates and changing the properties included in it.

4. Click + Template.

5. Enter a unique name for the property template.

   Create is dimmed if you enter the name of an existing template.

6. Select whether the template is created based on the current template or as a blank template.

7. Click Create.

   Property templates are saved to the ProjOrg database in the \ProjectOrganizer folder in the model folder. Saved property templates are shown in the property template list.

8. Do any of the following to define the properties that are included in the template:
<table>
<thead>
<tr>
<th>Option in image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a new property column.</td>
</tr>
<tr>
<td>2</td>
<td>Enter a name for a new property column or rename a property column.</td>
</tr>
</tbody>
</table>
| 3              | Drag one or more object properties from the list of properties to a property column.  
The properties are read from the environment.db file in the model folder.  
If you need properties that are not available in the list, for example reference model object properties, you can create them in Organizer as custom properties (page 28). |

Organizer 26 Create a property template in Organizer
You can use the **Search** box to easily find the relevant properties.

In the **Group** list, you can select an option to show only certain properties, for example:

- Select **Recent** to view the most recently used and created properties.
- Select **Custom** to view imported properties and the properties you have created in **Organizer**.
- Select **Property templates** to view the properties that are used in the property templates of your model.

### 4
Click **Ascending** or **Descending** to change the sorting order in a property column.

### 5
Drag a property column to the grouping row. The grouping icon ☐ is shown in the property column.

### 6
Delete a property column.

### 7
Select the property value shown in the sum row in **Object Browser**:

- `-` (minus) does not show any value.
- **Single value** shows a single property value. The single value is shown if all the objects have the same property value in the column.
- **Result** shows the sum of all the property values in the column.

### 8
Select the property values shown in combined rows in **Object Browser**:

- **Single value** shows a single property value.
- **Result** shows the sum of the property values.

### 9
Click **Unit** to set the unit and the precision of the unit for a property column.

### 10
Select a color set (page 31) for the template.

---

9. Click **Modify** to save the properties to the template.

10. To permanently save the template and the changes you have made to it, save the Tekla Structures model.

**Example of using multiple object properties**

It can be useful to have multiple object properties in one column. This way you can ensure that the relevant property value is found for different object types.
For example, you can include different name properties in the Name column. Object Browser shows Name for parts, Assembly_Name for assemblies, Cast_Unit_Name for cast units, and so on.

When searching for the properties, Object Browser uses the order, from left to right, in which the properties are shown in the column. Once a value is found, the rest of the properties in the column are ignored.

See also
Create a custom formula in Organizer (page 29)

Create a custom property in Organizer
You can create your own properties in Organizer and use these properties in property columns in the same way as any other properties. If you want to use the properties in the model, you can add them to the model objects in property categories.

Some object properties, for example, the properties of reference model objects are not automatically available in Organizer. To use these properties in Organizer, create them as custom properties.

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Click Settings.
3. Click Custom.
4. Select Property.
5. Enter a name for the property in the Name box. This name is shown in the list of properties. Ensure that there are no space characters before or after the name.
6. Enter the exact name of the property in the Property box.
**Organizer** uses this name to search for the property value. Ensure that there are no space characters before or after the name. For **UDA** type properties, the maximum length is 19 characters.

**NOTE** For reference model object properties you must add **EXTERNAL** at the beginning of the property name, for example, `EXTERNAL.Tekla Reinforcement.Rebar Mark`. You can copy the exact name of the property from the **Inquire Object** dialog box, for example.

7. Select a unit type for the property. **Organizer** automatically selects the default **Data type** value of the unit type. You can change the data type.

8. Select a data type for the property.

9. Select a property type for the property.

Use **UDA** when creating properties that you write to the model.

![Property creation dialog box]

10. Click **OK**.

Custom properties are shown in the list of properties in the **Custom** group. **UDA** properties are also shown in the **UDA** group. You can modify and delete custom properties by right-clicking the property.

**See also**

Create a property template in Organizer (page 25)

**Create a custom formula in Organizer**

You can create simple mathematical formulas using the object properties that are available in **Organizer**. You can, for example, calculate areas of specific...
object types. You can add formulas to property columns in the same way as object properties. You can also use formulas in the object properties when creating property categories.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click Settings.

3. Click Custom.

4. Select Formula.

5. Enter a name for the formula.
   Ensure that there are no space characters before or after the name.

6. Enter a property name in the search box in the Settings dialog box to find a property.
   You can also select an option from the Group list to narrow down the selection of properties shown in the list of properties.

7. Drag the needed properties to the formula box in the Create formula dialog box.

8. Drag the needed mathematical operators to the formula box and place them between the properties.

   - to add the main mathematical operation signs.
   - ( ) to add parentheses.
   - # to add a box where you can enter a number.

   ![Edit formula dialog box](image)

---

Organizer 30 Create a property template in Organizer
9. If needed, drag the properties and operators inside the formula box to modify the formula. Organizer automatically checks whether the formula is mathematically correct. If the formula is not correct, Create is dimmed and the incorrect parts are shown in red.

10. Select a unit type that is suitable for the properties used in the formula.
11. Click Create.

The formula is shown in the list of properties in the Custom group. You can modify and delete custom formulas by right-clicking the formulas in the list of properties. You can use custom formulas in property templates by dragging the formulas to property columns.

See also
Create a property template in Organizer (page 25)

Create a color set in Organizer
You can use colors to visualize the content of Object Browser groups in the model. The colors are included in color sets that you can create and modify. You can include a color set in a property template so that a property template always uses certain colors. The color visualization is for viewing purposes. You cannot save the colors in the model or in Object Browser.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click Settings.
3. Go to the **Colors** tab.

4. Click **+ Color set**.
   The color set is created based on the set that is currently selected.

5. Enter a unique name for the color set.

6. Click **Create**.

7. Do any of the following to define the colors that are included in the color set:
   - Double-click a color to modify it.
   - Drag the colors to arrange them to a different order.
   - Right-click a color and select **Add**, **Delete**, **Cut**, or **Copy**.
     Double-click an added color to modify it.
   
     You can select multiple colors by using the **Ctrl** and **Shift** keys.

   - Click **Reset colors** to restore the colors of the **Default** set.

8. If needed, click **Set as default** to use the color set as the default set in **Organizer**.

9. Click **Modify**.

   **Organizer** keeps the settings you have defined in the new color set. If you do not click **Modify** and close the **Settings** dialog box, the new color set has the same settings as the color set you used as a basis for the new set.

---

**TIP** You can export color sets from **Organizer** in the **xml** format and use the sets in other models. You can export one set at a time. The color set file has the **.colorset** file extension.

You can import color sets that have been exported from the current model or other Tekla Structures models as in the **xml** format. You can import several files at a time.

---

**See also**

Create a property template in Organizer (page 25)

---

**Delete a property template in Organizer**

You can delete property templates in **Organizer Settings**.

1. To open **Organizer**, click **Manage** on the ribbon and then click **Organizer**.

2. Click **Settings**.

3. Select a property template from the list of templates.
4. Click to delete the selected property template.

See also
Create a property template in Organizer (page 25)

1.4 Import a property template to Organizer
You can import to Organizer property templates that have been exported from the current model or other Tekla Structures models. Property templates are in the xml format. You can import one or multiple templates at a time. You can save the property templates to the \Environments\<environment>\System\ProjectOrganizerData folder to make them automatically available in all models.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click Settings.

3. Click Import.

4. Select the property template file you want to import.
   Property template files have the .propertytemplate file extension.

5. Click Open.
   The file is imported and shown in the property template list in Organizer.
   If an existing template has the same name as the imported file, Organizer adds a running number to the name of the imported file.

   Organizer displays an error message if the selected file is not a valid property template file and does not import the file.

   If the imported template contains properties that are not in the list of properties in Organizer, these properties are added as custom properties.

See also
Export a property template from Organizer (page 33)

1.5 Export a property template from Organizer
You can export property templates from Organizer to xml format files and use the exported templates in other models. You can export one or multiple templates at a time. Exporting the templates also ensures that you have back-up copies of the templates you have created.

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Click **Settings**.

3. If you want to export a specific property template, select the template from the list of templates.

4. Click **Export**.

5. Select whether to export the current property template or all property templates.

6. Click **Browse** to select the destination folder.
   
   By default, the templates are exported to the `\ProjectOrganizer` folder in the current model folder.

7. Click **Export**.

Each exported template creates a separate XML format file. The file extension is `.propertytemplate`.

**See also**

- Report object property values from Organizer (page 21)
- Import a property template to Organizer (page 33)

### 1.6 Categories in Organizer

You can categorize your model in location categories and other type of categories that you can create based on your needs using for example object properties.

- Using location categories, you can create a location breakdown structure and divide the model into projects, sites, buildings, sections and floors. A project contains all the objects of the models that are selected in the category properties, either the Tekla Structures model or reference models, or both. Within a project, a model object can belong to only one lowest level location category at a time.

  Organizer always creates an uncategorized category in a project for objects that cannot be included in any other category based on the location definitions you have made. You can modify the definitions to include the objects to location categories.

- Property categories allow you to add user-defined attributes (UDA) to model objects. Within a property category, a model object can belong to only one lowest level category at a time.

- Custom categories are created based on the rules that you define. Objects are added to the categories based on these rules. You can also create categories manually without rules.

An example of a default category set in Organizer:
When you have included objects in the categories:

- The number of objects in a category is shown in parentheses for location categories and property categories, and for lowest level custom categories.

- The number of objects in a category and the total number of objects included in the category and its subcategories is shown in parentheses for custom categories, as shown in the image below.
Create location categories in Organizer

You can create location categories by defining boundary boxes for the categories. This functionality allows you to organize model objects to sections and floors. The objects are automatically updated to categories based on their locations and the defined boundaries. If an object is not inside or within the limits of a boundary box, it will be placed in an uncategorized category that is automatically created.

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Select Building in the category tree.
3. Right-click and select Define boundary boxes for locations.
4. On the Building tab, define the boundary box for the building.
   a. If there are several grids in the model, select a grid for this building from the Grid origin in the model list.
      The grid selection is available only if there are several grids.
      The grid selection shows the global x, y and z coordinates of the grid origins and the rotation of grids compared to the model origin coordinates.
   b. If needed, change the default name of the building.
   c. Define the x, y and z coordinates for the building boundary box by selecting the boundary coordinates from the list, or by entering suitable coordinates in the boundary coordinate boxes.
   d. Click the icon in front of the building to view the boundary box in the model.
The image below shows an example of building coordinates.

- Right-click in the model and select **Update Window** to remove the boundary box from the model view.

5. On the **Sections** tab, define the boundary boxes for sections.
   
   a. Click **+ Section** to create one or more sections.
   
   b. If needed, change the default names of the sections.
   
   c. Define the x, y and z coordinates for the section boundary box by selecting the boundary coordinates from the list, or by entering suitable coordinates in the boundary coordinate boxes.

   Ensure that the sections do not overlap and that they are inside the building boundary box. A red exclamation mark is shown in front of the coordinates if the boundary boxes overlap. You can save the location definitions when the boundary boxes do not overlap.

   d. Click the **folder** icon in front of the section to view the boundary box in the model.
The image below shows an example of section coordinates.

```
<table>
<thead>
<tr>
<th>Section name</th>
<th>Local X Axis</th>
<th>Local Y Axis</th>
<th>Local Z Axis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame</td>
<td>1 (0.0)</td>
<td>30 500,0</td>
<td>-5 000,0</td>
</tr>
<tr>
<td></td>
<td>6 (36 000,0)</td>
<td></td>
<td>+17400 (17 400,0)</td>
</tr>
<tr>
<td>Ramp</td>
<td>1 (0.0)</td>
<td>30 500,0</td>
<td>-5 000,0</td>
</tr>
<tr>
<td></td>
<td>6 (36 000,0)</td>
<td></td>
<td>+17400 (17 400,0)</td>
</tr>
</tbody>
</table>
```

**e.** Right-click in the model and select **Update Window** to remove the boundary box from the model view.

**6.** On the **Floors** tab, define the boundary boxes for floors.

**a.** Click the **Floor system** button.

You can add as many floor systems as you need. The added floor systems are available in the list.

**b.** If needed, enter a name for the floor system.

**c.** Do one of the following:

- Click **Floor** to add a top floor to the floor system.
  
  You can enter the height of the top floor in the box next to the button.

- Click **Floors based on grid** to create floors automatically based on the grid levels.

**d.** If needed, change the default names of the floors.

**e.** Define the z coordinates for the floors by selecting the boundary coordinates from the list, or by entering suitable coordinates in the boundary coordinate boxes.

**f.** Select a building or a section in which the floor system is used from the list in the box at the top right.
If you have not defined sections, the buildings are shown. The building or section is added to the box.

Floor systems can be used in several buildings and sections. If the floor system is used in some other building and you want to remove the floor system from that other building, you need to open the boundary box definitions of that other building and make the modifications there.

g. Click the icon in front of the floor to view the boundary box in the model.

The image below shows an example of floor coordinates.

![Floor Coordinates Example](image)

h. Right-click in the model and select **Update Window** to remove the boundary box from the model view.

7. On the **Settings** tab, define how objects are placed in the categories.
**Organizer** checks the selected options in the order in which they are shown on the **Settings** tab, from top to bottom.

The objects that cannot be included in categories based on the default and the selected optional settings are placed in an **Uncategorized** category that is created automatically on the relevant level. You can either modify the boundary coordinates or manually move the objects to the correct location.

Note that if you have more than one project, you cannot move objects from one project to another.

8. Click **Modify** and **Close**.

9. Right-click any category in the project and select **Synchronize category** to refresh the category content from the model.

You can also click 🔄 to synchronize **Organizer**.
When you have created the categories, the icons in front of the categories are shown as blue in the category tree.

![Category Tree Example](image)

**Copy a project to property categories or custom categories**

You can copy any *Project* from the location categories to the property categories or custom categories.

1. Select the *Project* that you want to copy.
2. Drag the *Project* to the property categories or custom categories in the category tree.
   
   *Organizer* shows a thick line in the location to which you can copy the *Project*.
3. Select the appropriate copy option:
   
   - **Copy** to copy the *Project* tree structure and the objects
     
     When you copy a *Project* using this option and later make changes in the *Project* in the location categories, the changes are automatically shown in the copied *Project*.
   
   - **Copy only tree structure** to copy the *Project* tree structure

**NOTE**  
If you select a Tekla Structures model in the category properties, all assemblies, cast units, or pour objects are included.

If you select any of the reference models in the category properties, the reference assemblies or reference objects are included. If there are no assemblies in a reference model, then the reference objects are included.

**See also**

- Categories in Organizer (page 34)
- Modify a category in Organizer (page 50)
- Delete a category in Organizer (page 55)

**Create location categories manually in Organizer**

You can manually create location categories without defining boundary boxes for the categories.

1. To open *Organizer*, click *Manage* on the ribbon and then click *Organizer*. 
2. Select a **Project**, right-click and select **New site**.
   You can also select **New project** to have Organizer automatically create **Site** and **Building** under the project.

3. Right-click the **Site** you created and select **New building**.

4. Right-click the **Building** you created and select **New section** or **New floor**.

5. Right-click the **Section** you created and select **New floor**.
   You can create as many projects, sites, buildings, sections, and floors as you need.

6. Add objects to the categories. Do one of the following:
   - Select a category in the project to show the model objects in **Object Browser** and select the objects that you want to move to the new category. Then drag the objects to the new category.
   - In the model, select the objects that you want to move, right-click the new category and select **Move the selected objects**.

   **NOTE** You cannot move objects from one project to another. Within a project, you can move model objects between the lowest level categories. One object can belong to only one lowest level location category at a time.

When you have created the categories manually, the icons in front of the categories are shown as black in the category tree.

![Category Tree Example]

**See also**
- Categories in Organizer (page 34)
- Modify a category in Organizer (page 50)
- Delete a category in Organizer (page 55)

**Create a property category in Organizer**
You can create property categories to add properties to model objects. You can use existing user-defined attributes (UDAs) in the categories and add
values to them, or you can create UDAs as custom properties in Organizer and use these in the property categories.

**NOTE** If you have several property categories, you can use a certain UDA in only one root level property category. This ensures that other categories do not overwrite the UDA.

1. To open **Organizer**, click **Manage** on the ribbon and then click **Organizer**.
2. In **Categories**, select a property category at the root category level, right-click and select **Properties**.

3. **Add content to the category (page 46).**

Properties are added to the objects that are in the category. You can add the category content **manually (page 50)** by selecting objects in the model and inserting them to the category, or by defining rules that automatically insert objects to the category.

You can also **add subcategories (page 49)** to the category. Subcategories can be added manually or automatically based on a property. The property values are written to objects from lowest level categories.
Select the **Do not delete empty automated subcategories** check box to keep all subcategories at synchronization. If you do not select the check box and change the model so that some, or all of the subcategories do not contain any objects, the empty subcategories are deleted when you synchronize the root category or the whole Organizer.

Select the **Include the highest assembly level in the model** option if you want to ensure that only highest level assembly objects are inserted to the category.

4. Under **Object properties**, select a custom property or an existing UDA. You can add more than one property.

5. Define the property settings:

![Object properties](image)

a. Select the value type from the **Type** list and define the value in the **Value** box.

The type determines what kind of values you can use.

<table>
<thead>
<tr>
<th>Type of UDA</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Text</td>
<td>Enter text or a number.</td>
</tr>
<tr>
<td></td>
<td>Category name</td>
<td><strong>Organizer</strong> adds the name of the category to the <strong>Value</strong> box automatically.</td>
</tr>
<tr>
<td></td>
<td>Combined category names</td>
<td><strong>Organizer</strong> adds the names of the categories to the <strong>Value</strong> box automatically.</td>
</tr>
<tr>
<td>Integer</td>
<td>Number without decimals</td>
<td>Enter a number.</td>
</tr>
<tr>
<td>Double</td>
<td>Number with decimals</td>
<td>Enter a number with decimals.</td>
</tr>
<tr>
<td>Formula</td>
<td></td>
<td>Select a formula from the <strong>Value</strong> list. Formulas are defined in <strong>Organizer Settings</strong>.</td>
</tr>
<tr>
<td>Date</td>
<td>Date</td>
<td>Enter a date or select it from the calendar.</td>
</tr>
</tbody>
</table>

b. Select a unit for the value from the **Unit** list.

Only the possible unit options are available for the property:

- The units of the properties are defined in `contentattributes_userdefined.lst` or `object.inp` files.
• The units of custom properties that are created in Organizer are defined when creating the property.

c. Modify the properties in the subcategories if you want the subcategories to have different property values for the same property.

• If you want a property to use the property value defined on the higher property category level, select the Inherit value check box after the property name.

• If you have selected the Inherit value check box but select a type in the Type box or enter a value in the Value box, the Inherit value check box is cleared automatically.

**NOTE** The property values are written to the objects from the lowest level subcategories.

When you write the custom properties you have created in Organizer to the model, you can use these properties as any other UDAs in the model.

When the properties are written to the model, you can use them in visualization and IFC export, for example. You can also view the properties in object dialog boxes and share them with Tekla Model Sharing.

6. Clear the **Update category at synchronization** check box if you do not want to update the category when you synchronize the whole Organizer with the model.

7. Click **Modify**.

Organizer creates an **Uncategorized** category for the objects that are not included to the lowest level categories yet. If the same objects would belong to more than one subcategory based on the category rules, Organizer creates a **Clashing** category for these objects. You need to modify the category rules to empty the **Clashing** category.

8. Click 🔄 to synchronize Organizer, or select any category in the property category tree, right-click and select **Synchronize category**.

Properties and their values are written to the model objects when Organizer or the category is synchronized. **Uncategorized** and **Clashing** categories do not modify the existing UDA values.

You can inquire the properties written to the model and report them as any other properties.

**NOTE** If you delete a property category and its subcategories, the properties that have already been written to the model are not removed.
UDAs with options

If you add UDAs with options to a property category when writing properties to the objects, you have to use the UDA - <property name> format.

To get the correct report result in Object Browser, you can use the same property without UDA - in the name, or if it does not give the correct result, create a new property with USERDEFINED in the name, for example USERDEFINED.LOAD_BEARING.

See also

Categories in Organizer (page 34)
Example: Organizer for precast (page 99)

Create a custom category in Organizer

You can create custom categories to group model objects, for example, based on object properties.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click + to create a new category.

   If you have a category selected, the new category is created on the same level as the selected category. If you have several categories selected or do not have any category selected, the new category is created at the root category level. You can add as many categories as you need.

3. Right-click the new category and select Properties.
4. Type a name for the category.

5. Define the rules for setting the category content:
   a. Under Automated object content, select the models, filters and
categories that are used to automatically add objects to the category.
   Do any of the following:
      • Click the Select model list and select a model to add its objects to
the category.
      To include all model objects in the category, select the Tekla
Structures model.
      • Drag a category from the category tree to the categories and
filters rule box, or click or type in the box and select a filter from
the list.
      • Click Object group to define a filter for Organizer.
       The Object Group - Organizer dialog box opens in the Tekla
Structures main view. When you have saved the filter, click or type
in the rule box again and select the filter.

       Organizer filters are saved in the \attributes folder of the
model folder with the .OrgObjGrp file extension. You can use
these filters only in Organizer.

       You can add as many filters and categories as you want to the same
rule box.

       If you add more than one category or filter to the same rule box, the
category content is a union of all the objects in them.

       If you add categories or filters to separate rule boxes, select whether
the category content is an intersection or difference of the content of
the boxes.

       **NOTE** You can also separately create filters for Organizer before
creating any categories. These filters are created in the same
way as Tekla Structures selection and view filters, and you can
use them in category rules. When creating the filters, click
in the filter settings and set Organizer as the filter type.
       Then define the settings needed in the filter.

   b. Under Automated subcategories, select the properties that are
used to create the subcategories. Do the following:
      • Click Grouping in Object Browser.
       To use this option, drag one or more property columns to the
grouping (page 17) row in Object Browser. Organizer uses the
properties included in the columns when creating the subcategories.

You can also add property template columns or object properties to the rule boxes.

- Click the rule boxes and select a property template column or an object property.

Note that you cannot use the **Grouping in Object Browser** option if you first add property template columns or object properties to the rule boxes.

You can add more than one column or property to the same rule box.

**Organizer** adds a new subcategory level to the properties dialog box when you have added a column or a property to the rule box. If you want the category to have the new subcategory level, add columns or properties to the rule boxes on the new subcategory level.

- Select the **Do not delete empty automated subcategories** check box to keep all subcategories at synchronization.

  If you do not select the check box and change the model so that some, or all of the subcategories do not contain any objects, the empty subcategories are deleted when you synchronize the root category or the whole **Organizer**.

c. Select the **Include the highest assembly level in the model** option if you want to ensure that you have only assembly level objects in the category.

  When you select this option and add a model object to the category, the assembly to which the object belongs will be added to the category.

6. Clear the **Update category at synchronization** check box if you do not want to update the category when you synchronize **Organizer** with the model.

7. Select a default property template for the category from the **Property template** list.

   This is the property template that is shown in the **Object Browser** property table.

8. Click **Modify**.

---

**TIP** You can manually add categories and subcategories to automated categories. Select a category, right-click and select **New category** or **New subcategory**. Manually added categories are not deleted at synchronization. When you synchronize a manually created subcategory, only that category is synchronized.
Create automated subcategories in Organizer

You can create an automated subcategory tree structure for one or several custom categories at a time. The categories for which you create the automated subcategories cannot already have subcategories. If you use an empty category that does not contain objects yet, only the category rules are saved.

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Select a custom category, right-click and select Create automated subcategories.
   
   Organizer opens the Automated subcategories section in the category properties dialog box.

3. Do the following to select the properties that are used to create the subcategories:
   • Click Grouping in Object Browser.
   
   To use this option, drag one or more property columns to the grouping (page 17) row in Object Browser. Organizer uses the properties included in the column when creating the subcategories, for example, as shown in the image below.

   ![Automated subcategories](image)

   You can also add property template columns or object properties to the rule boxes.
• Click the rule boxes and select a property template column or an object property.

Note that you cannot use the Grouping in Object Browser option if you first add property template columns or object properties to the rule boxes.

You can also type the name of the property in the box, for example, PROFILE and press Enter. You can add more than one column or property to the same rule box.

Organizer adds a new subcategory level to the properties dialog box when you have added a column or a property to the rule box.

4. If you want the category to have the new subcategory level, add columns or properties to the rule boxes on the new subcategory level.

5. Select the Do not delete empty automated subcategories check box to keep all subcategories at synchronization.

If you do not select the check box and change the model so that some, or all of the subcategories do not contain any objects, the empty subcategories are deleted when you synchronize the root category or the whole Organizer.

6. Click Modify.

**TIP** You can manually add categories and subcategories to automated categories. Select a category, right-click and select New category or New subcategory. Manually added categories are not deleted at synchronization. When you synchronize a manually created subcategory, only that category is synchronized.

**See also**

Categories in Organizer (page 34)
Create a custom category in Organizer (page 46)
Modify a category in Organizer (page 50)
Delete a category in Organizer (page 55)

**Modify a category in Organizer**

You can modify the category rules and make manual changes to the category content.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename a category</td>
<td>Select a category, right-click and select Rename.</td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
</tr>
<tr>
<td>----</td>
<td>---------</td>
</tr>
</tbody>
</table>
| **Add objects to a category** | You can manually add objects to a category.  
1. Select objects in the model or select a category.  
2. Select objects in **Object Browser** by selecting rows.  
3. Drag the selected objects to a category.  
If you want to add all the objects that you have selected in the model, you can also right-click the category and select **Add the selected objects**. |
| **Remove objects from a category** | You can manually remove objects from a category.  
1. Select a category.  
2. Select the objects in **Object Browser**.  
3. Right-click and select **Remove the selected objects from the selected categories**. |
| **Manage manual changes in a category** | You can view in **Object Browser** how each object has been included in the category, or why it is not included. Objects can be included in categories either automatically based on category rules, or you can add and remove them manually.  
1. Select a custom category.  
2. Right-click the category and select **Properties** to view the rules used in the category.  
The properties show whether there are manually added and removed objects in the category. You can control the status of the objects in **Object Browser**.  
3. Click 📢 and select **Manage manual changes**.  
**Organizer** places a purple frame around **Object Browser** and **Categories**, and adds a **Status** column to **Object Browser**. In the manual change mode, a limited set of **Organizer** commands is available.  
Each object has a status icon: |
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| • | ▼
| The object has been automatically added to the category based on the category rules. |
| • | ◼️
| The object has been automatically added and manually removed from the category. |
| • | ◼️
| The object has been automatically added to the category and manually added to the category. |
| • | ◼️
| The object has been manually added to the category. |
| • | ◼️
| The object has been manually removed from the category. |

Note that the status applies in the selected category. The object may have a different status in another category.

4. Right-click an object in **Object Browser** to change the status:
   • **Add** manually adds the object to the category.
   • **Remove** manually removes the object from the category.
   • **Remove manual changes** removes manual status from an object but leaves the object to the category if it has been included automatically.

<table>
<thead>
<tr>
<th>Modify category rules</th>
<th>1. Select a category, right-click and select <strong>Properties</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2. Modify the category content rules under <strong>Automated object content</strong>.</td>
</tr>
<tr>
<td></td>
<td>The icon in the <strong>Automated object content</strong> button shows that the category has automated object content rules defined.</td>
</tr>
<tr>
<td></td>
<td>Do any of the following:</td>
</tr>
<tr>
<td></td>
<td>• Select a model from the list of models.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Model list</strong> to see which models are already used in the rules.</td>
</tr>
<tr>
<td><strong>To</strong></td>
<td><strong>Do this</strong></td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>• Drag a category from the category tree to the rule box.</td>
</tr>
<tr>
<td></td>
<td>• Click or type in the rule box and select a filter from the list.</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Object Group</strong> to define a filter for <strong>Organizer</strong>. When you have saved the filter, click or type in the box again, and select the filter.</td>
</tr>
<tr>
<td></td>
<td>You can add more than one category and filter, and create unions, intersections, or differences of them.</td>
</tr>
<tr>
<td></td>
<td>3. <strong>Modify the subcategory rules under Automated subcategories.</strong></td>
</tr>
<tr>
<td></td>
<td>The ![icon] icon in the <strong>Automated subcategories</strong> button shows that the category has automated subcategory rules defined.</td>
</tr>
<tr>
<td></td>
<td>Do any of the following:</td>
</tr>
<tr>
<td></td>
<td>• Click the rule boxes to add more property template columns or properties to the rules.</td>
</tr>
<tr>
<td></td>
<td>You can add more properties to the existing subcategory hierarchy levels or to the empty hierarchy level that is under the existing levels.</td>
</tr>
<tr>
<td></td>
<td>• Remove a property from the rules.</td>
</tr>
<tr>
<td></td>
<td>• Remove a whole subcategory hierarchy level from the rules.</td>
</tr>
<tr>
<td></td>
<td>4. Click <strong>Modify</strong>.</td>
</tr>
<tr>
<td></td>
<td>You can modify the subcategory rules of several subcategories at the same time if they have the same subcategory rules, see also Create automated subcategories in Organizer (page 49).</td>
</tr>
<tr>
<td>Change the default property template of a category</td>
<td>1. Select a category, right-click and select <strong>Properties</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Select another property template from the <strong>Property template</strong> list.</td>
</tr>
<tr>
<td></td>
<td>3. Click <strong>Modify</strong>.</td>
</tr>
<tr>
<td>Modify the properties of multiple categories</td>
<td>1. Select the categories you want to modify.</td>
</tr>
<tr>
<td></td>
<td>2. Right-click and select <strong>Properties</strong>.</td>
</tr>
<tr>
<td></td>
<td>The properties you can modify depend on the selected categories. You can, for example, change the default property template or subcategory rules.</td>
</tr>
<tr>
<td><strong>To</strong></td>
<td><strong>Do this</strong></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>
| Change the category content to include the highest assembly level | 1. Select a category, right-click and select **Properties**.  
2. Select the **Include the highest assembly level in the model** check box.  
3. Click **Modify**.  
If you add parts to a category that includes only assemblies, the assembly information is shown in the category. |
| Modify the boundary boxes of a building, section or floor category | 1. Select a category that you have created using boundary boxes.  
2. Right-click and select **Define boundary boxes for locations**.  
3. Modify the boundary box definitions.  
   If you modify a building coordinate and a section has the same coordinate, the section coordinate changes to the modified building coordinate.  
The categories you have created using boundary boxes have a blue icon in the category tree. |
| Add a floor manually to a building that has an automated location breakdown structure | You can manually add floors to automated buildings, for example, to collect the objects of special structures within a building into separate categories. The manually added floors do not have a boundary box for automated object collection. You can add objects from any part of the building.  
   You can use the manual floor category, for example, to separate the elevator shaft from the rest of the building.  
   1. Select a section under a building that has an automated location breakdown structure.  
   2. Right-click and select **New floor**.  
   3. Add objects to the floor.  
   4. Select the **Project** root category, right-click and select **Write to the model for reporting** to write the new location information to the model objects. |
| Add a category manually to an automated category | You can manually add categories to automated categories. Manually added categories are not deleted at synchronization even if they do not contain any objects.  
   1. Select an automated category.  
   2. Right-click and select either **New category** or **New subcategory**. |
To copy or move a category, you can copy or move one category and its subcategories at a time.

1. Select a category and drag it to a suitable location in the category tree, either on top of a category or between two categories.
2. Select a suitable option from the list:
   - **Copy** copies the category properties and the objects in the categories to the target category.
   - **Copy only the tree structure** copies the tree structure without the objects and their properties.
   - **Move** moves the category with the objects and their properties to the new location.

See also

- Synchronize Organizer with the model (page 58)
- Categories in Organizer (page 34)

### Delete a category in Organizer

You can delete categories in Organizer. Note that there must be at least one location category, one property category and one custom category in the Organizer category tree. You cannot delete the last categories.

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Select a category.
   - You can select more than one category.
3. Right-click and select **Delete**.
   - If you have used the selected category in the property rules of other categories, Organizer shows a dialog box where these categories are listed.
4. Click **Yes** to delete.

**NOTE**  To permanently delete a subcategory from a category created with the Create automated subcategories command, you must remove the subcategory objects from the main category. If you do not remove the objects from the main category, the subcategory will be created again based on the main category rules when you synchronize Organizer.
Customized default setup for Organizer

You can customize Organizer by creating a setup that opens the same templates and categories in all new models. A customized setup is useful if you have templates and categories you want to use in all models. Then you do not need to create or import the templates and categories for each model separately. The customized setup is used when you open Organizer in a model for the first time.

You can also exclude some object types (page 58) from Organizer using the ExcludedTypesFromOrganizer.xaml file. Excluded object types are not displayed in Object Browser and they are not included in categories.

To make the customized property templates and categories available in all models, store the templates in the \ProjectOrganizerData\PropertyTemplates folder and the categories in the \ProjectOrganizerData\DefaultCategoryTrees folder. The templates and categories are stored as in the xml format. Property template files have the .propertytemplate file extension and categories have the .category file extension.

NOTE The defined location categories are automatically imported but they behave like manually created categories. Automatic categories need to be defined in each model separately.

You can have the folders under any or all of the following folders:

- Current model folder
- Project folder, defined in the XS_PROJECT advanced option
- Firm folder, defined in the XS_FIRM advanced option
- System folder, defined in the XS_SYSTEM advanced option

Example of the \system folder:

![system folder]

All templates and categories in these folders are loaded to Organizer when you open it for the first time in a model. If there are many files with the same file name in several different folders, the first file found is loaded and the other files with the same file name are ignored. The search order is always: model, project, firm, system. The roles.ini does not affect this order.
For example, if you have `rebar.category`, `category.category` and `material.category` in the `\system\ProjectOrganizerData\DefaultCategoryTrees` folder, these files will all be loaded automatically to the categories. If you also have a `rebar.category` file in the `\PROJECT\ProjectOrganizerData\DefaultCategoryTrees` folder and in the `\model\ProjectOrganizerData\DefaultCategoryTrees` folder, only the first `rebar.category` file found is used. In this case, the file under the model folder would be the first one found.

**NOTE** You can use the `roles.ini` files to control multiple setups. For example, create a `\Concrete\ProjectOrganizerData` folder and a `\Steel\ProjectOrganizerData` folder under the firm folder. Then define in the `roles.ini` file which of these folders is read and/or in which order the folders are read. This way you can read only the `\Concrete` folder files, or read the `\Concrete` folder first. In this case, the files with the same name in the steel folder are ignored.

The loaded templates and categories are saved in the `ProjOrg.db` in the `\ProjectOrganizer` folder under the model folder. When you open Organizer for the first time, the `ProjOrg.db` is created and the files are read in from the model, project, firm and system folders. The `ProjOrg.db` database stores all template and category information used in the model. When you make changes to the templates and categories in the folders, they are not automatically updated in `ProjOrg.db`. The database will not read in the template and category `xml` files again, so updates to the files will not be automatically applied.

If you want to apply the changed templates and categories to the `ProjOrg` database, you have two options:

- Delete the old templates and categories in Organizer and import the changed templates and categories. We recommend that you use this option.
- Export from Organizer all the templates and categories that you want to keep and close the model. Delete the `ProjOrg.db` database from the `\ProjectOrganizer` folder under the model folder, and re-open the model. Import the exported templates and categories back to Organizer.

**NOTE** The second option will reset Organizer completely. All data will be lost if not exported.

See also

- Categories in Organizer (page 34)
- Import a category to Organizer (page 64)
- Import a property template to Organizer (page 33)
- Export a category from Organizer (page 62)
Export a property template from Organizer (page 33)

**Excluding object types from Organizer**

Some object types can be excluded from Organizer. These object types are listed in the ExcludedTypesFromOrganizer.xaml file that is by default located in the \system\ProjectOrganizerData folder in the Common environment. The location may vary depending on your environment. Excluded object types are not displayed in Object Browser and they are not included in categories, even if you select in the category rules to include a model and all its objects to a category. For example, loads, cuts and fittings are listed in the ExcludedTypesFromOrganizer.xaml file and excluded from Organizer.

You can modify the ExcludedTypesFromOrganizer.xaml file to either include or exclude the object types. Before you modify the file, we recommend that you copy it to the \ProjectOrganizerData folder that is under the model folder. You may need to create the \ProjectOrganizerData folder as it does not by default exist in the model folder.

For example, to exclude fittings, change the value as follows:

<Fitting>true</Fitting> to <Fitting>false</Fitting>

To include fittings again, change the value false back to true.

To apply the changes, click in Categories to fully synchronize Organizer with the model.

**NOTE** Do not add or remove any lines from the ExcludedTypesFromOrganizer.xaml file, otherwise Organizer will not be able to use the file.

You can also customize Organizer by creating a setup (page 56) that opens the same templates and categories in all new models. A customized setup is useful if you have templates and categories you want to use in all models.

1.7 **Synchronize Organizer with the model**

You can synchronize Organizer with the model to ensure that the categories are up to date and that Object Browser shows the latest object property values from the model. You can also synchronize individual categories or reload the Object Browser view.

Synchronization adds location information (page 61) to model object properties. You can use the location information when creating reports and inquiries.
Synchronize Organizer

Synchronizing Organizer updates all properties of the changed objects in the Organizer database. You do not need to reload Object Browser if you change the selection in the model, or select another category or property template. When you have synchronized Organizer, the object properties are up to date until you make changes in the model.

Organizer is synchronized:

- When you click the Synchronize with the model button.
- When you open Organizer and select to synchronize it.

To make synchronization faster, set the XS_COLLECT_MODEL_HISTORY advanced option to TRUE. If XS_COLLECT_MODEL_HISTORY is set to FALSE, at synchronization all objects are loaded to check what has been deleted in the model.

When you synchronize Organizer, the Tekla Structures action history that is used in undoing the last action is deleted. This means that you cannot use the Undo (Ctrl + Z) command immediately after you have synchronized. Otherwise, Undo works normally.

You can define in Organizer Settings that Organizer is always synchronized when you open it. Go to the Synchronization tab and select the Always synchronize Organizer with the model when opening check box.

When you open Organizer and select the Do not show this dialog again check box in the Synchronize dialog box, Organizer does not show the Synchronize dialog box anymore in any model where you use Organizer. To get the Synchronize dialog box back, browse to the \users\<user> \AppData\Local\Trimble_Solutions_Corpora folder and delete all the files starting with ObjectBrowser. Note that deleting these files deletes the default Organizer unit settings. Check the unit settings in Organizer Settings.

Update the whole Organizer database

You can update the whole Organizer database so that the properties you have viewed in Object Browser, or that are used in categories, are updated to all model objects in the Organizer database.

The Organizer database is updated:

- When you press Ctrl + the Synchronize with the model button.
- When you open a model that was saved with an older Tekla Structures version and click the Synchronize with the model button.
• When you change the value of the `XS_ENABLE_POUR_MANAGEMENT` advanced option and open Organizer. The cast-in-place object hierarchy is replaced with pour object hierarchy.

• When `XS_ENABLE_POUR_MANAGEMENT` is set to `TRUE` and you click the Synchronize with the model button.

• When you change any model-specific advanced option and click the Synchronize with the model button the next time.

• When you save the model with Save as and click the Synchronize with the model button the next time.

• When you change the material catalog and click the Synchronize with the model button the next time.

Reload Object Browser

Click the reload button in Object Browser when you want to view the latest property values from the model. Once you have viewed a property of any object in Organizer, the property will be updated in the Organizer database at synchronization.

If you make changes in the model while viewing the objects, reload Object Browser.

NOTE When you select objects in the model or in the categories, Object Browser shows the properties that are already in the Organizer database, and loads the new values from the model to the properties that are not yet in the Organizer database.

You have to Reload the view in Object Browser to update the view with the new values.

Synchronize a category

Organizer is partially synchronized:

• When you select a category, right-click and select Synchronize category. To view the synchronization date and time, right-click the category again.

• When you synchronize categories at export.

Partial synchronization:

• Synchronizes the whole project when you synchronize any location category, such as a Floor.
• Synchronizes the categories that are used in the category rules of other categories when you synchronize these other categories.
• Synchronizes the whole category tree created by automated subcategory rules when you synchronize one subcategory in the tree.
• Synchronizes the whole category tree when you synchronize a manually created subcategory in a property category tree.

NOTE Partial synchronization does not update the properties shown in Object Browser. You need to reload Object Browser to show the updated category content.

Exclude a category from synchronization
1. Select a category, right-click and select Properties.
2. Clear the Update category at synchronization check box.
The objects that are deleted from the model are removed from the category even if the Update category at synchronization option is not selected.

1.8 Report Organizer location categories
You can use location category properties in reports. If you have more than one project in a model, you need to select which project, including the subcategories in the project, is used in reporting. You can use only one project at a time. When you synchronize a project, the report properties are always written to the model.
1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Select a Project.
3. Right-click and select Use for reporting.
   The icon in front of the Project that is selected for reporting is shown as black.
4. Right-click the Project again and select Write to the model for reporting.
   The report properties are updated to the model.
The location properties of the assembly level objects in the model are:
• LBS_PROJECT
• LBS_BUILDING
• LBS_SECTION
• LBS_SITE
• LBS_FLOOR
5. To change the project used for reporting, select another Project, right-click and select Use for reporting.

6. Right-click the Project again, and select Write to the model for reporting.

The report properties are updated to the model.

NOTE When using location properties in a report template, you need to add LOCATION_BREAKDOWN_STRUCTURE to the property name, for example, LOCATION_BREAKDOWN_STRUCTURE.LBS_FLOOR.

See also
Categories in Organizer (page 34)
Synchronize Organizer with the model (page 58)

1.9 Export a category from Organizer
You can export categories from Organizer to an xml format file and use the exported categories in other models. You can export the selected categories, or all location categories, custom categories, and property categories at a time. Organizer creates only one .category export file even if you export more than one category at a time. By exporting categories you can ensure that you have back-up copies of the categories you have created.

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Select one or more categories.
3. Click and select Export Organizer categories.
4. Define the export settings.
   a. Select All categories or Selected categories with their subcategories.
      • Exporting location categories: The whole project is exported even if you only select a subcategory in the project, for example, a floor.
      • Exporting categories that have been created using rules: The whole category tree is exported. If you select a subcategory, the main category and the other subcategories in the category tree are also exported.
• Exporting property categories: The whole category tree is exported. If you select a subcategory, the main category and the other subcategories in the category tree are also exported.

• Exporting categories that have been created manually: Only the selected category is exported.

b. Select the include the properties of the categories check box to include category properties in the export.

• If the rules in category properties include a filter, and you plan to use the category in another model, the filter must be available in that model. Otherwise, the category will not have the correct content.

• If you do not select Include the properties of the categories, only the category name is exported. The property template is set to the default template in the export.

c. Select the include the objects check box to include the object GUIDs in the export.

If the exported category is used in other models, the categories will be empty.

d. Select the Synchronize the categories before export check box if you want to ensure that the latest model changes are included in the export.

5. Click Browse to select the destination folder.

By default, the category is exported to the \ProjectOrganizer folder in the current model folder.

6. Click Export.

If the category you are exporting includes other categories in the category property rules, and you have not selected these other categories to the export, the Export category structure references dialog box is displayed.

a. Export the valid references exports categories including the rules defined in the category.

This option is dimmed when you have not selected the categories defined in the rules for export. Click Cancel and select the category to export and the categories used in the rules. When you do this, the Export category structure references dialog box is not shown at all. In import, all exported categories will now be imported.
b. **Export without references** exports the object GUIDs in the categories if you have selected the **Include the objects** check box in the **Export category structure** dialog box.

If you have not selected to include the objects, only the category name is exported. In import, Organizer treats this category as a manually created category.

7. Click **OK**.

**See also**

* Import a category to Organizer (page 64)
* Categories in Organizer (page 34)

**1.10 Import a category to Organizer**

You can import categories that have been exported from Organizer in the current model or in other Tekla Structures models. The category import files are in the xml format, and have the .category file extension. You can import one .category file at a time. The file can contain many categories.

1. To open Organizer, click **Manage** on the ribbon and then click **Organizer**.

2. Click ![Import] and select **Import Organizer categories**.

3. Click **Browse**.

4. Select the .category file you want to import.

5. Click **Open**.

6. Click **Import**.

   If the category you are importing has the same name as an existing category, you have the following options:

   • You can import the category and replace the existing category.
   • You can select not to import the category.
   • You can import the category but keep the existing category. If you import a category that has the same name as an existing category, Organizer adds a running number to the category name.

Location categories are added at the end of the location categories, property categories at the end of property categories, and custom categories at the end of the custom categories.

**NOTE** If the imported category does not contain any objects, check if the rules in the category properties have a filter that does not exist in the model. When you add the filter to the model, the category content is
updated. Another reason could be that there are no objects in the model that match the rules.

The category may also be empty if it has only manually added content and the objects were not included in the export. If you have imported the category from another model, the manually added content is not imported.

See also

Categories created in earlier Tekla Structures versions (page 65)
Export a category from Organizer (page 62)
Categories in Organizer (page 34)

Categories created in earlier Tekla Structures versions

If you have used the Model Organizer tool in the same model in an earlier Tekla Structures version, the categories created in Model Organizer are automatically transferred to Organizer. Model Organizer categories are shown in the custom categories in Organizer.

When you are using Organizer in a model created in an earlier Tekla Structures version:

• If you have never opened Model Organizer in the earlier Tekla Structures version model, no categories are imported.

• If you have opened and closed Model Organizer in the earlier Tekla Structures version model, the project and site logical area categories are imported to Organizer.

• If you have added at least one object to the Model Organizer logical area categories, the logical area categories are imported to Organizer.

• If you have added at least one object to the Model Organizer object type categories, all the categories are imported to Organizer.

Model Organizer property sets are imported to Organizer, converted to property templates, and named after the categories. If several categories have the same name, a running number is added to the property template name.

See also

Import a category to Organizer (page 64)
Categories in Organizer (page 34)
1.11 Import IFC categories to Organizer

You can import the location breakdown structure of an IFC model as IFC categories to the location categories in Organizer.

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Select a Project, right-click and select New IFC project.
3. Select the IFC model.
4. Click Import.
   
The IFC categories are imported at the bottom of location categories. The objects of the imported IFC model are automatically included in the IFC categories.
5. If the IFC model is changed, you can update the latest version of the model to the categories. Select the highest IFC category level in the category tree, right-click and select Update.

TIP If you import IFC categories that have the same name as existing IFC categories, Organizer adds a running number to the category name. You can rename the categories.

See also
Categories in Organizer (page 34)

1.12 Organizer in the multi-user mode

When using Organizer in the multi-user mode, only one user at a time can save changes. The first user who opens Organizer becomes the main user and is the only user who can save changes. When the main user closes Organizer and saves the model, another user who wants to save changes must first close Organizer and open it again to be able to save changes.

Even though only one user at a time can save changes, other users can still select, create and modify categories and property templates. Other users can also export the categories and property templates they have changed, and import them back to Organizer for saving.

NOTE Organizer data is not shared in Tekla Model Sharing.

See also
Organizer (page 9)
1.13 Example: Organize the model into location and custom categories, and view quantities

This example will go through the basic workflow of setting up Organizer, and creating concrete and reinforcing bar take-offs.

You will use Organizer to organize your model into buildings, sections and floors based on the locations in the model. You will create a category tree structure and custom categories. When you have created the locations and custom categories, it is fast and easy to view and report quantities in Object Browser.

In the example, the set-up is done using the Cast in Place Sample model that is available in the Default environment as a model template. You can delete the existing set-up or just create a new project and start setting that up.

Example: Organize the model to buildings, sections and floors

You will now organize your model to location categories (page 36).

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Select the Building category under Project, right-click and select Define boundary boxes for locations.
3. Adjust the boundary box for the building by selecting or entering coordinates.
4. Go to the **Sections** tab and add two sections to your building using the values shown in the image below.
You can click the blue box in front of the section name to visualize the section in the model. The image below shows the **Frame** section.

5. Go to the **Floors** tab and create a floor system for the **Frame** section based on the grid lines.
6. Click **Modify** and **Close**.
   You have now organized the model to sections and floors based on locations.

7. There are three ramp objects that are located in the **Basement** of the **Frame** section. You have to move these manually to the **Ramp** section:
   
a. Select the **Basement** category, right-click and select **Select in the model** to view the objects in the model.

   ![Image](image_url)

   b. Select the three ramp objects in the model.
   c. Right-click the **Ramp** category and select **Move the selected objects**.
Example: Create a custom category with automated subcategories based on object names in Organizer

You will now create a custom category (page 46) for assemblies, and divide the category to subcategories based on the assembly name.

1. Click to create a new custom category.
2. Right-click the Custom Category and select Properties. Rename the category as Object.
3. Under Automated object content, add the material filters Material - Concrete and Material - Steel to the rules. You can also select the Tekla Structures model to include the Tekla Structures objects in the category content.
4. Click Modify to add the objects to the category.
5. Next, group the objects in Object Browser. Click and select Group to create a grouping based on the Name column. The grouping you see in Object Browser is a preview of the automated subcategories.
6. Now create automated subcategories for the category based on object names. Right-click the new category, select Properties and under Automated subcategories, click Grouping in Object Browser. This adds the object properties that are used in the grouping to the category properties.

7. Select the Include the highest assembly level in the model check box. Selecting Include the highest assembly level in the model ensures that only assemblies and cast units are included in the category. Otherwise, the category will include both parts and assemblies. Using assemblies in categories is important because later you will select and view multiple different categories, and this will require using hierarchical dependencies for objects. Also, Organizer is built to work with assemblies.

8. Select the Default property template for Object Browser.

9. Click Modify.

The subcategories are created under the Object category. If you now make changes to the model, the category and the subcategories will be updated. For
example, new subcategories are created and old ones deleted based on the names found in the model.

Next, you will create a custom category for reinforcing bars.

**Example: Create a custom category for reinforcing bars in Organizer**

You will now create a custom category (page 46) for reinforcing bars.

1. Create a new category and name it **Reinforcement**. Select to use the **Object type - Reinforcement** filter in the category property rules.
If you do not have a filter for reinforcement, click **Object group** and create a filter as shown in the image below.

![Object Group - Organizer](image)

<table>
<thead>
<tr>
<th>Category</th>
<th>Property</th>
<th>Condition</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Object type</td>
<td>Equals</td>
<td>Rebar</td>
</tr>
</tbody>
</table>

2. Select a property template for **Object Browser**. In this example, you select the **Rebar** template. For this category, do not select the **Include the highest assembly level in the model** check box. If you select to include only assemblies, you will get all assemblies that contain reinforcing bars. The highest assembly level for reinforcing bars is cast unit. Create subcategories based on the nominal diameter.

3. Click **Modify** to create the category.

You have now created the categories you need and you can start creating reports.

Next, you will create a concrete quantity take-off and a reinforcing bar quantity take-off for specific objects in a specific location.

**NOTE** You can customize **Categories** to open with a set of default categories to avoid creating frequently used categories for each project. **Export the desired categories (page 62)** in the **xml** format as a **.category** file. Save the file to your firm folder under \ProjectOrganizerData.

### Example: Create a concrete quantity take-off using Organizer

You will now **get the quantities (page 10)** and formwork areas for the columns on the first floor. You need accurate quantities to order materials (formwork plywood and concrete), or just to plan your work.

1. Select the **Floor 1** and **Column** categories in the category tree.

2. Select a property template for quantity take-offs. **Object Browser** now shows the quantities of the columns on the first floor.
In this example, you have 19 columns with a total volume of 8.7 m$^3$. You can now create a report by exporting, or you can just check the objects individually. Or, you can just use the total volume and call the concrete supplier to order the needed concrete to the site.

3. Select a property template for formwork. Using a different property template allows you to get different information on your selection.
You now get the total formwork area for columns. The formwork area is calculated using a formula (page 29). You can also see the individual formwork area of each column.

4. To check for discrepancies, you can select columns and locate them in the model for visual checking:
   a. Select the columns in **Objects Browser**.
   b. Right-click on the selected rows and select **Select in the model**.
   c. Press **Ctrl+5** to show only the selected columns. Other objects are almost completely transparent.
   d. Press **Ctrl+4** to show the object surfaces again.
Next, you will create a quantity take-off for the reinforcing bars in the first floor columns.

**Example: Create a reinforcing bar quantity take-off using Organizer**

You will now get the quantities (page 10) of the reinforcing bars of the columns on the first floor.

1. Select the **Floor 1** and **Reinforcement** categories, and the **Column** subcategory.

2. Click ![Organizer](image) to view the categories as unions and intersections in the selection pane, as shown in the image below. In this example, you need the intersections of the categories.
Object Browser shows the reinforcing bars that belong to the columns on Floor 1 using a combination of the property templates of all the selected categories. You can select a different property template to view other properties, and change the grouping and sorting of the properties.

You can change your category selection for different union and intersection combinations. For example, you can add more than one floor category to get a union of the categories.
3. Click Export to create an Excel file (page 62) of your selection.

If you need the same report often, you can save your selection as a new category and set the desired template as the default property template. You can use categories in the rules to define the content of the new category. This is useful especially when you are building your model, and want to automatically include model changes in the category.

1.14 Example: Track modeling and planning issues using Organizer

You can use Organizer to highlight objects with certain properties. This functionality is useful for detailers and contractors, or anyone who wants to check abnormalities during modeling or planning.

Example: Track reinforcing bar length using Organizer

In this example, the maximum reinforcing bar length in your stock is 12 meters. All the reinforcing bars in your model should therefore be under 12 meters. You can use Organizer to track reinforcing bars that are longer than 12 meters.

1. Create a new category and name it Rebar length over 12 m in Category Properties. Click Object group to create a filter for the category and set it up as shown in the image below. The value is shown in millimeters.
2. Save the filter with a unique name using **Save as**.

3. In **Category Properties**, add the filter you created to the rule box, and an **Object Browser** property template if needed. Note that if you select the **Include the highest assembly level in the model** check box, you will get the assemblies and cast units that contain reinforcing bars longer than 12 meters.

4. Click **Modify**. The reinforcing bars that are longer than 12 meters are now included in the category. In this example, there are 208 reinforcing bars longer than 12 meters.

5. Select the category and view the content in **Object Browser**. You can group the reinforcing bars in the category based on their length or location, for example. You can also select them in the model through category, or select them in the **Object Browser** listing and right-click to select them in the model.
6. Before your floor will go to fabrication, you may want to do a final check. You can select the **Floor 2** and **Rebar length over 12 m** categories to check if there are any reinforcing bars that are too long on the floor. In this example, there are 9 such bars.

![Organizer](image)

<table>
<thead>
<tr>
<th>Name</th>
<th>Size / mm</th>
<th>Rebar shape</th>
<th>Grade</th>
<th>Quantity</th>
<th>Weight of single bar / kg</th>
<th>Weight of group / kg</th>
<th>Length / mm</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOTTOM BAR</td>
<td>8.0</td>
<td>1</td>
<td>Undefined</td>
<td>1</td>
<td>7.0</td>
<td>7.0</td>
<td>17 830.0</td>
<td>Frame</td>
</tr>
<tr>
<td>BOTTOM BAR</td>
<td>8.0</td>
<td>1</td>
<td>Undefined</td>
<td>1</td>
<td>7.0</td>
<td>7.0</td>
<td>17 830.0</td>
<td>Frame</td>
</tr>
<tr>
<td>BOTTOM BAR</td>
<td>8.0</td>
<td>1</td>
<td>Undefined</td>
<td>1</td>
<td>7.0</td>
<td>7.0</td>
<td>17 830.0</td>
<td>Frame</td>
</tr>
<tr>
<td>BOTTOM BAR</td>
<td>8.0</td>
<td>1</td>
<td>Undefined</td>
<td>1</td>
<td>7.0</td>
<td>7.0</td>
<td>17 830.0</td>
<td>Frame</td>
</tr>
<tr>
<td>BOTTOM BAR</td>
<td>8.0</td>
<td>1</td>
<td>Undefined</td>
<td>1</td>
<td>7.0</td>
<td>7.0</td>
<td>17 830.0</td>
<td>Frame</td>
</tr>
<tr>
<td>BOTTOM BAR</td>
<td>8.0</td>
<td>1</td>
<td>Undefined</td>
<td>1</td>
<td>7.0</td>
<td>7.0</td>
<td>17 830.0</td>
<td>Frame</td>
</tr>
<tr>
<td>BOTTOM BAR</td>
<td>8.0</td>
<td>1</td>
<td>Undefined</td>
<td>1</td>
<td>7.0</td>
<td>7.0</td>
<td>17 830.0</td>
<td>Frame</td>
</tr>
<tr>
<td>BOTTOM BAR</td>
<td>8.0</td>
<td>1</td>
<td>Undefined</td>
<td>1</td>
<td>7.0</td>
<td>7.0</td>
<td>17 830.0</td>
<td>Frame</td>
</tr>
<tr>
<td>BOTTOM BAR</td>
<td>8.0</td>
<td>1</td>
<td>Undefined</td>
<td>1</td>
<td>7.0</td>
<td>7.0</td>
<td>17 830.0</td>
<td>Frame</td>
</tr>
<tr>
<td>BOTTOM BAR</td>
<td>25.0</td>
<td>1</td>
<td>Undefined</td>
<td>4</td>
<td>55,3</td>
<td>221,2</td>
<td>14 350.0</td>
<td>Frame</td>
</tr>
<tr>
<td>BOTTOM BAR</td>
<td>25.0</td>
<td>1</td>
<td>Undefined</td>
<td>4</td>
<td>55,3</td>
<td>221,2</td>
<td>14 350.0</td>
<td>Frame</td>
</tr>
<tr>
<td>BOTTOM BAR</td>
<td>8.0</td>
<td>1</td>
<td>Undefined</td>
<td>1</td>
<td>5.3</td>
<td>5.3</td>
<td>13 300.0</td>
<td>Frame</td>
</tr>
<tr>
<td>BOTTOM BAR</td>
<td>8.0</td>
<td>1</td>
<td>Undefined</td>
<td>1</td>
<td>5.3</td>
<td>5.3</td>
<td>13 300.0</td>
<td>Frame</td>
</tr>
<tr>
<td>BOTTOM BAR</td>
<td>8.0</td>
<td>1</td>
<td>Undefined</td>
<td>1</td>
<td>5.3</td>
<td>5.3</td>
<td>13 300.0</td>
<td>Frame</td>
</tr>
<tr>
<td>BOTTOM BAR</td>
<td>8.0</td>
<td>1</td>
<td>Undefined</td>
<td>1</td>
<td>5.3</td>
<td>5.3</td>
<td>13 300.0</td>
<td>Frame</td>
</tr>
<tr>
<td>BOTTOM BAR</td>
<td>8.0</td>
<td>1</td>
<td>Undefined</td>
<td>1</td>
<td>5.3</td>
<td>5.3</td>
<td>13 300.0</td>
<td>Frame</td>
</tr>
<tr>
<td>BOTTOM BAR</td>
<td>8.0</td>
<td>1</td>
<td>Undefined</td>
<td>1</td>
<td>5.3</td>
<td>5.3</td>
<td>13 300.0</td>
<td>Frame</td>
</tr>
<tr>
<td>BOTTOM BAR</td>
<td>8.0</td>
<td>1</td>
<td>Undefined</td>
<td>1</td>
<td>5.3</td>
<td>5.3</td>
<td>13 300.0</td>
<td>Frame</td>
</tr>
</tbody>
</table>

Number of objects in the table: 208

Result of: Total

Of these rows: All
Other possible use cases

You can also check reference models that contain reinforcing bars. In this example, the IFC model has been created with Tekla Structures.

1. First, create a filter as shown in the image below. Click ⏯️ to set the filter type to Organizer.
2. Then, create a new category using this filter.
3. Ensure that your reference model is subdivided to be able to include reference objects to categories.
**TIP** If you have a reference model that has been created with some other software, an easy way to find out the string for the filter is to use the Inquire command. Select an object and right-click. Find the desired value string from the Inquire dialog box, and copy and paste the value as a property to the filter dialog box, and add `EXTERNAL` in front of the property name.

**Example: Track too heavy precast elements from a reference model using Organizer**

You can track precast element weights in Organizer by creating selection filters.

1. Create a new category.
2. Create filters to track precast element weights.
   a. Create a filter to track a weight over 10 tonnes.
   b. Create a filter to track a weight under 1 tonne.
   c. Create a filter to track a weight within a certain limit.
3. When you have created the category and the filters, add a suitable filter to the category property rules and save the category.

**NOTE** You can also use this similar process with Tekla Structures objects, for example, to track both steel assembly and cast unit weights with one filter. Here is an example of such a filter:

This filter selects all steel assemblies and concrete cast units that are under 13 tonnes. The hierarchy level attribute is needed to get the main assembly weight.

---

**Example: Create weight group categories to track different weights using Organizer**

You can create selection filters to track different weights in Organizer.

1. Create a suitable filter to create categories for weights, for example, **Weight 5 - 10t** as shown in the image below. Click [Organizer](#) to set the filter type to Organizer.
2. You can now create categories for the weight intervals and track locations. You can use the categories like other categories, for example, you could track first floor weights. You can also use the same logic with other properties, such as volume, length, and area. Adjust the filter rules depending on what you want to track.

Example: Track large concrete volumes using Organizer

It may sometimes happen that the volumes in the model accidentally exceed certain limits. Such limits could be the daily pour rate and delivery rate. You can use Organizer to track the limits.

1. Create a new category and name the category as **Pour volume over 140m³**.

2. In **Category Properties**, click **Object group** to create a filter for selecting volumes larger than the daily delivery maximum and set it up as shown in the image below. In this example, the daily delivery limit is 140 m³. The unit is mm³.

Example: Track modeling and planning issues using Organizer
3. Add the filter you created in the category rules and select the **Include the highest assembly level in the model** check box. Save the category properties.

Note that if you are doing this with pour objects as shown in the image below, use a pour object filter and do not select the **Include the highest assembly level in the model** check box.

You can now start planning based on the result. For example, you may need a bigger crane, or maybe the elements should be smaller. Perhaps the four pours you have should be divided into smaller pours, or maybe you need more concrete delivered to the site.
1.15 Example: Add a classification code to objects in Organizer and export the code to IFC

You can add a classification code to the user-defined attributes of objects through a property category in Organizer and export the code with the objects to an IFC file.

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Create the classification categories that you need as property categories (page 42).

Property categories have round icons in the category tree.

3. Create a custom property that you will use in the classification.
   a. Click 💾 to open the settings and click Custom --> Property.
b. Define the custom property as shown in the image below. Set the property type to UDA.

If you want, you can add the property to the objects.inp file to see the property in the user-defined attributes dialog box.

4. Add the custom property to a property template.

If you do not have a suitable property template, create a new template (page 25).

a. Search for the custom property you created and drag it to the selected template.

b. Click Modify to save the template and close the settings.
5. Add the custom property to the property category you created earlier.
   a. Double-click the root property category to open the category properties.
   b. Under **Object properties**, select the custom property you created.
   c. Click **Modify** to save the changes.

Now all the subcategories under the property category have the same custom property. The lowest subcategories will add the custom property to the objects with the values you will define next.

6. Set the custom property value in the subcategories to add the value to the objects.

You can add different property values in all subcategories.
   a. Double-click a lowest level subcategory to open category properties.
   b. Add the custom property value that you want to write to the objects in the selected subcategory.
c. Click **Modify** to save the changes.

7. Synchronize the property category to write the property values to the model objects.

   Select any subcategory in the property category, right-click and select **Synchronize the category**.

   The whole category tree is synchronized.

   You can check the result in **Object Browser**, or by inquiring an object.

8. Add the classification code to the project properties.
   
   a. On the **File** menu, click **Project properties** --> **User-defined attributes**.

   b. Add the classification code to the **Classification system** box.
Use the name that you added to the **Property** option when creating the custom property.

You can add one classification code at a time this way.

9. Export the classification code to an IFC file.
   a. On the **File** menu, click **Export --> IFC**.
      The classification code is exported with assemblies even if you have added it to parts.
   b. Check the result in the exported model.

Example: Add a classification code to objects in Organizer and export the code to IFC
1.16 Example: Create a custom category for structural design status in Organizer

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Create a new category, right-click the category and select Properties. Enter Design Status (User Defined Attribute) as the name of the category.

3. Set the category rules to create automated subcategories using Grouping in Object Browser based on the design status that has been assigned for each model part under the UDA.
You can now use the categories in managing the structural design status of your project.

See also
Example: Create a custom category for architectural design status in Organizer (page 93)
Organizer (page 9)

1. Ensure that the architectural team places an IFC attribute to each object, such as Architectural_Status, which can be included in the IFC file that they share. In ArchiCAD, this can be done by simply adding an IFC property to the objects called, for example, Status. In Revit, this can be done by using the Revit comment attribute found on each Revit Family Instance.

2. In Tekla Structures, use the Add Model command to place the architectural IFC model in the correct location and ensure that the model is subdivided.

3. To open Organizer, click Manage on the ribbon and then click Organizer.
4. Create a new category, right-click the category and select Properties. Enter Architectural_Status as the category name.

5. Add the Object type - Reference Object filter to the rule box for categories and filters, or a locally set filter that will find all reference objects in the model.

6. Create a new property to allow Tekla Structures to read comments from the ArchiCAD / Revit IFC file. To find the name used by the IFC file, select an IFC object, right-click and select the Inquire command. Find the property name in the Inquire dialog box and copy it.

7. Create a new property template. Open Settings and click Template. Select to create a blank template and enter Arch_Comments_attribute as the name of the new template. Save the template.

8. In Settings, create a new property:
   a. Select Custom from the Group list.
   b. Then click the Custom button and select Property.
      In this example, you will add a Revit_Comments property.
   c. Enter the word EXTERNAL in capital letters to the beginning of the property name in the Property box, then paste or write the property you copied in the Inquire dialog box.
      For example, the correct notation could be EXTERNAL.IdentityData.Comments.
d. Click OK, add the new property to the new template, click Modify, and close Settings.

9. Select the Architectural_Status category. Ensure that Object Browser is showing the Arch_Comments_attribute grouping information. Right-click the Architectural_Status category and select Create automated subcategories to create subcategories using the property values. Create the subcategories using Grouping in Object Browser and click Modify.

The categories are now as follows:

You can now automatically track the status of architectural IFC objects in the Tekla Structures model.

See also
Organizer (page 9)
Example: Create a custom category for structural design status in Organizer (page 92)

1.18 Example: Organizer for steel - manage bolts

You can use Organizer to quickly get the quantities of the bolts required for a project. In addition to the raw quantities, Object Browser lets you group and sub-total by bolt standard, diameter, and length as well as by where the bolt will be used (shop or site).

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click Settings.

3. Click Template to create a new template. Enter Bolt summary as the template name, select the Blank template option, and click Create to create the new template.
4. Next, select BOLT from the Group list, and from the available properties in the list drag the following properties to the Columns:
   • TYPE - The bolt standard (for example, 7990, A325, F10T).
   • DIAMETER - The nominal diameter of the bolt.
   • LENGTH - The nominal length of the bolt.
   • SITE_WORKSHOP - Where the bolt is to be used.
   • NUMBER - The number of bolts in the bolt group.

   Set the In sum row option to - for DIAMETER and LENGTH so that the result is not shown in the sum row.

   You can also add CONTENTTYPE, which shows the type of the object that is being reported in a row. This is useful for checking the results and identifying when something other than a bolt is being reported.

5. Click Modify to save your changes and close the Settings dialog box.

6. Select some bolts (and optionally other objects as well) in the model.

7. Click to reload the view in Object Browser to ensure that the latest information is shown and verify that the bolt information is correctly reported. At this point, you could edit your Bolt summary template further to add additional information, such as the main part phase, or create a custom property to calculate and report the weight of the bolts, nuts, and washers in the bolt group.

   Next, you can use Object Browser to summarize the bolt quantities in your selection.

8. Click in Object Browser and select Group.
   a. Drag the Type column to the grouping row.

   You now have a summary of the different types of bolts used in your selection.

   b. Drag the Diameter column and then the Length column to the right side of Type in the grouping row.

   Object Browser now gives you a breakdown of the number of bolts first by type, then by diameter, and then by length.

   You could now also drag the SITE_WORKSHOP column at the end of the grouping row to further break down the bolts by location, or drag the column to the beginning of the grouping row to first break down the bolts by location, then by type, diameter, and length. Other properties could also be used to group and summarize the bolts.

9. Customize the template and grouping to suit your needs and click Modify to save the template. Now you can use the grouping of your template to categorize all the bolts in the model.
10. Next, create a new custom category, right-click the category and select **Properties**. Enter **Bolts** as the name of the category.

11. Define the properties of the category as follows:
   a. Ensure that the **Include the highest assembly level in the model** check box is not selected.
   b. Under **Automated object content**, click in the rule box for categories and filters, and select the **Object type – Bolt** filter from the list of filters.

      Note that the **Object type – Bolt** filter selects all bolt group objects including the ones that create only bolt holes as well as studs.

   c. Ensure that the **Update category at synchronization** check box is selected.
   d. Select the **Bolt summary** property template from the **Property template** list.
   e. Click **Modify**.

      All bolt objects in the model are now added to the category. In **Object Browser**, the properties of the bolts are shown using the **Bolt summary** template.

      You can now automatically categorize all the bolts in the model using the same breakdown as in the bolt summary.

12. Right-click the **Bolts** category and select **Create automated subcategories**.

13. Click **Grouping in Object Browser**.

14. Click **Modify**.

   You now have a **Bolts** category which is broken down into a tree based on the grouping in your **Bolt summary** template. If any changes are made to the model, you can simply synchronize this category to automatically update the breakdown. New bolts will be found and added to the correct subcategories, or a new subcategory will be created if necessary. For example, if a new bolt standard or diameter is added to the model, a new subcategory for that bolt standard or diameter will automatically be created in the tree when you synchronize the **Bolt** category with the model.

   You could now export the **Bolt summary** property template, as well as the **Bolts** category for use in other projects.

**See also**

*Example: Organizer for steel - manage assemblies (page 97)*

*Organizer (page 9)*
1.19 Example: Organizer for steel - manage assemblies

The categories in Organizer can help manage the amount of work for a project by breaking down the assemblies by phase and assembly type. This can help in estimating the amount of work required to detail and/or fabricate the project even before the model has been detailed.

This example assumes that the model has been divided into two or more phases using Phase Manager. The model could be a design model with no detailing, or it could be a fully detailed model.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Create a new custom category, right-click the category and select Properties. Enter Assemblies by phase as the name of the category.

3. Define the properties of the category as follows:
   a. Ensure that the Include the highest assembly level in the model check box is selected.
   b. Under Automated object content, click the Select model list and select the Tekla Structures model to avoid getting any reference model assemblies to the category.
   c. Ensure that the Update category at synchronization check box is selected.
   d. Select the Erection property template from the Property template list.
   e. Click Modify.

   The steel assemblies in the model are now added to the category and their erection information is shown in Object Browser.

4. Next, click Grouping in Object Browser and select Group:
   a. Drag the Phase (or Phase Name) column to the grouping row.
   b. Drag the Name column to the grouping row.

   You can further group by any additional properties you would like to use to break down the work of each phase.

5. Right-click the Assemblies by phase category and select Create automated subcategories.

6. Click Grouping in Object Browser.

7. Click Modify.

   You now have the Assemblies by phase category broken down into subcategories by phase, then by name.

This now gives you a breakdown of the number and kinds of assemblies in each phase, which can be used to quickly estimate the amount of work in each phase. As the model is detailed or changes are made to the project, you can
simply synchronize this category to automatically update the breakdown. This
could be used to track and check the workload of each phase against
production capacity or available resources as the project progresses.

Once detailing has started, the **DrawingsFromModel Object Browser**
property template could be used to check the availability and status of
drawings for assemblies in each phase.

**See also**

Example: Organizer for steel - manage bolts (page 95)
Organizer (page 9)

1.20 **Example: Organizer for precast**

You can use **Organizer** to view the properties of model objects, for example,
based on custom and standard property types.

1. To open **Organizer**, click **Manage** on the ribbon and then click **Organizer**.
2. Create delivery lot categories DeliveryLot_1…n.
3. Add sequences to the objects in cast units using **Task Manager** or the **Sequencer** tool.
   
   For example, if you use the **Sequencer** tool, enter a sequence name as
   the sequence property. The sequence could be the installation sequence.
   You can check that the property exists by using the **Inquire objects**
   command.

4. Click **Settings** in **Organizer**.
5. Create a new property template for cast units.
6. Create a custom property for the sequence property:
   a. Set the **Data type** to **Number without decimals**.
   b. Set the **Property type** to **UDA**.

   You can use the **Inquire objects** command to find the sequence property.
   Copy the property to the **Create Property** dialog box in **Organizer**.

7. Add the custom property as a new property column to the new property
template.
8. Set the sorting of the custom property column.
9. Save the template.
10. Close the **Settings**.
11. Sort the cast units based on the sequence property in **Object Browser**.
12. Select the cast units that have the same sequence property.
13. Select **Selected** from the **Of these rows** list at the bottom in **Object Browser**.

14. Select an option from the **Result of** list, for example, to show the total or average weight of the selected cast units.

15. Select a delivery lot category in **Categories** and add the selected cast units to the category.

16. Select the **Select objects in the model** option from the list at the bottom in **Categories**.

17. Export the selected cast units from **Object Browser** to an Excel file.

18. You can also create property categories to quickly manage object property data. Create a new property category and open the category properties.

19. Define the category properties:
   a. Enter **Fabrication Status** as the category name.
   b. Select the Tekla Structures model from the list of models.
   c. Set the automatic object content with **Organizer** filters to select all precast concrete assemblies in the delivery lot categories.
   d. Select the previously created property template.
   e. Under **Object properties**, select the **UDA - FABRICATION_STATUS** property.
20. Create automated subcategories based on **UDA - FABRICATION_STATUS**. **Organizer** automatically creates categories based on the properties that are now already in the user-defined attributes of objects.

You can also create the subcategories manually: **Scheduled for fabrication**, **In storage**, **Delivered**, and **On hold**.

21. Now open the subcategory properties and set the type of the property to **Category name** for **UDA - FABRICATION_STATUS**.
22. Now move the uncategorized delivery lot objects between the new subcategories to easily assign statuses to the objects. Synchronize the category with the model.

You can also use **Object Browser** to conveniently overview the statuses assigned both in the categories and in the object property dialog boxes.

**See also**

Organizer (page 9)

Sequencer (page 136)
**Task Manager** is a tool for contractors, sub-contractors, and project managers. **Task Manager** allows you to incorporate time-sensitive data into 3D Tekla Structures models and to control the schedule at various stages and levels of detail throughout the project.

With **Task Manager**, you can create, store and manage scheduled tasks, and link the tasks to their corresponding model objects. On the basis of the tasks, you can create customizable model views and comprehensive 4D simulations of the progression of the project.

You can create tasks in **Task Manager** or import tasks from external project management tools such as Microsoft Office Project or Primavera P6. The import functionality allows you to preserve any schedules that you have created outside the model environment, and thereby maintain schedule intelligence and organization. You can supplement imported schedules with more detail in **Task Manager**.

The above workflow matches what can be found in a normal project delivery - an increasing awareness of activities that support higher level project objectives and milestones. **Task Manager** gives you a logical storage space for this information, and helps you extend schedule control into powerful 3D representations.

**See also**

- Task Manager user interface (page 104)
- Create a task in Task Manager (page 108)
- View tasks in Task Manager (page 121)
- Import tasks and task types to Task Manager (page 124)
- Export tasks and task types from Task Manager (page 126)
- Print a task schedule from Task Manager (page 126)
- Example: Visualize a Task Manager schedule in the model (page 127)
2.1 Task Manager user interface

Task Manager lists all the tasks included in the current Tekla Structures model and shows the timescale of your project.

To start Task Manager, go to the Manage tab and click Tasks.

The tasks and task properties are shown in a table. The default task view that opens depends on the Tekla Structures environment and it contains the recommended settings. You can modify and delete the default tasks.

The Gantt chart shows the timescale of the project using the following symbols:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>The task is not linked to any model object.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>The task has planned start and end dates.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>The task has actual start and end dates.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Shows the completeness of the task.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>The task is a summary task. Summary tasks can contain other summary tasks as subtasks.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Shows the dependency between tasks.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Shows a milestone.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>The task is locked. The task is marked as locked in the Task Manager table.</td>
</tr>
</tbody>
</table>

See also

Customize your Task Manager view (page 104)
Customize the calendar in Task Manager (page 106)
**Customize your Task Manager view**

You can customize the Task Manager view to show the relevant task properties and the timescale.

On the Manage tab, click Tasks and do any of the following:

### Customize the Task Manager dialog box

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show the tasks</td>
<td>Click &gt; Task List.</td>
</tr>
</tbody>
</table>
| Show and hide a task property | 1. Click > Task List Items.  
2. Select a task property to show or hide it.  
A check mark in front of the property indicates that the property is shown.  
When you open Task Manager the next time, the selections you made in the previous Task Manager session are in use. |
| Change how dates and months are shown | Task Manager shows the dates and months as set in the Windows regional and language settings.  
1. Click the Windows Start button.  
2. Click Control Panel.  
3. Go to the Region and Language settings and select the format you want to use.  
4. Click OK.  
5. Restart Tekla Structures for the change to take effect. |
| Change the size of the buttons | Click > Large Icons. |
| Keep the Task Manager dialog box on top of other windows on your screen | Click > Stay On Top. |

### Customize the Gantt chart view

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show the Gantt chart</td>
<td>Click &gt; Gantt Chart.</td>
</tr>
<tr>
<td>Show and hide task properties</td>
<td>1. Click &gt; Gantt Chart Settings.</td>
</tr>
</tbody>
</table>
To | Do this
---|---
2. Select a task property to show or hide it.  
   Note that you must have the actual start and end dates defined for a task to show them in the Gantt chart.  
   A check mark in front of the property indicates that the property is shown in the Gantt chart.

Change the Gantt chart timescale | 1.  
   Click .  
   2. Select a timescale option.  
   **Fit to the project** automatically selects the appropriate timescale option to show the whole project schedule in the Gantt chart.  
   You can also change the timescale by dragging the mouse on the Gantt chart. Hold down the right mouse button and drag the mouse to the left to make the timescale narrower and to the right to make the timescale wider.

Zoom in the Gantt chart | • To zoom to a task in the Gantt chart, select a task in the task list and press Ctrl + 1.  
• To zoom to the whole scenario, press Ctrl + 2.  
• To place the Gantt chart symbol of the selected task in the middle of the chart, press Ctrl + 3.

Change the colors of Gantt chart symbols | 1.  
   Click > Set Colors.  
   2. Click the color you want to change.  
   3. Select a color.  
   4. Click OK.

See also  
Create a task in Task Manager (page 108)

**Customize the calendar in Task Manager**

Task Manager has a calendar that is used when calculating the task length. You can customize the calendar by adding, modifying and removing holidays and other non-working periods.

Non-working periods change the task duration automatically but they do not change the planned or actual end dates of a task. This means that the workload of the task may change. For example, adding an extra non-working
day for a one-week task changes the duration from 5 to 4 days increasing the workload of one day. Weekends are by default non-working periods.

On the **Manage** tab, click **Tasks**, and do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| **Set the length of the working day** | 1. Click 🎨 > **Non-working Periods**.  
2. Type the working hours in the **From** and **To** boxes.  
3. Click **Set working day**.  
4. Click **OK**. |
| **Add non-working periods to the calendar** | 1. Click 🎨 > **Non-working Periods**.  
2. Click **Add**.  
3. Type a descriptive name in the **Name** box.  
4. Select the **Start** date and the **End** date.  
5. Set the **Recurrence** frequency to non-recurring, weekly or yearly.  
6. Set the **Range of recurrence** for recurrent non-working periods.  
7. Click **OK**.  
To modify a non-working period, select a period in the **Non-working Periods** dialog box and click **Modify**.  
To delete a non-working period, select a period in the **Non-working Periods** dialog box and click **Remove**. |
| **Import a holiday file from Microsoft Outlook** | 1. Click 🎨 > **Non-working Periods**.  
2. Click **Import Holidays**.  
4. Select the country from the list.  
5. Click **OK**. |
| **Import a calendar** | You can import a calendar, for example, from Microsoft Project.  
**NOTE** The imported calendar overrides the existing calendar in **Task Manager**.  
1. Click 🎨 > **Import**.  
2. Browse for the file to import.  
3. Select the **Import calendar** option. |
To | Do this
--- | ---
4.  | Click **OK**.

**See also**
Create a task in Task Manager (page 108)

2.2 **Create a task in Task Manager**
You can create scheduled tasks in **Task Manager** and link the tasks to the relevant model objects. Each task must have at least a name and a planned start date and end date. The tasks in **Task Manager** are saved when you save the Tekla Structures model.

1. On the **Manage** tab, click **Tasks**.
2. Do one of the following:
   - In Tekla Structures, select one or more model objects, then right-click and select **Task --> Create Task**.
     The task is automatically linked to the selected model objects.
   - In **Task Manager**, click ![Icon](image.png).
     If you have an existing task selected, **Task Manager** uses the properties of the selected task as a basis for the new task.
     The task is not linked to any model objects.
3. If needed, click ![Icon](image.png) to create a subtask.
4. Define the task properties in one of the following ways:
   - Select a task, right-click and select **Task Information**.
     Note that you can modify some of the properties only in the **Task Information** dialog box.
   - Select a task, click the property you want to modify, and type the new value or select the value from a list.
     You can also copy property values. Right-click a property and select **Copy Value**. Then select another property, right-click and select **Paste Value**. You can paste the copied value to multiple tasks.
5. If the task you created is not shown in **Task Manager**, click anywhere on the tasks to update the view.
TIP You can lock tasks if you want to ensure that task properties are not unintentionally changed. Select a task, right-click and select Lock Task. Locked tasks are marked with a lock icon in the task list.

You can lock one or more tasks at one go. If you select several tasks, and one or more of the tasks, but not all of them, are already locked, Task Manager shows a lock icon in front of the Lock Task command.

See also
Define a task type in Task Manager (page 109)
Define general task properties in Task Manager (page 111)
Define a task schedule in Task Manager (page 112)
Manage the planned dates of objects in a task in Task Manager (page 113)
Track a task schedule in Task Manager (page 114)
Define a dependency between tasks in Task Manager (page 117)
Link a task to the model in Task Manager (page 119)

Define a task type in Task Manager
You can define task types for different types of tasks. In the task type, you can define a production rate and user-defined attributes that are linked to the objects in the task.

1. On the Manage tab, click Tasks.
2. Click > Task Types.
3. Click Add.
4. Type a name for the task type.
5. Define a production rate for the task type.
   The production rate is used when calculating task duration. Using the production rate, you can define how many units are produced within a certain time frame, for example, how many pieces per hour or how large an area in an hour, 1.50 pcs/hour or 8.00 m²/hour. Task Manager automatically calculates the production rate when you define the unit, quantity, and time.
   a. Select a unit in the Unit list.
      The default unit is PIECES.
      The default task type units are report properties that are listed in the WorkTypeProperties.xml file. The file is located in the model folder and it is created when you first open Task Manager.
report properties included in the file depend on the Tekla Structures environment. To change a task type unit or to add new task types, edit the WorkTypeProperties.xml file.

You can add Tekla Structures report properties, reference model properties and calculations to the file. The display name defined in the file is shown in the Unit column and the report property name value is used in Task Manager. If you are adding a calculation, the property type must be calc.

The default units of the task type units depend on the settings in File menu --> Settings --> Options --> Units and decimals.

b. Type the quantity in the Quantity box.

c. Type the time in the Time box.

6. Select the planned dates user-defined attributes that are linked to the objects that are added to the task.

7. Click OK.

TIP To define a task type in the Task Information dialog box, select a task, right-click and select Task Information. Go the General tab and click next to the Task type list.

See also
Manage the planned dates of objects in a task in Task Manager (page 113)
Define general task properties in Task Manager (page 111)

Define a contractor in Task Manager
You can add contractors in Task Manager. You can assign one contractor for a task.

1. On the Manage tab, click Tasks.

2. Click > Contractors.

3. Click Add.

4. Type the contractor name.

5. Click OK.

NOTE To add a contractor in the Task Information dialog box, select a task, right-click and select Task Information. Go the General tab and click next to the Contractor list.
Define general task properties in Task Manager

You can define general properties for a task, such as a name, task type, and contractor.

1. On the Manage tab, click Tasks.
2. Select a task in the task list.
3. Right-click and select Task Information.
4. Ensure that you are on the General tab.
5. Type the task name in the Task name box.
6. Select the Milestone check box if you want to mark the task as a milestone.

   Task Manager selects this check box automatically if you set the task length to zero.

7. Select how the task is moved in the Gantt chart if it has a dependency with another task:
   • Only forward moves the dependent task forward only when the preceding task is moved forward. If the preceding task is moved backward to an earlier date, the dependent task is not moved.
   • Forward and backward moves the dependent task in the same direction as the preceding task, according to the dependency type and the possible lag time.

   TIP  Click 🗝️ Task Settings to set the default value that is used in all new tasks.

8. Select a task type from the Task type list.
9. Select a contractor from the Contractor list.
10. Click OK.

   TIP  You can mark several tasks as milestone tasks at one go. Select the tasks, right-click and select Milestone Task. Milestone tasks are shown in the Gantt chart with the milestone symbol ⚖️.

   If you select several tasks, and one or more of the tasks, but not all of them, are already milestone tasks, Task Manager shows ▶️ in front of the Milestone Task command.
Define a task schedule in Task Manager

You can plan a schedule for a task by defining the start date and the end date. You can define both the start and the end date, or enter the start date and the task length, and let Task Manager calculate the end date.

1. On the Manage tab, click Tasks.
2. Select a task in the task list.
3. Right-click and select Task Information.
4. Go to the Scheduling tab.
5. Select the Scheduling mode:
   • Fixed start and end
     If you add objects to the task or remove objects from the task, the production rate changes but the task length does not change.
   • Fixed start
     If you add objects to the task or remove objects from the task, the task length changes.

TIP Click 📋 > Task Settings to set the default scheduling mode that is used in all new tasks.

6. Select the Planned start date.
7. Select the Planned end date.

Instead of selecting the planned end date, you can let Task Manager calculate the end date. Do one of the following:
   • Enter the Planned length of the task. Planned length is shown in shifts.

You can define the length of a shift as a working day in 📊 > Non-working Periods > Set working day.
• In the **Fixed start** scheduling mode, enter the task length in **Planned work duration**.

**Task Manager** automatically calculates the total workload, production rate, and work duration of the task.

8. If needed, define the work duration in hours in the **Fixed start** mode.

9. Click **OK**.

**TIP** To check that the dates of subtasks are within the summary task dates, click > **Check Dates**. The conflicting dates are shown in red.

To modify the start dates of the whole scenario at one go, click > **Change Project Start Date** and select a new start date.

**TIP** You can also modify the length of the task in the Gantt chart. Place the mouse pointer over the edge of the task bar in the Gantt chart. The mouse pointer changes into a double-ended arrow. Hold down the left mouse button, and then drag the edge to the right or to the left.

**See also**

- Track a task schedule in **Task Manager** (page 114)
- Manage the planned dates of objects in a task in **Task Manager** (page 113)

**Manage the planned dates of objects in a task in **Task Manager****

You can manage the planned duration of the activities related to each object in a task.

**NOTE** Ensure that there are objects in the task and that you have defined task types that are linked to the appropriate user-defined attributes for planned dates.

1. On the **Manage** tab, click **Tasks**.
2. Select a task in the task list.
3. Right-click and select **Task Information**.
4. Go to the **Objects** tab.
5. Click the **function button to calculate the planned dates for the objects in the task.

The calculated dates are written to the corresponding user-defined attributes in the object properties.
6. Click **OK**.

**TIP** To calculate the dates for several tasks at one go, select the tasks in the **Task Manager** dialog box and click **.**

![Task Manager dialog box](image)

**See also**
- Define a task type in Task Manager (page 109)
- Link a task to the model in Task Manager (page 119)

**Track a task schedule in Task Manager**
You can track how a task is progressing by defining the actual schedule and task completeness information.

1. On the **Manage** tab, click **Tasks**.
2. Select a task in the task list.
3. Right-click and select **Task Information**.
4. Go to the **Tracking** tab.
5. Select the **Completeness tracking** mode:

- **Automatic**
  If there are no objects in the task, **Automatic** works in the same way as the **Task level** tracking mode.
  If there are objects in the task, **Automatic** works in the same way as the **Object level** tracking mode.

- **Task level**
  Define the actual schedule and the task completeness for the task in **Task Manager**.

- **Object level**
  Define the actual start and end date of individual objects in the object properties in the model. **Task Manager** calculates the task length and the task completeness.
  When you change the dates of an object in the model, refresh the task in **Task Manager** to ensure that the changed dates are shown in **Task Manager**.

  **TIP** Click **Task Settings** to set the default tracking mode that is used in all new tasks.

6. Click **OK**.

**See also**

- Define general task properties in Task Manager (page 111)
- Define a task schedule in Task Manager (page 112)

**Define the order of objects in a task in Task Manager**
You can define and save the order in which objects are stored in a task.

1. On the **Manage** tab, click **Tasks**.
2. Select a task in the task list.
3. Right-click and select **Task Information**.
4. Go to the **Objects** tab.
5. Set the sequencing order of objects:
   a. Click to select all objects in the table, or select the objects that you want to modify.
   b. Click ⏩.
The **Sequencing order** column shows the order of the objects.

You can also set the sequencing order by selecting the objects in the desired order in the model. Select objects in the table, click 📲 and select the objects in the model in the desired order.

**TIP** You can show a sequence in the model.

- a. Select the objects in the table.
- b. Type the speed of the object selection in seconds in the box next to the **Play** button.
  
  For example, if you enter 2, Tekla Structures waits for 2 seconds until it selects the next object in the sequence.

- c. Click 📲.
  
  The objects are selected in the model in the same order as they are on the **Objects** tab. The objects stay selected in the model until you click somewhere in the model.

6. If needed, change the order of the objects in the table:

- Drag the object rows in the table manually to the desired order.
  
  You can drag several object rows at a time.
- Click a table column heading to sort the objects.
  
  Press **Ctrl** and select more than one column heading to sort the objects by several columns.

7. Click **OK**.

**TIP** To show the order information in the model, select one or more objects in the table and click 📲 or press **Ctrl + D**. The order information is shown on the
selected objects in the model. For example, 2-1 means that the object belongs to the second task in the task list and that the object is the first object in the task.

To clear the numbers from the model, right-click and select **Update Window**.

When you define the cast-in-place work order or work groups within a task, you can use **Organizer** for planning the appropriate quantities for each group or lot.

---

**See also**

- Link a task to the model in Task Manager (page 119)
- View object properties in Organizer (page 10)
- Example: Organize the model into location and custom categories, and view quantities (page 66)

---

**Define a dependency between tasks in Task Manager**

You can define different types of dependencies between tasks in **Task Manager**. You can define a dependency for one task at a time.

The dependencies are represented by arrows in the Gantt chart. The arrow points to the start or the end of the other task, depending on their relationship. A task can also be dependent on a milestone.

A predecessor is a task that must be completed before the dependent task. You can also define a lag between the tasks, for example, that Task1 must be completed five days before Task2 can be started. It is not possible to create circular dependencies in **Task Manager**.

To define a dependency between tasks:

1. On the **Manage** tab, click **Tasks**.
2. Select a task in the task list.
3. Right-click and select **Task Information**.
4. Go to the **Dependencies** tab.
   - If you have more than one task selected, the **Dependencies** tab is not shown.
5. Select the preceding task from the **Task Name** list.
   - You cannot select the summary task of the current task, or a task that already has a dependency with the current task.
6. Select a dependency type from the **Type** list. The options are:
• **Finish-to-Start (FS):** The preceding task must finish before the dependent task can start.

    You can also drag a task bar onto another task bar in the Gantt chart to create a basic **Finish-to-Start** dependency with no delay days between the tasks.

• **Start-to-Start (SS):** The preceding task must start before the dependent task can start.

• **Finish-to-Finish (FF):** The preceding task must finish before the dependent task can finish.

• **Start-to-Finish (SF):** The preceding task must start before the dependent task can finish.

7. If you want to add a delay between the tasks, enter a value in the **Lag** list.

   Define the value on a scale from 1 to 100. The time unit of the delay is always **Days**.

8. If needed, go to the **General** tab and check that the **Move with predecessor** setting for how tasks are moved in the Gantt chart is suitable.

9. Click **OK**.

---

**TIP** You can also modify a dependency in the Gantt chart. Right-click a dependency arrow and do any of the following:

- Select a dependency from the list.
- Enter a new lag value and press the **Enter** key.

   The changes are immediately visible in the Gantt chart.

---

**See also**

* Define general task properties in Task Manager (page 111)

---

**Define additional information for a task in Task Manager**

You can define additional information for a task in **Task Manager**, such as links to web pages, relevant documents, project schedules, and contracts.

1. On the **Manage** tab, click **Tasks**.
2. Select a task in the task list.
3. Right-click and select **Task Information**.
4. Go to the **Additional Information** tab.
5. Click **Add**.
6. Select the file and click **Open**.
7. Enter additional notes in the Notes box.
8. Click OK.

See also
Create a task in Task Manager (page 108)

## Link a task to the model in Task Manager
Tasks are linked to the model through the objects that are included in the tasks. You can add objects to a task, copy objects from one task to another and remove objects from a task.

On the Manage tab, click Tasks. Then select a task and do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add objects to a task</td>
<td>1. In Tekla Structures, select the objects that you want to add to the task.</td>
</tr>
<tr>
<td></td>
<td>2. Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• In Tekla Structures, right-click and select Task --&gt; Add to Selected Task</td>
</tr>
<tr>
<td></td>
<td>• In Task Manager, right-click the selected task and click Add Selected Objects.</td>
</tr>
<tr>
<td></td>
<td>• In Task Manager, click &gt; Add Selected Objects.</td>
</tr>
<tr>
<td></td>
<td>When the objects have been added to the task, Task Manager changes the color of the task bar to blue in the Gantt chart and selects the <strong>Task linked to model</strong> check box.</td>
</tr>
<tr>
<td>Copy objects from one task to another</td>
<td>You can copy objects from one task to another in Task Manager. If you want to move all the objects of a task to another task, you must manually remove the objects from the original task after the copying.</td>
</tr>
<tr>
<td></td>
<td>1. Click ☐ to automatically highlight the objects in the model.</td>
</tr>
<tr>
<td></td>
<td>2. Click ☐ &gt; Keep Selection.</td>
</tr>
<tr>
<td></td>
<td>All objects linked to the task stay selected.</td>
</tr>
<tr>
<td></td>
<td>3. Select the task you want to copy the objects to.</td>
</tr>
<tr>
<td><strong>To</strong></td>
<td><strong>Do this</strong></td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>4.</td>
<td>Click &gt; <em>Add Selected Objects</em>.</td>
</tr>
</tbody>
</table>

**Remove objects from a task**

1. Click to automatically highlight the objects in the model.
2. In Tekla Structures, select the objects you want to remove.
   If you do not select any model objects, all objects are removed from the task.
3. Do one of the following:
   - In Tekla Structures, right-click and select **Task --> Remove from Selected Task**.
   - In **Task Manager**, click > *Remove Selected Objects*.
   - In **Task Manager**, right-click the selected task and click **Remove Selected Objects**.
   - In **Task Manager**, right-click the selected task and select **Task Information --> Objects**. Select the objects you want to remove and press the **Delete** key.
4. Click the view in Tekla Structures and then click the task again in **Task Manager** to verify that the objects were successfully removed.

**See also**

- Create a task in Task Manager (page 108)
- Define the order of objects in a task in Task Manager (page 115)
- Manage the planned dates of objects in a task in Task Manager (page 113)

**Create a scenario in Task Manager**

You can create different scenarios to define alternative workflows, for example, for design, fabrication and erection schedules to help you in project planning. You can add different tasks and dependencies between the tasks in the scenarios. You can also create separate weekly scenarios for easier project follow-up.

1. On the **Manage** tab, click **Tasks**.

2. Click 🔃.
3. Click **Add**.

**Task Manager** names the new scenario as **Scenario** and adds a running number to the name, for example **Scenario 1**. You can rename the scenario.

4. Click **Open** to add tasks to the new scenario.

5. Click **+** to create a task.

6. If needed, copy tasks from another scenario.
   a. Select a scenario in the list of scenarios and click **Open**.
   b. Select the tasks that you want to copy.
      
      The subtasks of the selected tasks are also copied.
   c. Right-click and select **Copy** or **Copy Without Objects**.
   d. Go back to the new scenario, select a location for the copied tasks in the task list, right-click and select **Paste**.
      
      When you select a location, the copied tasks are placed on the same level as the selected task. If you do not select any location, the copied tasks are placed after all existing tasks.

**TIP**  To delete a scenario, right-click a scenario in the list of scenarios and click **Delete**.

**See also**

Create a task in Task Manager (page 108)
Define a task type in Task Manager (page 109)

### 2.3 View tasks in Task Manager

You can view, select, highlight and filter tasks in different ways in **Task Manager**.

On the **Manage** tab, click **Tasks** and do any of the following:

**Select tasks**

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Select multiple tasks | Do any of the following:
<p>| | • Hold down the <strong>Ctrl</strong> key and select the tasks. |
| | • Select the first task, hold down the <strong>Shift</strong> key and select the last task. |</p>
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>To select tasks</td>
<td>• Select the first task and drag the mouse across the tasks you want to select.</td>
</tr>
</tbody>
</table>
| Select multiple tasks in the Gantt chart | Do one of the following:  
• Select an area in the Gantt chart.  
• Drag the mouse on the header line in the Gantt chart to select a time period.  
*Task Manager* highlights the tasks that are within the selected area. |
| Show only the selected tasks in the task list | 1. Select one or more tasks in the task list.  
2. Click .  
3. Click to show all tasks again. |

**Organize tasks in the task list**

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Change the order of tasks | Select a task and click or until the task is in the desired location.  
You can move more than one task at a time. When you move a task, the related subtasks are also moved. |
| Save the order of tasks | Click and select *Save Current Order*.  
If you change the saved order of tasks and want *Task Manager* to show the saved order again, click and select *Return to Saved Order*. |
| Change the hierarchy of tasks | Select a task and do one of the following:  
• To increase the hierarchy, click .  
You can change a task to a subtask.  
• To decrease the hierarchy, click .  
You can change a subtask to a task.  
You change the hierarchy of more than one task at a time. |
| Expand and collapse task hierarchies | Select a task and do one of the following:  
• Click to collapse the hierarchy of the selected task. |
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| To highlight the model objects of a task in the model | **In Task Manager:**  
1. Select a task in the task list.  
2. Click . |
| Highlight a task in the model | **In the model:**  
1. Activate the Select tasks selection switch in Tekla Structures.  
2. Place the mouse pointer over a model object. If the object belongs to a task, Tekla Structures highlights the task.  
   The green box shows the boundaries of the task in the model. |
| View the tasks related to a model object | 1. Ensure that the Select tasks selection switch in Tekla Structures is not active.  
2. Select a model object.  
3. Right-click and select Task --> Show Related Task . **Task Manager** selects the related tasks in the task list. The model objects that belong to the related tasks are highlighted, but not selected, in the model. |
Filter tasks

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Filter tasks in the task list | You can filter tasks by status, contractor, task type, name, and start and end dates. You can set that the filtering shows only those tasks that are within your selection in the model.  
  1. Click 
  2. Select the filters you want to use. 
  3. Click Filter. 
  4. Click Show all to show all tasks. 
You can also filter tasks by entering a filter criterion in the search box in Task Manager. The search covers all the task properties that are visible in the task list. |

**TIP** You can create filters for tasks using the Tekla Structures selection and view filter functionality. The filters control which objects are shown in the model and which objects can be selected. When you use selection and view filters, the tasks in the current scenario are used in the filtering.

See also

Create a task in Task Manager (page 108)
Customize your Task Manager view (page 104)

2.4 Import tasks and task types to Task Manager

You can import tasks and task types from external project management software to Task Manager. For example, you can import general building schedules from Microsoft Project, and further modify them in Task Manager.

On the Manage tab, click Tasks, and do the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Import tasks | You can import one task file at a time. The file can contain more than one task.  
  1. Click > Import. 
  2. Browse for the file to import. |
3. Select **Import baseline dates to planned dates** to import the baseline dates of tasks as the planned dates.
   By default, scheduled dates are imported to **Task Manager** as planned dates.

4. Select how the tasks are imported to **Task Manager**:
   - **Append imported tasks to scenario** adds the imported tasks at the end of the task list.
   - **Override existing tasks** replaces the existing tasks with the imported tasks.
     The links between the existing tasks and model objects are not modified. Task dependencies are imported.
   - **Override selected properties of existing tasks** imports task properties.
     When you select this option, **Task Manager** displays a list where you can select the properties.
     The links between the existing tasks and model objects are not modified. Task dependencies are imported.

5. Click **OK**.

Imported tasks are marked as imported 🅱️ and locked 🗝️ in **Task Manager**.

### Import task types

You can import one task type file at a time. The file can contain more than one task type.

1. Click ➤ **Task Types**.
2. Click **Import**.
3. Browse for the file to import.
4. Select how the task types are imported to **Task Manager**:
   - **Override task types using the same name** replaces the existing task types that have the same task type name as the imported task types.
   - **Append imported task types** adds the imported task types at the end of the task type list.

5. Click **OK**.

**See also**

*Create a task in Task Manager (page 108)*
Define a task type in Task Manager (page 109)

2.5 Export tasks and task types from Task Manager
You can export tasks and task types from Task Manager to external project management software.

On the Manage tab, click Tasks, and do the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export tasks</td>
<td>1. Click &gt; Export.</td>
</tr>
<tr>
<td></td>
<td>2. Browse for the file to export.</td>
</tr>
<tr>
<td></td>
<td>3. Click Save.</td>
</tr>
<tr>
<td></td>
<td>Task dependencies are exported.</td>
</tr>
<tr>
<td></td>
<td>If the tasks contain only planned dates, they are exported as scheduled dates.</td>
</tr>
<tr>
<td></td>
<td>If the tasks contain planned dates and actual dates, the planned dates are exported as baseline dates and the actual dates as scheduled dates.</td>
</tr>
<tr>
<td>Export task types</td>
<td>1. Click &gt; Task Types.</td>
</tr>
<tr>
<td></td>
<td>2. Click Export.</td>
</tr>
<tr>
<td></td>
<td>3. Browse for the file to export.</td>
</tr>
<tr>
<td></td>
<td>4. Click Save.</td>
</tr>
</tbody>
</table>

See also
Create a task in Task Manager (page 108)
Define a task type in Task Manager (page 109)

2.6 Print a task schedule from Task Manager
You can print task schedules from Task Manager. By default, the schedule is printed from the first date to the last date that is visible in the Gantt chart.

1. On the Manage tab, click Tasks.

2. Click .

3. Select the suitable printing options:
   - Click Page Setup to modify the page settings.
• Select **Print to the project end date** to print the whole schedule even if the end date is not visible in the Gantt chart.

• Select **Adjust to percent of normal size** or **Fit to pages** according to your needs.

4. If needed, click **Print Preview** to view how the schedule is printed.

   You can print the schedule from the **Print preview** dialog box.

5. Click **Print** to print the schedule.

6. Modify the printer settings if needed.

7. Click **Print**.

**TIP** You can create reports from the task information in **Task Manager** and list various details about the tasks, such as the task name, task type, planned and actual dates, and task completeness.

---

**See also**

Create a task in Task Manager (page 108)

### 2.7 Example: Visualize a Task Manager schedule in the model

You can use the **Project Status Visualization** tool to review the task schedules created in **Task Manager**.

In this example, you will first create object groups to define which tasks are shown in the model. The object groups are related to the current **Task Manager** scenario. You will then create object representation settings to define how the tasks are shown in the model. Finally, you will review the task schedule using the **Project Status Visualization** tool.

1. Create object groups for tasks:
   a. In Tekla Structures, go to the **View** tab and click **Representation**.
   b. Click **Object group**.
   c. In the **Object group - Representation** dialog box, create an object group with the following settings:

<table>
<thead>
<tr>
<th>Task</th>
<th>Property</th>
<th>Condition</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
<td>Planned start date</td>
<td>Earlier than</td>
<td>Review date</td>
</tr>
<tr>
<td>Task</td>
<td>Planned end date</td>
<td>Earlier than</td>
<td>Review date</td>
</tr>
</tbody>
</table>

   d. Enter a name for the group, for example **Completed**, in the box next to the **Save as** button, and then click **Save as**.
e. Repeat steps 1c - d to create an object group called Started. Use the following settings:

<table>
<thead>
<tr>
<th>Category</th>
<th>Property</th>
<th>Condition</th>
<th>Value</th>
<th>And/Or</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
<td>Planned start date</td>
<td>Earlier than</td>
<td>Review date</td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>Planned end date</td>
<td>Later than or</td>
<td>Review date</td>
<td></td>
</tr>
</tbody>
</table>

f. Repeat steps 1c - d to create an object group called NotStarted. Use the following settings:

<table>
<thead>
<tr>
<th>Category</th>
<th>Property</th>
<th>Condition</th>
<th>Value</th>
<th>And/Or</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
<td>Planned start date</td>
<td>Later than</td>
<td>Review date</td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>Planned end date</td>
<td>Later than</td>
<td>Review date</td>
<td></td>
</tr>
</tbody>
</table>

g. Repeat steps 1c - d to create an object group called All. Use the following settings:

<table>
<thead>
<tr>
<th>Category</th>
<th>Property</th>
<th>Condition</th>
<th>Value</th>
<th>And/Or</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part</td>
<td>Name</td>
<td>Equals</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

h. Click Close.

2. Create object representation settings for tasks:
   a. In the Object Representation dialog box, select the object group Completed from the list in the Object group column.
   b. In the Color column, select a color for the object group, for example White.
   c. In the Transparency column, select a transparency setting for the object group, for example Visible.
   d. Click Add row to add a new row.
   e. Repeat steps 2a – d to define the color and transparency settings for the other object groups (Started, NotStarted, and All).

   For example, you can use the following settings:

<table>
<thead>
<tr>
<th>Object group</th>
<th>Color</th>
<th>Transparency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completed</td>
<td>White</td>
<td>Visible</td>
</tr>
<tr>
<td>Started</td>
<td>White</td>
<td>Visible</td>
</tr>
<tr>
<td>NotStarted</td>
<td>Yellow</td>
<td>90% transparent</td>
</tr>
<tr>
<td>All</td>
<td>Red</td>
<td>50% transparent</td>
</tr>
</tbody>
</table>

   Enter a name for the object representation settings, for example Tasks, and then click Save as

   f. Click OK.

3. Review the task schedule using Project Status Visualization:
   a. In Tekla Structures, go to the Manage tab and click Project status.

   Example: Visualize a Task Manager schedule in the model
b. Select **Tasks** from the **Object representation** list.

c. Click the step buttons to change the **Review date** and to view the changes in the model.

**See also**

- Create a task in Task Manager (page 108)
- Create a scenario in Task Manager (page 120)
Use the **Phase Manager** to break a model up into sections.

Phases are often used to indicate erection sequences. You can create reports and views, hide and lock objects, and copy objects from other models, according to their phase number.

For example, you might have a large project which several users work on simultaneously in single-user mode. First create a basic model that includes, for example, the columns. This is phase 1. You then copy this basic model to all users.

Each user then works on a separate part of the building. When a part of the model is completed, you can copy it back to the basic model as a separate phase (phase 2, 3, etc.).

**NOTE** When you copy objects between models using phases, the target model must have been created using the same or newer version of Tekla Structures as the source model. You cannot copy from a newer version to an older version.

See also

- Divide the model into phases (page 130)
- Lock and unlock objects in specific phases (page 131)
- Custom phase properties (page 132)

### 3.1 Divide the model into phases

1. On the **Manage** tab, click **Phases**.
   The **Phase Manager** dialog box appears.

2. Click **Add** to create new phases.
3. Click **Set current** to make the selected phase the current phase.

   From now on, Tekla Structures assigns all objects you create to the current phase. The @ character in front of the phase number indicates the current phase.

4. Divide the model into phases.
   a. To identify the phase of an object, select an object and click **Phases by objects**.
      
      Tekla Structures selects the phase of the object.
   b. To see which objects belong to a certain phase, select a phase from the list and then click **Objects by phases**.
      
      Tekla Structures highlights the corresponding objects in the model.
   c. To change the phase of one or more objects, select the objects, select a phase from the list, and then click **Modify phase**.

5. Click **OK** to save your changes.

   **See also**
   
   - Lock and unlock objects in specific phases (page 131)
   - Custom phase properties (page 132)
   - Phase Manager (page 130)

3.2 **Lock and unlock objects in specific phases**

   To protect model objects from being accidentally modified or deleted, you can lock them. For example, you can lock parts, bolts, welds, and reference models in a Tekla Structures model according to their phase.

   When an object is locked, you cannot modify its properties or delete it. You can only change the object's user-defined attributes that do not affect numbering. If you try to modify or delete a locked object, Tekla Structures displays the following warning message:

   "There are locked objects, see report. The operation could not be performed."

   1. On the **Manage** tab, click **Phases**.
   2. In the **Phase Manager** dialog box, select the phases whose objects you want to lock or unlock.
   3. Do one of the following:
      - To lock objects, click **Lock objects**.
        
        Tekla Structures sets the user-defined attribute **Locked** to **Yes** for the objects in the selected phases.
• To unlock objects, click **Unlock objects**.
  Tekla Structures sets the user-defined attribute **Locked** to **No** for the objects in the selected phases.

**See also**
- Phase Manager (page 130)
- Divide the model into phases (page 130)

### 3.3 Custom phase properties

You can add custom phase properties, which will appear as extra columns in the **Phase Manager** dialog box.

Define the names of phase properties in the `objects.inp` file. To use phase properties in reports and templates, use the syntax `PHASE.ATTRIBUTE_NAME` in the phase property field name.

**See also**
- Phase Manager (page 130)
With lots you can group assemblies for transporting to site. Lotting means that you evaluate specific model parts with respect to the number of units that can be carried by a transfer vehicle.

For example, you can calculate how many concrete truck deliveries are needed to pour the footings or slabs for a specific portion of the model. With this information, it is easier to determine area requirements and create an erection schedule.

When you define lots, you must take into account the load-carrying capacity of the vehicle, because a lot cannot exceed the maximum total load capacity. You can calculate truck load sizes based on material weights and model quantities. For most model parts, the weight is based on the size, length, and material of the part.

**TIP** To view the properties of a part, right-click the part and then select *Inquire* --&gt; *Part* or *Properties*.

You can use lotting in conjunction with the *Sequencer* tool. For example, you can load each part of the model onto a specific truck based on the erection sequence of the part.

The basic lotting process is the same for steel and concrete parts. However, if you are using cast-in-place concrete, remember that the concrete is transported in a volumetric container (for example, in a ten-cubic-yard truck). In that case, you must calculate the weight-carrying capacity of the concrete vehicle before defining the number of lots.

**See also**

Create a lot (page 134)
Add parts to a lot (page 134)
Remove parts from a lot (page 134)
Delete a lot (page 135)
Sequencer (page 136)
4.1 Create a lot
Create lots to group assemblies for transporting to a site.

1. On the Manage tab, click Lotting.
2. Click Properties to display the Lot Properties dialog box.
3. Enter a name in the box at the bottom of the dialog box.
4. Enter a lot number in the Number box.
5. Enter the maximum weight of the lot in the Max weight box. The units depend on the settings in File menu --> Settings --> Options --> Units and decimals.
6. Click Add.
   Tekla Structures creates an empty lot with the defined properties.

See also
Add parts to a lot (page 134)
Remove parts from a lot (page 134)
Delete a lot (page 135)

4.2 Remove parts from a lot

1. On the Manage tab, click Lotting.
2. Select an existing lot from the list.
   Tekla Structures highlights the parts included in the lot.
3. Hold down Ctrl and select the parts you want to remove from the lot.
   Tekla Structures deselects the parts.
4. Click Apply selected.
5. Click OK to close the dialog box.

See also
Add parts to a lot (page 134)
Delete a lot (page 135)
4.3 Add parts to a lot

After you have created the needed lots, you must select each part of the model and assign them to a lot until the total load weight of the lot reaches the specified target.

1. On the Manage tab, click Lotting.
2. Select an existing lot from the list.
   Tekla Structures highlights the parts included in the lot. The total weight of the lot and the number of assemblies it contains are displayed under Applied values.
3. Hold down Shift and select the parts that you want to add to the lot.
4. Click Apply selected.
   The weight and the number of added parts are displayed under Current values. Tekla Structures displays a warning message if the weight limit of the lot is exceeded.
5. Click OK to close the dialog box.
   When you re-open the dialog box, the Applied values include the weight and the number of parts you added.

WARNING Parts can belong only to one lot at a time. If you add parts that are already in another lot, the parts will be removed from that lot.

See also
Create a lot (page 134)
Remove parts from a lot (page 134)

4.4 Delete a lot

1. On the Manage tab, click Lotting.
2. Click Properties.
3. Select an existing lot from the list.
4. Click Delete.

See also
Lotting (page 133)
Use the **Sequencer** tool to name sequences and assign incremental numbers to parts.

You can define several sequences for different purposes, and a part can belong to several sequences at the same time. For example, you can define the order in which to erect parts by creating erection sequences.

**Sequencer** works by assigning a sequence number to a user-defined attribute of a part. The sequence name that you enter in the **Sequencer Properties** dialog box is the name of the user-defined attribute defined in the *objects.inp* file.

**Limitations**

Sequencer does not work for objects that are inside a reference model.

**See also**

- Create a sequence (page 136)
- Add parts to a sequence (page 137)
- Check the sequence of a part (page 138)
- Modify the sequence number of a part (page 138)
- Delete a sequence (page 139)

### 5.1 Create a sequence

Use the **Sequencer** tool to assign sequence numbers to parts. If you want to view and modify the sequence number afterwards, you must first create a user-defined attribute to which you assign sequence numbers.

1. Create a user-defined attribute to which you assign sequence numbers.
   a. Open the *objects.inp* file in any standard text editor.
   b. In the *Part attributes* section, add a new user-defined attribute.
The value_type must be integer, and the field_format must be %d.

For example:

attribute("MY_INFO_1", "My Info 1", integer, "%d", no, none, "0.0", "0.0")

c. Save the file.
d. Restart Tekla Structures.

2. On the Manage tab, click Sequencer.

3. Enter a name for the sequence. Use exactly the same name as in the objects.inp file.

   For example, MY_INFO_1.

4. Click Apply.

5. Select the parts you want to include in the sequence.

   The first part gets the sequence number 1, the second part number 2, and so on.

   If you select a part that has already been included in the sequence, Tekla Structures asks if you want to override the existing number. If you click Yes, Tekla Structures gives the next available number to the part.

6. To finish adding parts to the sequence, right-click and select Interrupt or press Esc.

See also

Add parts to a sequence (page 137)
Check the sequence of a part (page 138)
Modify the sequence number of a part (page 138)
Delete a sequence (page 139)

5.2 Add parts to a sequence

You can add new parts at the end of an existing sequence. If the sequence changes, you must redefine the whole sequence.

1. On the Manage tab, click Sequencer.

2. Select a sequence name from the list.

3. Click OK or Apply.

4. Select the parts you want to add to the sequence.

5. To finish adding parts to the sequence, right-click and select Interrupt or press Esc.
5.3 **Check the sequence of a part**

You can check the sequence name and number of a part by using the **Inquire** tool.

1. On the ribbon, click **Inquire objects**.
2. Select a part.

   Tekla Structures displays the properties of the part. The sequence name and number are displayed under **More**. For example:

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence_1</td>
<td>5</td>
</tr>
<tr>
<td>Sequence_2</td>
<td>4</td>
</tr>
</tbody>
</table>

See also

**Modify the sequence number of a part (page 138)**

5.4 **Modify the sequence number of a part**

Modify a sequence number that has been assigned to a part using the **Sequencer** tool.

Before you start, assign a sequence number to a user-defined attribute of a part.

1. Double-click a part to open the part properties dialog box.
2. Click **User-defined attributes...**

   The current sequence number is displayed next to the user-defined attribute to which you assigned the sequence number. For example, **MY_INFO_1**.

3. Modify the sequence number.
4. Click **Modify**.

See also

**Create a sequence (page 136)**
5.5 Delete a sequence
Delete a sequence that has been created using the **Sequencer** tool.
1. On the **Manage** tab, click **Sequencer**.
2. Select a sequence name from the list.
3. Click **Delete** and then click **Yes**.

See also
**Sequencer** (page 136)
Project Status Visualization

Use the **Project Status Visualization** tool to review the status of model objects in a specific time frame.

You can, for example:

- display the erection schedule for groups of parts using different colors
- identify the parts that are scheduled to be fabricated during a specific time period.

Before you can create project status visualizations, you need to define some color and transparency settings that include object groups based on date rules.

You can also define tasks for parts and assemblies using **Task Manager**. The project status visualization can then be based on tasks.

**See also**

- Create a visualization (page 140)
- Copy visualization settings to another model (page 141)
- Delete visualization settings (page 141)
- Project status visualization example: Visualize the erection schedule of a project (page 142)
- Example: Visualize a Task Manager schedule in the model (page 127)

### 6.1 Create a visualization

Create visualization settings to view the project status of model objects in a specific time frame.

1. On the **Manage** tab, click **Project status** to open the **Project Status Visualization** dialog box.
2. Modify the visualization settings.
a. In the **Object representation** list, select one of the predefined object representation settings.

b. Define a start and end date for the time scale slider.

c. Define the length of the time step.

3. Select the **Refresh view automatically** check box.

4. Enter a unique name in the box next to the **Save as** button.

5. Click **Save as** to save the visualization settings.

6. To view the visualization in the model, click the step buttons.

**See also**

Project status visualization example: Visualize the erection schedule of a project (page 142)

---

### 6.2 Copy visualization settings to another model

You can copy project status visualization settings to another model. The visualization settings files are located in the model's `\attributes` folder, and they have the file name extension `.4d`.

1. In the model's `\attributes` folder, select the visualization settings you want to copy.

2. Select where you want to copy the settings.

   - To make the settings available in another model, copy them to the `\attributes` folder of the destination model.
   - To make the settings available in all models, copy them to the project or firm folder, defined by the advanced option `XS_PROJECT` or `XS_FIRM`.

3. Include a copy of the object representation settings file (.rep) and object group files (.PObjGrp) in the `\attributes`, `project`, and `firm` folders to ensure that all the files will work correctly.

4. Restart Tekla Structures.

**See also**

Project Status Visualization (page 140)

---

### 6.3 Delete visualization settings

Delete the project status visualization settings that have been created using the **Project Status Visualization** tool.
1. Delete the visualization settings file located in the model's attributes folder.
   Project status visualization settings have the file name extension .4d.
2. Restart Tekla Structures.

See also
Project Status Visualization (page 140)

6.4 Project status visualization example: Visualize the erection schedule of a project
This example shows how to visualize erection schedules using the Project Status Visualization tool. The workflow consists of five tasks:
1. Project status visualization example: Define an erection schedule (page 142)
2. Project status visualization example: Select objects for the visualization (page 143)
3. Project status visualization example: Define the color and transparency of selected objects (page 143)
4. Project status visualization example: Define a time period for visualization (page 144)
5. Project status visualization example: View the erection schedule (page 145)

Project status visualization example: Define an erection schedule
Start by defining an erection schedule for parts using the user-defined attribute Erection Planned start. This task is phase 1 in the workflow Project status visualization example: Visualize the erection schedule of a project (page 142).
1. Double-click a part to open the part properties dialog box.
2. Click User-defined attributes.
3. On the Workflow tab, modify the value of the user-defined attribute Erection Planned start.
4. Ensure that all the check boxes are cleared.
5. Select the **Erection Planned start** check box.
6. Select all the parts for which you want to use the same erection date.

**TIP** To make it easier to select parts, create a separate selection filter for each group of parts.

7. Click **Modify**.
8. Repeat steps 1–7 for each group of parts in your model.
   You can use a different erection date for each group of parts.

### Project status visualization example: Select objects for the visualization

After defining an erection schedule, you can continue by creating an object group that defines which objects are shown in the model during the visualization. This task is phase 2 in the workflow [Project status visualization example: Visualize the erection schedule of a project](page 142).

1. On the **View** tab, click **Representation** to open the **Object Representation** dialog box.
2. Click **Object group** to open the **Object Group - Representation** dialog box.
3. Create an object group that includes all objects whose user-defined attribute **Erection Planned start** is earlier than or equal to the review date.
   a. In the **Category** list, select **Object**.
   b. In the **Property** list, select **PLANNED_START_E**.
   c. In the **Condition** list, select **Earlier than or equal**.
   d. In the **Value** list, select **Select date**.
   e. In the **Select Date** dialog box, select **Review date** and click **OK**.
4. In the box next to the **Save as** button, enter a name for the group. For example, **plan_same_or_before_review_date**.
5. Click **Save as**.
Project status visualization example: Define the color and transparency of selected objects

After defining which objects are shown in the model during the visualization, you can continue by defining color and transparency settings that define how the objects are shown during the visualization. This task is phase 3 in the workflow Project status visualization example: Visualize the erection schedule of a project (page 142).

1. On the View tab, click Representation to open the Object Representation dialog box.

2. Define color and transparency settings for the object group that you created in Project status visualization example: Select objects for the visualization (page 143).
   a. Click Add row.
   b. In the Object group list, select the object group you just created.
   c. In the Color list, select Color by class.
   d. In the Transparency list, select Visible.

3. Define another set of color and transparency settings to hide the rest of the parts from the model.
   a. Click Add row.
   b. In the Object group list, select the object group All.
   c. In the Color list, select Color by class.
   d. In the Transparency list, select Hidden.

4. In the box next to the Save as button, enter a name for the settings. For example, planned_start_erection_date.

5. Click Save as.

<table>
<thead>
<tr>
<th>Object group</th>
<th>Color</th>
<th>Transparency</th>
</tr>
</thead>
<tbody>
<tr>
<td>plan_same_or_before_review_date</td>
<td>Color by class</td>
<td>Visible</td>
</tr>
<tr>
<td>All</td>
<td>Color by class</td>
<td>Hidden</td>
</tr>
</tbody>
</table>

Project status visualization example: Define a time period for visualization

After defining how the objects are shown during the visualization, you can continue by defining a time period for the visualization. This task is phase 4 in...
the workflow Project status visualization example: Visualize the erection schedule of a project (page 142).

1. On the Manage tab, click Project status to open the Project Status Visualization dialog box.
2. Define the length of the time step.
3. Define a start and end date for the time scale slider.
4. In the Object representation list, select the object representation setting you created in Project status visualization example: Define the color and transparency of selected objects (page 143).
5. Select the Refresh view automatically check box.
6. In the box next to the Save as button, enter a name for the visualization.
7. Click Save as to save the visualization settings.

![Project Status Visualization](image)

Project status visualization example: View the erection schedule

You are now ready to view the erection schedule using the Project Status Visualization tool. This task is phase 5 in the workflow Project status visualization example: Visualize the erection schedule of a project (page 142).

1. On the Manage tab, click Project status to open the Project Status Visualization dialog box.
2. In the list next to the Load button, select the visualization setting you created in Project status visualization example: Define a time period for visualization (page 144).
3. Click Load.
4. To view the visualization in the model, click the step buttons.
The images below show how the objects are shown when you change the review date:

<table>
<thead>
<tr>
<th>Review date</th>
<th>Visualization</th>
</tr>
</thead>
<tbody>
<tr>
<td>November 02</td>
<td><img src="image1" alt="Visualization" /></td>
</tr>
<tr>
<td>November 05</td>
<td><img src="image2" alt="Visualization" /></td>
</tr>
<tr>
<td>November 08</td>
<td><img src="image3" alt="Visualization" /></td>
</tr>
</tbody>
</table>

Project Status Visualization 146 Project status visualization example: Visualize the erection schedule of a project
<table>
<thead>
<tr>
<th>Review date</th>
<th>Visualization</th>
</tr>
</thead>
<tbody>
<tr>
<td>November 11</td>
<td><img src="image1" alt="Visualization" /></td>
</tr>
<tr>
<td>November 14</td>
<td><img src="image2" alt="Visualization" /></td>
</tr>
</tbody>
</table>

Project status visualization example: Visualize the erection schedule of a project.
<table>
<thead>
<tr>
<th>Review date</th>
<th>Visualization</th>
</tr>
</thead>
<tbody>
<tr>
<td>November 17</td>
<td><img src="image1" alt="" /></td>
</tr>
<tr>
<td>November 20</td>
<td><img src="image2" alt="" /></td>
</tr>
</tbody>
</table>

Project Status Visualization example: Visualize the erection schedule of a project
The profile catalog contains information on profiles, their rules and types, and the analysis and design properties of the profiles. Profiles are displayed in a hierarchical tree grouped according to rules.

By default, the profile catalog contains standard, environment-specific profiles and generic parametric profiles. You can add, modify, import, export, and delete profiles.

Tekla Structures stores the profile catalog information in the profdb.bin file.

**See also**
- Profile types (page 149)
- Manage profiles (page 150)
- Import and export profiles (page 158)
- Create your own profiles (page 165)
- Define standardized values for parametric profiles (page 216)
- Create an image of a profile (page 217)
- Predefined parametric profiles available in Tekla Structures (page 218)
- Shapes (page 252)

### 7.1 Profile types

There are two types of profiles in Tekla Structures:

- **Fixed profiles**

Fixed profiles are profiles that can be obtained pre-manufactured. The properties of the fixed profiles conform to industry standards, and you should not modify them unless you are an administrator. Fixed profiles are environment-specific.
- **Parametric profiles**

  Parametric profiles are partly user-definable: they have a predefined shape but you can change their cross section dimensions using one or more parameters. Tekla Structures calculates the cross section shape each time you open the model.

  You can use the profiles available in Tekla Structures, or you can define your own user-defined profiles, which can be either fixed or parametric. Use the profile catalog to create new fixed profiles, either from scratch or by copying an existing one. Use the sketch editor or .clb files to create new parametric profiles.

  **See also**

  - Create your own profiles (page 165)
  - Predefined parametric profiles available in Tekla Structures (page 218)

### 7.2 Manage profiles

You can manage existing profiles using the profile catalog. For example, you can group profiles and add your own attributes to profiles.

Click the links below to find out more:

- Important buttons in the profile catalog (page 150)
- Group profiles together (page 151)
- Add user attributes to profiles (page 153)
- Associate profile types with a certain material (page 156)
- Delete a profile from the profile catalog (page 157)

**Important buttons in the profile catalog**

When you work with the profiles, note the usage of the following buttons in the **Modify Profile Catalog** dialog box:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Update" /></td>
<td>Saves the changes of a single edited profile to the computer’s memory until you click <strong>OK</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="OK" /></td>
<td>Saves the changes in the model folder. Tekla Structures saves the modified catalog on the hard disk when you click <strong>OK</strong> to close the dialog box and then click <strong>OK</strong> in the <strong>Save confirmation</strong> dialog box.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| ![Cancel](cancel.png) | Closes the **Modify Profile Catalog** dialog box without saving the changes.  
Note that all changes made to the catalog will be lost even if you have clicked **Update**, because the changes have not been saved on the hard disk. The changes made to the catalog are visible during one session, because the catalog is using the computer’s memory. When you start Tekla Structures the next time, the previous data is restored from the hard disk. |

Tekla Structures stores the information of fixed profiles in the **profdb.bin** file. When you first open a model, Tekla Structures reads the data from the hard disk and stores it in the computer’s memory.

When you select a profile, Tekla Structures reads the data from the computer’s memory and displays it in the **Modify Profile Catalog** dialog box. This is faster than accessing the data from the hard disk.

**See also**

Manage profiles (page 150)

**Group profiles together**

In the profile catalog, the profiles are displayed in a hierarchical tree and they are grouped according to rules, such as the profile type (for example, I profiles) and the profile subtype (for example, HEA). To change how the profiles are grouped in the profile tree, you need to modify the rules.

The order in which you create the rules does not matter, only the location of the rules in the profile tree.

Tekla Structures reads the rules from top to bottom in the profile tree. Profiles are in the highest group where they meet the criteria defined in the rule. For example, a rule that collects **All profiles** overrides all rules that are below it in the profile tree.

**See also**

Add a rule to the profile catalog (page 151)

Modify a rule in the profile catalog (page 152)

**Add a rule to the profile catalog**

1. On the **File** menu, click **Catalogs** --> **Profile catalog** to open the **Modify Profile Catalog** dialog box.
2. Right-click any existing rule and select **Add Rule**.
   The **Profile manager rules** dialog box appears.

3. Define the rule properties.
   a. Enter a rule name in the **Rule name** box.
   b. Select the **Profile type** to which the rule is applied.
   c. Enter the **Name filter string** that defines the new rule.
      By default, the wildcard symbol (*) is entered, meaning “all entries”.
      For example, to group all catalog entries with names beginning with A, enter \textls{A*} in the **Name filter string** box, or to group all catalog entries with names containing 100, enter \textls{*100*}. Tekla Structures groups the catalog entries that meet your criteria under the new rule.

4. Click **OK** to close the **Profile manager rules** dialog box.

5. Click **OK** to close the **Modify Profile Catalog** dialog box.

6. Click **OK** in the **Save confirmation** dialog box to save the changes.

   **TIP** You can add a next level rule that creates a subgroup under an existing rule. Use the **Add Next Level Rule** command to add the next level rule.

---

**See also**

*Modify a rule in the profile catalog (page 152)*

---

**Modify a rule in the profile catalog**

1. On the **File** menu, click **Catalogs --> Profile catalog** to open the **Modify Profile Catalog** dialog box.

2. Right-click any existing rule and select **Edit Rule**.
   The **Profile manager rules** dialog box appears.

3. Modify the rule properties.

4. Click **OK** to close the **Profile manager rules** dialog box.

5. Click **OK** to close the **Modify Profile Catalog** dialog box.

6. Click **OK** in the **Save confirmation** dialog box to save the changes.

Profiles in the profile tree are listed in an alphabetical order, and rules are listed in the order you specify. To change the order in which the rules appear, use the **Move up** and **Move down** commands.

   **TIP** If you want to delete a rule, right-click an existing rule and select **Delete Rule**.
**Add user attributes to profiles**

You can add your own attributes to profiles. For example, you can specify paint layer thickness, define the maximum grain size of concrete, sort out different profile types by material, or create profile aliases for converting imperial profiles to metric and vice versa.

1. On the **File** menu, click **Catalogs --> Profile catalog** to open the **Modify Profile Catalog** dialog box.
2. On the **User attributes** tab, click **Definitions**.
   The **Modify Profile Properties** dialog box appears.
3. Click **Add** to add a new row.
4. To define a user attribute, click each item on a row.
   a. In the **Profile type** list, select a profile type to which the user attribute is applied.
   b. In the **Quantity type** list, select the type of information that the user attribute contains, for example, weight, area, ratio, or string.
   c. In the **Order** list, define the order in which the user attributes are shown in the dialog box. Larger values are shown first.
   d. In the **Property name** list, define a name for the property.
      The name is saved in the catalog and can be used in reports and templates. When **Property name** is used in a template, PROFILES.PROPERTY_NAME indicates where the property name appears. For example, PAINT_LAYER_THICKNESS.
   e. In the **Symbol** column, define an abbreviation that can be used for the property, such as Ix or ct.
   f. In the **Label** column, define a label for the attribute.
5. Click **Update**.
6. Click **OK** to close the **Modify Profile Properties** dialog box.

**See also**

*Example: Add a user attribute to a profile and use it in a rule (page 153)*
Example: Add a user attribute to a profile and use it in a rule
You can add your own attributes and their values to profiles. The user attributes can then be used, for example, in profile filtering.

In this example, you will add a user attribute for I profiles’ rule.

1. On the File menu, click Catalogs -- Profile catalog to open the Modify Profile Catalog dialog box.
2. On the User attributes tab, click Definitions.
   The Modify Profile Properties dialog box appears.
3. Click Add to add a new row.
4. Select the row that was created and modify the properties as follows:
   • Set Profile type to I profiles.
   • Set Quantity type to String.
   • Set Property name to HISTORICAL_PROFILE.
   • Set Symbol to Hist.
   • Set Label to Historical profile.
5. Click Update and OK.
6. In the profile tree, select I profiles and then HEA.
7. Right-click and select Add Next Level Rule.
8. In the Profile manager rules dialog box, set the rule properties as follows:
   • Set Rule name to Historical profiles.
   • In Profile type, clear the All profiles check box and select the I profiles check box.
   • Enter HEA* in the Name filter string box.
• Set **User attribute** to **HISTORICAL_PROFILE** and **Equals**, and enter **Yes** in the box next to the two other boxes.

9. Click **OK**.

**Historical profiles** appears in the profile tree.

10. Select the required historical profile, for example **HEA120**, in the profile tree.

11. Go to the **User attributes** tab and set **Value** of **Historical profile** to **Yes**.

12. Click **Update**.

13. Repeat the steps 10 and 11 for any other required profiles.
14. Click **OK** to close the **Modify Profile Catalog** dialog box.

15. Click **OK** in the **Save confirmation** dialog box to save the changes.

Next time you open the profile catalog, the profiles appear under **Historical profiles** in the profile tree.

**See also**

*Add user attributes to profiles (page 153)*

*Add a rule to the profile catalog (page 151)*

**Associate profile types with a certain material**

You can define which profiles are available for steel parts, concrete parts, or both. This affects which profile types are shown in the **Select Profile** dialog box when you change the material of a part.

To define the material of a profile type:

1. On the **File** menu, click **Catalogs --> Profile catalog** to open the **Modify Profile Catalog** dialog box.

2. Select a profile type, for example, **L profiles**.

3. To associate the profiles with steel, right-click and select **Material --> Steel**.
A check mark next to **Steel** indicates that the profiles are available for steel parts.

4. To make the selected profiles available also for concrete parts, right-click and select **Material --> Concrete**.

   If needed, you can remove the check mark by clicking the material again.

5. Click **OK** to close the **Modify Profile Catalog** dialog box.

6. Click **OK** in the **Save confirmation** dialog box to save the changes.

### Delete a profile from the profile catalog

1. On the **File** menu, click **Catalogs --> Profile catalog** to open the **Modify Profile Catalog** dialog box.

2. Select the profile that you want to delete.

3. Right-click and select **Delete Profile**.

4. Click **OK** to close the **Modify Profile Catalog** dialog box.

5. Click **OK** in the **Save confirmation** dialog box to save the changes.

Tekla Structures will continue showing parts in model views using the deleted profiles until you modify the parts or reopen the model. After that, the parts
having profiles that are not available in the profile catalog, are shown as sticks without a profile.

See also
Manage profiles (page 150)

7.3 Import and export profiles
Use importing and exporting for merging profiles across profile catalogs. Profile catalogs are imported and exported as .lis files, sketched profiles as .uel files, and user-defined parametric profiles as .clb files.

When you export an entire profile catalog, Tekla Structures creates three separate files: profiles.clb, profiles.lis and rules.lis. The .clb file contains parametric profile definitions, if they are used in the profiles in the catalog, otherwise it is empty. The profiles.lis file includes the actual profile definitions and the rules.lis file the branch rules. When you export a branch of a profile catalog, the branch name is attached as prefix to the file names.

Importing and exporting is useful when you:
• upgrade to a newer version of Tekla Structures and want to use a customized profile catalog from a previous version
• want to combine profile catalogs that are stored in different locations
• want to share profile catalog information with other users
• want to combine profile catalogs across different environments.

Limitations
• You cannot import or export hard-coded profiles such as PROFILE_ZZ, PROFILE_CC, and PROFILE_CW.
• You cannot import profiles that do not have a defined cross section.
• If you have used a sketched profile or a user-defined parametric profile as the cross section for a fixed profile, you also need to import the sketched profile or the user-defined parametric profile to the new model.

TIP You can also download or share profiles using Tekla Warehouse.

See also
Export an entire profile catalog (page 160)
Export a part of the profile catalog (page 160)
Import profile catalog items (page 159)
Import profile catalog items

Tekla Structures has five types of profile catalog items: fixed profiles, hard-coded parametric profiles, sketched profiles, user-defined parametric profiles, and rule sets. Profiles and rule sets are imported to Tekla Structures models as .lis files, sketched profiles as .uel files, and user-defined parametric profiles as .clb files.

If you are importing an entire profile catalog or a branch, we recommend that you save the related files in a separate folder. This makes the import process faster.

1. Open the model to which you want to import profile catalog items.
2. On the File menu, click Catalogs --> Profile catalog to open the Modify Profile Catalog dialog box.
3. Click Import to import a single file, or Import Directory to import the contents of a file folder.
4. Select the import file or the import folder.
5. Click OK.

If a profile item with the same name as the profile item being imported already exists, the Review import items dialog box appears, and you have four options:

- **Leave**: The existing profile item is not replaced and the profile definitions in the import file are ignored.
- **Merge**: Profile properties that are different in the import file are added to the existing profile. All the other properties remain unchanged.
  Use this option to import only certain elements of the profile catalog, such as user attributes.
- **Replace**: The existing profile item is replaced with the imported profile item.
- **Continue**: The dialog box closes and the actions you selected take place. If an import item has Unknown as the action, it is not imported.

You can select more than one profile item at a time by using the Shift and Ctrl keys.

NOTE Each cross section definition has a unique name and ID number. If, during an import, a cross section with the same name but different properties is found in the existing profile catalog, the cross section being imported is renamed by adding an incremental number at the end of the existing name.
6. Click **OK** to close the **Modify Profile Catalog** dialog box.
7. Click **OK** in the **Save confirmation** dialog box to save the changes.

**See also**
- Import and export profiles (page 158)
- Export an entire profile catalog (page 160)
- Export a part of the profile catalog (page 160)
- Import sketched profiles (page 164)
- Units used in import and export (page 163)

**Export an entire profile catalog**
Profile catalogs are exported from Tekla Structures models as .lis, .uel, and .clb files.

1. On the **File** menu, click **Catalogs --> Profile catalog** to open the **Modify Profile Catalog** dialog box.
2. Click **Export**.
3. Browse for the folder where you want to save the export files.
   By default, the files are saved to the current model folder. For faster profile catalog import, we recommend that you create a separate subfolder for the catalog files.
4. Click **OK** to close the **Modify Profile Catalog** dialog box.

**See also**
- Import and export profiles (page 158)
- Export a part of the profile catalog (page 160)
- Example of profile export file (page 161)
- Import profile catalog items (page 159)
- Units used in import and export (page 163)

**Export a part of the profile catalog**
If you do not want to export an entire profile catalog, you can export a branch of the profile tree, meaning all the profiles grouped under one rule, or a single profile. Profiles and rule sets are exported from Tekla Structures models as .lis files, sketched profiles as .uel files, and user-defined parametric profiles as .clb files.
1. On the File menu, click Catalogs --> Profile catalog to open the Modify Profile Catalog dialog box.

2. Select profiles to be exported.
   • To export a branch of the profile tree, right-click the branch and select Export Profiles.
   • To export a single profile, right-click the profile and select Export Profile.

3. Browse for the folder where you want to save the export files.
   By default, the files are saved to the current model folder.
   If you are exporting a single profile, enter a name for the file.

4. Click OK.

5. Click OK to close the Modify Profile Catalog dialog box.

See also

Export an entire profile catalog (page 160)
Example of profile export file (page 161)
Import profile catalog items (page 159)
Units used in import and export (page 163)

Example of profile export file

The export .lis file is divided into specific sections.

The first row in the file is PROFILE CATALOG EXPORT VERSION = n, where n is the version number.

WARNING Do not delete this row. If the row does not appear in the file, the import is canceled.

The next section defines the hierarchical tree structure that is used to display the contents of the catalog.

The next section contains the profiles.
Fixed profiles

PROFILE_NAME = "HE120";
{
  TYPE = 1;  SUB_TYPE = 1001;  COORDINATE = 0.000;
  
  "FLANGE_SLOPE_RATIO"      0.0000000000E+00
  "ROUNDING_RADIUS_2"        0.0000000000E+00
  "ROUNDING_RADIUS_1"        1.2000000000E+01
  "FLANGE_THICKNESS"         8.0000000000E+00
  "WEB_THICKNESS"            5.0000000000E+00
  "WIDTH"                    1.2000000000E+02
  "HEIGHT"                   1.1400000000E+02

Fixed user-defined profiles

Fixed user-defined profiles can have more than one cross section. The profile type for fixed user-defined profiles is 998. \texttt{SUB\_TYPE} refers to the name of the cross section definition. When importing fixed user-defined profiles, the relevant cross section definitions must be in the same import file as the profile.

PROFILE_NAME = "TAN\_HK\_TEST\_2\_CS";
{
  TYPE = 998;  SUB_TYPE = 253;  COORDINATE = 0.000;
  
  "EQUIVALENT\_TYPE" 11
  "FLANGE_SLOPE_RATIO"      0.0000000000E+00
  "ECCENTRICITY\_Y"        0.0000000000E+00
  "ECCENTRICITY\_X"        0.0000000000E+00
  "ROUNDING_RADIUS_2"        0.0000000000E+00
  "FLANGE_THICKNESS_2"         0.0000000000E+00
  "WEB_THICKNESS_2"            0.0000000000E+00

Cross section definitions

\texttt{CROSS\_SECTION\_NAME} = "MY\_OWN\_PROFILE"
POINT\_NUMBER = 1;
POINT\_X = 200.00;
POINT\_Y = -200.00;
CHAMFER\_TYPE = 0;
CHAMFER\_X = 0.00;
CHAMFER\_Y = 0.00;
POINT\_NUMBER = 2;
POINT\_X = 200.00;
POINT\_Y = 200.00;
CHAMFER\_TYPE = 0;
CHAMFER\_X = 0.00;
CHAMFER\_Y = 0.00;

See also

Export an entire profile catalog (page 160)
Export a part of the profile catalog (page 160)
## Units used in import and export

The table below lists the units Tekla Structures uses when importing and exporting profile catalogs and material catalogs.

<table>
<thead>
<tr>
<th>Type</th>
<th>Unit (if blank, no unit)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td></td>
</tr>
<tr>
<td>Integer</td>
<td></td>
</tr>
<tr>
<td>String</td>
<td></td>
</tr>
<tr>
<td>Ratio</td>
<td></td>
</tr>
<tr>
<td>Strain</td>
<td></td>
</tr>
<tr>
<td>Angle</td>
<td>degree</td>
</tr>
<tr>
<td>Length</td>
<td>mm</td>
</tr>
<tr>
<td>Deformation</td>
<td>mm</td>
</tr>
<tr>
<td>Dimension</td>
<td>mm</td>
</tr>
<tr>
<td>Radius of inertia</td>
<td>mm</td>
</tr>
<tr>
<td>Area</td>
<td>mm²</td>
</tr>
<tr>
<td>Reinforcement area</td>
<td>mm²</td>
</tr>
<tr>
<td>Transverse reinforcement area</td>
<td>mm²/m</td>
</tr>
<tr>
<td>Area/unit length</td>
<td>mm²/m</td>
</tr>
<tr>
<td>Volume</td>
<td>mm³</td>
</tr>
<tr>
<td>Section modulus</td>
<td>mm³</td>
</tr>
<tr>
<td>Moment of inertia</td>
<td>mm⁴</td>
</tr>
<tr>
<td>Torsion constant</td>
<td>mm⁴</td>
</tr>
<tr>
<td>Warping constant</td>
<td>mm⁶</td>
</tr>
<tr>
<td>Force</td>
<td>N</td>
</tr>
<tr>
<td>Weight</td>
<td>kg</td>
</tr>
<tr>
<td>Distributed load</td>
<td>N/m</td>
</tr>
<tr>
<td>Spring constant</td>
<td>N/m</td>
</tr>
<tr>
<td>Mass/length</td>
<td>kg/m</td>
</tr>
<tr>
<td>Surface load</td>
<td>N/m²</td>
</tr>
<tr>
<td>Strength</td>
<td>N/m²</td>
</tr>
<tr>
<td>Stress</td>
<td>N/m²</td>
</tr>
<tr>
<td>Modulus</td>
<td>N/m²</td>
</tr>
<tr>
<td>Density</td>
<td>kg/m³</td>
</tr>
<tr>
<td>Moment</td>
<td>Nm</td>
</tr>
</tbody>
</table>
To use a sketched profile in other Tekla Structures models, you have to export the profile to a file (*.uel), and then import the file into another Tekla Structures model.

We recommend that you use the profile catalog to import and export sketched profiles. You can also use the Applications & components catalog to import sketched profiles together with related custom components.

Import and export sketched profiles

After you have exported sketched profiles to a file, you can import them to another Tekla Structures model.

1. Open the Tekla Structures model you want to import to.
2. On the File menu, click Catalogs --> Profile catalog to open the Modify Profile Catalog dialog box.
3. Click Import.
4. In the Import Profile Catalog dialog box, select *.uel from the Filter list.
5. Select the file to import.
6. Click OK.
7. Click OK to close the Modify Profile Catalog dialog box.
8. Click **OK** in the **Save confirmation** dialog box to save the changes.

**TIP**  To automatically import all *.uel* files from a folder when creating a new model, use the advanced option XS_UEL_IMPORT_FOLDER.

**See also**

Export sketched profiles (page 165)

---

### Export sketched profiles

1. Open the Tekla Structures model you want to export from.

2. On the **File** menu, click **Catalogs --> Profile catalog** to open the **Modify Profile Catalog** dialog box.

3. Right-click the profile you want to export and select **Export Profile**.

4. In the **Export Profile Catalog** dialog box, enter a name for the export file in the **Selection** box.

5. If you want to save the export file to a specific location, browse for the folder.
   By default, Tekla Structures saves the export file in the current model folder.

6. Click **OK**.

**See also**

Import sketched profiles (page 164)

---

### 7.4 Create your own profiles

You can create your own profiles and save them in the profile catalog.

Use any of the following methods to create user-defined profiles in Tekla Structures:

<table>
<thead>
<tr>
<th>Profile type</th>
<th>Creation methods</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed profile</td>
<td>• Create a fixed profile (page 172)</td>
</tr>
<tr>
<td></td>
<td>• Create a fixed profile by copying (page 174)</td>
</tr>
<tr>
<td></td>
<td>• Create a fixed profile based on a parametric profile (page 175)</td>
</tr>
<tr>
<td>Parametric profile</td>
<td>• Create parametric profiles using .clb files (page 176)</td>
</tr>
<tr>
<td>Profile type</td>
<td>Creation methods</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• Create parametric profiles by sketching (page 184)</td>
</tr>
<tr>
<td>Parametric profile with variable cross sections</td>
<td>• Create parametric profiles with variable cross sections (page 213)</td>
</tr>
</tbody>
</table>

**Create user-defined cross sections**

User-defined cross sections can be used for creating fixed profiles. Define the needed cross sections before creating the profile.

Use any of the following methods to define a cross section:

- **Define a cross section using polygon (page 166)**
  
  Use this method to create a cross section with fixed dimensions.

- **Define a cross section using a plate (page 168)**
  
  Use this method if you have a contour plate in the model.

- **Define a cross section using a DWG file (page 170)**
  
  Use this method if you have a .dwg file of the profile you want to define.

**See also**

Create fixed profiles (page 172)

**Define a cross section using polygon**

Define a cross section by picking the shape of the cross section.

1. Go to Quick Launch, start typing `define cross section using polygon`, and select the **Define Cross Section Using Polygon** command from the list that appears.

2. Define a cross section without or with inner contours.
   
   - To create a cross section with no inner contours:
     
     a. Pick the corner points of the cross section to define the shape. Start at the bottom-right corner and pick the points counter clockwise.

     b. Pick the start point and click the middle mouse button to close the shape.
c. Pick the center point of the cross section.

TIP To make it easier to define the shape, insert a reference model of the cross section in the model, and use the reference model as a basis for picking the cross section shape.

Alternatively, you can create a few construction lines or points in the model and use them to define the cross section shape.

If you do not have any actual points to pick, picking the center point of the cross section becomes difficult. This is because the cross section shape disappears after you have clicked the middle mouse button to close the shape.

• To create a cross section with inner contours:
  a. Pick the corner points of the cross section to define the shape.
  b. Pick the start point to close the shape.
  c. Pick the corner points of the cross section inner contour.
  d. Pick the start point to close the shape.
  e. Repeat until you have picked all inner contours.
  f. Click the middle mouse button.
g. Pick the center point of the cross section.

3. When the **User Profile Cross Section** dialog box appears, enter a name for the cross section.

4. Click **OK** to close the **User Profile Cross Section** dialog box.

5. Click **OK** in the **Save confirmation** dialog box to save the changes.

   You can now use the cross section in the profile catalog to create a new profile. The **Profile type** will be **User-defined, fixed**.

**See also**
- Create a fixed profile (page 172)
- Modify a user-defined cross section (page 171)
- Define a cross section using a plate (page 168)
- Define a cross section using a DWG file (page 170)

**Define a cross section using a plate**

You can define a cross section using a contour plate.

1. Create a contour plate that includes all the chamfers.

   Make sure the cross section does not have more than 99 corner points. Typically rounded shapes consist of many corner points. If needed, you can round the chamfers afterwards.

2. Go to **Quick Launch**, start typing `define cross section using plate`, and select the **Define Cross Section Using Plate** command from the list that appears.

   The **Profile Cross-Section from Plate (10)** dialog box appears.

3. On the **Parameters** tab, enter a name in the **Section name** and **Profile name** boxes.

   Other properties are optional.
4. Click **OK**.

5. Select the contour plate.

   Tekla Structures creates the cross section with the shape of the contour plate.

   You can now use the cross section in the profile catalog to create a new profile. The **Profile type** will be **User-defined, fixed**.

**See also**

Create a fixed profile (page 172)

Properties: Profile cross-section from plate (10) (page 169)

Define a cross section using polygon (page 166)

Define a cross section using a DWG file (page 170)

**Properties: Profile cross-section from plate (10)**

Use the **Parameters** tab to define the profile properties in the **Profile cross-section from plate (10)** component.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Section name</strong></td>
<td>Name of the cross section shown in the <strong>Modify Profile Catalog</strong> dialog box. If you leave this box empty, no profile is created.</td>
</tr>
<tr>
<td><strong>Profile name</strong></td>
<td>Name of the profile shown in the <strong>Beam Properties</strong> dialog box, and in the <strong>Modify Profile Catalog</strong> dialog box.</td>
</tr>
<tr>
<td></td>
<td>If you leave this box empty, no profile is created.</td>
</tr>
<tr>
<td><strong>Save to</strong></td>
<td>The location of the profile catalog.</td>
</tr>
<tr>
<td></td>
<td>Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Model directory</strong>: The current model folder.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Global directory</strong>: ..\ProgramData\Tekla Structures &lt;version&gt;\environments&lt;environment&gt;\profile</td>
</tr>
<tr>
<td></td>
<td>• <strong>Don’t save</strong>: Does not save the profile. This is useful for testing.</td>
</tr>
<tr>
<td><strong>Min distance between points</strong></td>
<td>The minimum distance between the corner points of the cross section.</td>
</tr>
<tr>
<td></td>
<td>To create simpler drawings of complicated cross sections, increase this value.</td>
</tr>
<tr>
<td><strong>Center point offset</strong></td>
<td>The origin of the plate defines the location of the profile reference line.</td>
</tr>
<tr>
<td></td>
<td>Enter an offset value to move the reference line, relative to the cross section.</td>
</tr>
</tbody>
</table>
Define a cross section using a DWG file

If a cross section is available in DWG format, you can import the cross section and add it as a DWG profile to the profile catalog.

Tekla Structures supports DWG files that have been created using version ACAD2012 or earlier.

Before you start defining a cross section using a DWG file:

- Save the outline of the cross section as a DWG file. Ensure that the DWG file only contains the outline of the profile.
- Make sure that the cross section is created as a closed polyline.
- Make sure that the outline consists of only one closed polyline. You cannot, for example, define holes to your cross section with this method. If you need holes or openings, use the polygon or the plate creation method.
- Remove hatching and unnecessary lines from the DWG file. Tekla Structures imports all the lines it finds in the DWG file.
- Make sure the cross section does not have more than 99 corner points. Typically rounded shapes consist of many corner points. If needed, you can round the chamfers afterwards.
- If there are blocks in the DWG file, they must be exploded.

1. Open a model.
2. Go to Quick Launch, start typing define cross section using DWG file, and select the Define Cross Section Using DWG File command from the list that appears.
   The DWG Profile to Library (6) dialog box appears.
3. Define the cross section properties and click OK.
4. In the model, pick the start and the end points of the cross section to be imported.
   Tekla Structures imports the cross section and places the profile reference line at the origin of the DWG file.
   You can now use the cross section in the profile catalog to create a new profile. The Profile type will be User-defined, fixed.

See also
Create a fixed profile (page 172)
Properties: DWG Profile to Library (6) (page 171)
Define a cross section using polygon (page 166)
Define a cross section using a plate (page 168)

Properties: DWG Profile to Library (6)
Use the Parameters tab to define the profile properties in the DWG profile to library (6) component.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input file</td>
<td>Browse for the DWG file to be imported.</td>
</tr>
<tr>
<td>Section name</td>
<td>Name of the cross section shown in the Modify Profile Catalog dialog box.</td>
</tr>
<tr>
<td>Profile name</td>
<td>Name of the profile shown in the Modify Profile Catalog dialog box.</td>
</tr>
<tr>
<td>Save to</td>
<td>The location of the profile catalog.</td>
</tr>
<tr>
<td></td>
<td>Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• Model directory: The current model folder.</td>
</tr>
<tr>
<td></td>
<td>• Global directory: ..\ProgramData\Tekla Structures &lt;version&gt;\environments&lt;environment&gt;\profile</td>
</tr>
<tr>
<td></td>
<td>• Don’t save: Does not save the profile. This is useful for testing.</td>
</tr>
<tr>
<td>Min distance</td>
<td>The minimum distance between the corner points of the cross section.</td>
</tr>
<tr>
<td>between points</td>
<td>To create simpler drawings of complicated cross sections, increase this value.</td>
</tr>
<tr>
<td>Center point</td>
<td>The origin of the plate defines the location of the profile reference line.</td>
</tr>
<tr>
<td>offset</td>
<td>Enter an offset value to move the reference line, relative to the cross section.</td>
</tr>
</tbody>
</table>

See also
Define a cross section using a DWG file (page 170)

Modify a user-defined cross section
You can modify cross sections that have been defined using a polygon, a plate, or a DWG file.

1. Go to Quick Launch, start typing edit polygon cross section, and select the Edit Polygon Cross Section command from the list that appears.
   The Modify Cross Section dialog box appears.
2. Select the cross section you want to modify.
3. Modify the cross section point properties.
• **Number** refers to each point picked when the cross section was created, in numerical order. The first point picked is 1, the second 2, and so on.

• **Chamfer** refers to the chamfer shape.

• **x:** and **y:** apply to the chamfer type. For example, if you want the chamfer to be equal on both sides of the angle, only enter a value for **x:**.

  For an uneven chamfer, enter values for **x:** and **y:**.

4. Click **Update**.

5. Click **OK** to close the **Modify Cross Section** dialog box.

6. Click **OK** in the **Save confirmation** dialog box to save the changes.

**TIP** If you want to delete a cross section, select the cross section and click **Delete**.

**See also**

- Define a cross section using polygon (page 166)
- Define a cross section using a plate (page 168)
- Define a cross section using a DWG file (page 170)

**Create fixed profiles**

You can create new fixed profiles either from scratch or by copying an existing one. You can also convert a parametric profile into a fixed one.

Click the links below to find out more:

- Create a fixed profile (page 172)
- Create a fixed profile by copying (page 174)
- Create a fixed profile based on a parametric profile (page 175)
- Modify a fixed profile (page 175)

**Create a fixed profile**

You can create fixed profiles with a single cross section or with multiple cross sections. Note that cross sections affect the total weight of the profile.

**WARNING** If you create a profile with multiple cross sections, create the cross sections with the same number of corner points and in the same order.
1. On the File menu, click Catalogs --> Profile catalog to open the Modify Profile Catalog dialog box.

2. Right-click anywhere in the profile tree and select Add Profile.
   A new fixed profile with the name PROFILE1 is created.

3. Change the profile name by entering a new name in the Profile name box.
   The profile name must be in upper case letters, with no spaces. Tekla Structures automatically converts lower case letters to upper case letters.

4. In the Profile type list, select User-defined, fixed.

5. In the Profile subtype list, select the cross section you want to use.
   If you have created your own user-defined cross sections, you can use one of them.

6. Under Equivalent type, select a profile type that matches the new cross section as closely as possible. This is important because some connections only work for certain types of profiles.
   The equivalent type and the profile dimensions, such as height and width, affect which connections can be applied to the profile. An unsuitable equivalent type or missing dimension values may result in problems with connections.

7. Click Update.

8. Modify the dimension values.
   Always enter values for the dimensions Height h and Width b, as these values affect how Tekla Structures displays the profiles. If the values are 0, the part is drawn as a line.

9. Under Cross section, define a relative location for each cross section:
   a. In the Number list, select the number of the cross section.
   b. In the Relative location box, enter the location of the cross section.
      This value indicates the location of the cross section along the axis: 0.0 for the start end and 1.0 for the second end. If you only have a single cross section, select 1 for Number and enter 0.000 for Relative location.
   c. Click Update after defining each cross section.

10. Click Add to add more cross sections, if needed.

11. If you want to use a different cross section in the profile, select a new one from the Profile subtype list.

12. If you want to remove a cross section, select the cross section from the Number list and click Remove.

13. Click OK to close the Modify Profile Catalog dialog box.
14. Click **OK** in the **Save confirmation** dialog box to save the changes.

**Example**

For a pitched profile, you need two cross sections with the same center point height. The **Relative location** value is **0.0** for the first cross section, **0.5** for the second cross section, and **1.0** for the third cross section.

![Diagram of a pitched profile with cross sections labeled csn = 1, csx = 0.0, cstype = CS1, csn = 2, csx = 0.5, cstype = CS2, csn = 3, csx = 1.0, cstype = CS1.]

**See also**

- Create a fixed profile by copying (page 174)
- Modify a fixed profile (page 175)
- Delete a profile from the profile catalog (page 157)
- Create user-defined cross sections (page 166)

**Create a fixed profile by copying**

You can create new fixed profiles by modifying a copy of an existing, similar profile.

1. On the **File** menu, click **Catalogs --> Profile catalog** to open the **Modify Profile Catalog** dialog box.
2. Select a fixed profile that is similar to the one you wish to create.
3. Right-click and select **Copy Profile**.
   
   A new profile with the name `<existing_profile_name COPY>` is created.
4. Change the profile name by entering a new name in the **Profile name** box.
   
   The profile name must be in upper case letters, with no spaces. Tekla Structures automatically converts lower case letters to upper case letters.
5. Modify the profile properties on the **General**, **Analysis**, and **User attributes** tabs.

**WARNING** Under **Equivalent type**, select a profile type that matches the new cross section as closely as possible. This is important because some connections only work for certain types of profiles.

Always enter values for the dimensions **Height h** and **Width b**, as these values affect how Tekla Structures displays the profiles. If the values are 0, the part is drawn as a line.

The equivalent type and the profile dimensions, such as height and width, affect which connections can be applied to the profile. An unsuitable equivalent type or missing dimension values may result in problems with connections.

6. Click **Update**.
7. Click **OK** to close the **Modify Profile Catalog** dialog box.
8. Click **OK** in the **Save confirmation** dialog box to save the changes.

**See also**
- Create a fixed profile (page 172)
- Modify a fixed profile (page 175)

**Create a fixed profile based on a parametric profile**

1. On the **File** menu, click **Catalogs --> Profile catalog** to open the **Modify Profile Catalog** dialog box.
2. Select a parametric profile from the list.
3. Right-click and select **Add Profile**.
   
   A new standard fixed profile is created, and it has the profile values of the parametric profile.

**See also**
- Create fixed profiles (page 172)

**Modify a fixed profile**

If necessary, you can modify existing fixed profiles using the profile catalog. Note that the fixed profiles conform to industry standards, and you should not modify them unless you are an administrator.

1. On the **File** menu, click **Catalogs --> Profile catalog** to open the **Modify Profile Catalog** dialog box.
2. Select a fixed profile in the tree and modify its properties.
   - The **General** tab contains information on profile types and dimensions.
   - The **Analysis** tab contains information on the properties used in structural analysis. The structure can be analyzed with different analysis software.
   - The **User attributes** tab is for viewing or entering user attributes for profiles.
3. When you have finished modifying the profile, click **Update**.
4. Click **OK** to close the **Modify Profile Catalog** dialog box.
   Tekla Structures asks if you want to save the changes to the model folder.
5. Click **OK** in the **Save confirmation** dialog box to save the changes.

**See also**
- Create a fixed profile (page 172)
- Create a fixed profile by copying (page 174)

**Create parametric profiles using .clb files**
This section explains how to create new parametric profiles using .clb files. The workflow consists of three tasks:
1. Define the shape and point coordinates of the profile (page 177)
2. Create the .clb file (page 180)
3. Add profile definitions to the profitab.inp file (page 182)

**See also**
- How the .clb, components.clb and profitab.inp files work together (page 176)
- Create an image of a profile (page 217)

**How the .clb, components.clb and profitab.inp files work together**
When you create new parametric profiles using this method, you need the following three files:
- .clb
  This file contains cross section definitions. Create a new .clb file in the ..\ProgramData\Tekla Structures\<version>\environments\common\inp folder for each parametric profile you define.
• **components.clb**
  This file contains a list of all .clb files that contain cross section definitions. When you create a new .clb file, you need to add its file name to the components.clb file located in the ..\ProgramData\Tekla Structures<version>\environments\common\inp folder.

• **profitab.inp**
  This file is the link between the .clb files and the profile catalog. This file contains a list of all parametric profiles available in Tekla Structures. The file controls how the parametric profiles are displayed in the Modify Profile Catalog dialog box. When you want to take a new parametric profile into use, you must add the needed profile definitions, such as the profile type, prefix and the unit of measurement, to the profitab.inp file located in the ..\ProgramData\Tekla Structures<version>\environments<environment>\prof folder. Tekla Structures searches for the profitab.inp file in the standard search order and then from the folder indicated by the advanced option XS_PROFDB.

---

**Define the shape and point coordinates of the profile**

Start by defining the shape and point coordinates of the new profile. This task is phase 1 in the workflow Create parametric profiles using .clb files (page 176).

1. Design the profile on a paper.
   a. Draw the cross section outline.
   b. Add the needed corner points.
   c. Add the needed dimensions.
   d. Place the y-z coordinate axis center point to the middle of the cross section.
2. Define the y and z coordinate directions. For example:
   - positive y axis: up
   - negative y axis: down
   - positive z axis: on the right
   - negative z axis: on the left
3. Define the y and z vectors. For example:
   • y1, y2, y3
   • z1, z2, z3

4. Make coordinate pairs to the points. Assign y, z vector pairs to each point. Start from the lower right corner and define the points in the counter clockwise order. For example:
   • point 1: y1 z3
   • point 2: y2 z3
   • point 3: y3 z2
   • point 4: y3 z1
   • point 5: y1 z1
Create the .clb file

After defining the shape and point coordinates of the profile, you can continue by creating the actual .clb file. This task is phase 2 in the workflow Create parametric profiles using .clb files (page 176).

1. Create a new .clb file using any standard text editor, for example Microsoft Notepad.

2. Define a library name that will be used in the profitab.inp file for this profile.
   For example:
   ```
   library_id "1Gen"
   ```

3. Define a cross section name that will be used in the profitab.inp file for this profile.
   For example:
   ```
   Section_type
   [1
   name "RectChamfer"
   ```

4. Define the dimensions of the cross section.
For example:

```plaintext
base_attribute
{
  name "h"
  description "albl_Height"
  type dimension
  default 1000
}
```

5. Define the coordinates of the profile.

   The coordinates must be the same as the y and z vectors that you defined earlier. Define the default values. For example:

   ```plaintext
   expression
   {
     name "y1"
     type y
     default -400
     formula -h/2
   }
   ```

6. Define the geometry of one or several faces of the profile.

   For example:

   ```plaintext
   geometry
   {
     name "default"
     face
     {
       index 0
       point 0 y1 z3
       point 0 y2 z4
       point 0 y3 z4
       point 0 y4 z3
       point 0 y5 z2
       point 0 y3 z1
       point 0 y2 z1
       point 0 y1 z1
     }
     face
     {
       index 1
       point 1 y5 z7
       point 1 y6 z8
       point 1 y7 z5
       point 1 y8 z7
       point 1 y9 z6
       point 1 y7 z5
       point 1 y6 z5
       point 1 y5 z6
     }
   }
   ```

Profiles  181  Create your own profiles
7. Save the .clb file in the ..\ProgramData\Tekla Structures \<version>\environments\common\inp folder.

8. Open the components.clb file.

9. Add your profile definition to the components.clb file by adding the following line:

   Include "new_file_name.clb" // give comment

10. Save the components.clb file.

---

**Add profile definitions to the profitab.inp file**

Before taking the new parametric profile into use, you must add the needed profile definitions to the profitab.inp file. This task is phase 3 in the workflow Create parametric profiles using .clb files (page 176).

1. Go to the ..\ProgramData\Tekla Structures\<version>\environments\<environment>\profit folder.

2. Copy the profitab.inp file to a model, project or firm folder.

3. Open the file in the new location using a standard text editor, such as Microsoft Notepad.

4. Under a suitable category, add a new line for the profile definition.

   Use the following syntax:

   Prefix
   ! Type ! SO ! Z ! MI ! MA ! G3-NAME ! Z3-NAME !

5. Save the file.

   The profile is now available in the profile catalog. You may have to restart Tekla Structures for the change to take effect.

**Example**

An example of a profile definition:

```
PNL_A
! USER ! 0 ! ! 2 ! 3 !1Gen.RectChamfer !h*b-[c]
```

**See also**

- Properties used in profitab.inp (page 183)
- Create an image of a profile (page 217)
- Import and export profiles (page 158)
**Properties used in profitab.inp**

Use the following properties when you define new parametric profiles using the profitab.inp file:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prefix</td>
<td>Prefix of the parametric profile. The prefix is shown in the profile catalog. For example, PNL-A.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the parametric profile. For example, USER for user-defined parametric profiles.</td>
</tr>
<tr>
<td>SO</td>
<td>Sorting order. The options are: • -1: Decreasing sorting order • +1: Increasing sorting order • 0: No sorting order • -2: Name increasing, value decreasing • +2: Value increasing, name decreasing For example, if your profile is PLT200<em>10 or PLT10</em>200 and the sorting order is +2, the result in the output (such as a report) for both cases is PLT200<em>10. If the sorting order is -2, the result for both cases is PLT10</em>200.</td>
</tr>
<tr>
<td>Z</td>
<td>Unit of measurement. The options are: • 0: millimeters • 1: inches • 2: feet • 3: centimeters • 4: meters</td>
</tr>
<tr>
<td>MI</td>
<td>Minimum number of parameters you can use with the parametric profile. For example, the rectangular hollow section SHS has the following Profile subtypes: h<em>t, h</em>b<em>t, h1</em>b1-h2<em>b2</em>t. If you define SHS with a minimum of two and a maximum of two parameters, you will only have the option h*t available in the Select Profile dialog box.</td>
</tr>
<tr>
<td>MA</td>
<td>Maximum number of parameters you can use with the parametric profile.</td>
</tr>
<tr>
<td>G3-NAME</td>
<td>Refers to a cross section file (.clb file). Can be a combination of a library id and the name of a cross section, separated by a full stop. For example, 1Gen.RectChamfer.</td>
</tr>
</tbody>
</table>
Create parametric profiles by sketching
This section explains how to create parametric user-defined profiles by sketching. You can change the dimensions of parametric profiles each time you use them in a model.

Click the links below to find out more:

Open the sketch editor (page 184)
Sketch the outline of a profile (page 187)
Refine the shape of a sketched profile (page 189)
Add dimensions to a sketched profile (page 193)
Define positioning planes for a sketched profile (page 197)
Check a sketched profile (page 202)
Save a sketched profile (page 203)
Modify a sketched cross section (page 203)
Use sketched profiles in a model (page 206)
Example: Create a symmetric C-shaped profile (page 207)

Open the sketch editor
Use the sketch editor to create and modify sketched profiles.

1. Open a Tekla Structures model.
2. On the File menu, click Editors --> Define cross section in sketch editor.

Tekla Structures opens the sketch editor, the Sketch Browser, and the Variables dialog box.

When you first open the sketch editor, the view is empty. The grid coordinates and labels that you see in the sketch editor depend on the grid properties of your actual Tekla Structures model.
Sketch Browser

The Sketch Browser shows the objects (lines, arcs, circles, constraints, dimensions, and chamfers) of a sketched profile in a hierarchical, tree-like structure. The Sketch Browser automatically opens when you open the sketch editor.

See also

Sketch Browser (page 185)

Variables in sketched profiles (page 186)
When you click an object in the sketch editor, Tekla Structures highlights the object in the **Sketch Browser**, and vice versa.

The **Sketch Browser** displays the following information about a sketched profile:

- Extrusion type (0, 1, or 2) and thickness of the sketched profile
- Lines, arcs, and circles
- Constraints
- Distances and dimensions and their values
- Chamfers and their type (0=**None**, 1=**Line** ... 7=**Line and arc**) and dimensions.

**See also**

- [Open the sketch editor](#) (page 184)
- [Extrusion types](#) (page 206)

**Variables in sketched profiles**

Use the **Variables** dialog box to define the properties of a sketched profile. Variables can define fixed properties, or they can include formulas, so that Tekla Structures calculates the property value each time you use the profile in a model.
The **Variables** dialog box automatically opens when you open the sketch editor.

![Variables dialog box]

**NOTE** The **Variables** dialog box functions the same way as the corresponding dialog box in the custom component editor. For more information on how to use variables, see Add variables to a custom component.

**See also**

Open the sketch editor (page 184)

**Sketch the outline of a profile**

When you create a new sketched profile, start by sketching the outline and the holes of the profile using lines, arcs, and circles.

Ensure that you create a closed shape, unless you are creating a profile of a consistent thickness, such as a cold-rolled profile.

The maximum number of points in a sketched profile is 100.

**See also**

Sketch a polyline (page 187)
Sketch an arc (page 188)
Sketch a circle (page 188)

**Sketch a polyline**

You can create line segments in the sketch editor by picking points. Tekla Structures automatically creates coincident constraints between the line segments and displays a chamfer symbol where line segments meet.
1. Open the sketch editor.

2. Click the **Sketch polyline** button: [Image]

3. Pick points to create each line segment.

4. Click the middle mouse button to create the polyline.

![Image of a sketch with points labeled 1 to 7]

**See also**

*Sketch the outline of a profile (page 187)*

**Sketch an arc**

You can create an arc in the sketch editor by picking three points.

1. Open the sketch editor.

2. Click the **Sketch arc** button: [Image]

3. Pick three points to define the arc.

![Image of a sketch with points labeled 1, 2, and 3, and an arc]

**TIP** You can use the advanced option XS_CS_CHAMFER_DIVIDE_ANGLE to define the smoothness of the arc.

**See also**

*Sketch the outline of a profile (page 187)*

Profiles 188 Create your own profiles
Sketch a circle
You can create a circle in the sketch editor by picking two points.

1. Open the sketch editor.

2. Click the **Sketch circle** button: 📊.

3. Pick a point to indicate the center of the circle (1).

4. Pick a point to indicate the radius of the circle (2).

---

See also
* Sketch the outline of a profile (page 187)

Refine the shape of a sketched profile
After you have sketched the outline of a profile, use *constraints* to refine your sketch and lock the shape. For example, you can straighten lines, create 90 degree angles, force lines to meet, close the shape, and add chamfers in corners.

To straighten the entire profile, use horizontal and vertical constraints in conjunction with other constraints. Although the shape is locked, you can still rotate the profile in the model.

See also
* Add a parallel constraint (page 189)
* Add a perpendicular constraint (page 190)
* Add a coincident constraint (page 190)
* Add a fixed constraint (page 191)
* Add a horizontal constraint (page 192)
* Add a vertical constraint (page 192)
* Delete a constraint (page 193)
**Add a parallel constraint**
You can force two lines in a sketched profile to be parallel to each other. Before you start, sketch the outline of the profile in the sketch editor.

1. Click the **Parallel constraint** button: ![Parallel constraint](image)
2. Select a line in the sketch (1).
3. Select another line in the sketch (2).

See also
Refine the shape of a sketched profile (page 189)

**Add a perpendicular constraint**
You can force a line in a sketched profile to be at a 90 degree angle to another line you select. The lines do not have to intersect. Before you start, sketch the outline of the profile in the sketch editor.

1. Click the **Perpendicular constraint** button: ![Perpendicular constraint](image)
2. Select a line in the sketch (1).
3. Select another line in the sketch (2).

See also
Refine the shape of a sketched profile (page 189)
**Add a coincident constraint**

You can force two lines in a sketched profile to start or end at the same point, by extending or shortening one or both lines. The lines do not have to intersect.

**NOTE** Tekla Structures automatically creates coincident constraints:

- Where two lines meet.
- Between line segments when you draw them with the Sketch polyline tool.
- Between the start of the first line segment and the end of the last line segment in a shape, if they are within a certain distance of each other.

Before you start, sketch the outline of the profile in the sketch editor.

1. Ensure that the **Snap to end points** snap switch is active.

2. Click the **Coincident constraint** button: 📈.

3. Pick the end of the first line (1).

4. Pick the end of the second line. (2)

![Diagram showing coincident constraint](image)

**See also**

*Refine the shape of a sketched profile (page 189)*

**Add a fixed constraint**

You can lock the position and angle of a line in a sketched profile so that other constraints do not affect it.

Before you start, sketch the outline of the profile in the sketch editor.

1. Click the **Fixed constraint** button: 📈.

2. Select a line in the sketch.
See also
Refine the shape of a sketched profile (page 189)

**Add a horizontal constraint**
Use horizontal constraints to force a line in a sketched profile to be parallel to the local x axis. Tekla Structures automatically creates horizontal constraints when you create lines that are nearly horizontal.

Before you start, sketch the outline of the profile in the sketch editor.

1. Click the **Horizontal constraint** button:
2. Select the lines you want to straighten (1, 2).

See also
Refine the shape of a sketched profile (page 189)

**Add a vertical constraint**
Use vertical constraints to force a line in a sketched profile to be parallel to the local y axis. Tekla Structures automatically creates vertical constraints when you create lines that are nearly vertical.

Before you start, sketch the outline of the profile in the sketch editor.

1. Click the **Vertical constraint** button:
2. Select the lines you want to straighten (1, 2).
See also
Refine the shape of a sketched profile (page 189)

Delete a constraint
You can delete constraints from sketched profiles.

1. Click \(\text{\textcolor{blue}{\text{ stranger#}}\text{\textcolor{black}{\text{ icon}}}}\) to open the Sketch Browser.
2. Select the constraint you want to delete.
3. Right-click and select Delete.
4. Click Refresh.

See also
Refine the shape of a sketched profile (page 189)

Add dimensions to a sketched profile
After you have sketched a profile, use dimensions to make different distances in the profile parametric. You can use these dimensions to define the size of the profile when you use it in a model.

Tekla Structures also adds the dimensions you create to the list of variables that you can use in calculations.

**NOTE** Do not create too many dimensions in a sketch, or the dimensions will not be able to adjust when the values are changed.

In the following example, if you create the dimension marked in red, the dimension b1 will no longer work:
See also
Add a radial dimension to a sketch (page 194)
Add an angle dimension to a sketch (page 195)
Add a dimension between two points in a sketch (page 195)
Add a horizontal dimension to a sketch (page 196)
Add a vertical dimension to a sketch (page 196)
Delete a dimension from a sketch (page 197)

Add a radial dimension to a sketch
You can create a radial dimension for an arc or a circle in a sketched profile. Before you start, sketch the outline of the profile in the sketch editor.

1. Click the Sketch radial dimension button:
2. Select the arc or circle.

See also
Add dimensions to a sketched profile (page 193)
Add an angle dimension to a sketch
You can create an angle dimension between two lines in a sketched profile. The angle is calculated counter clockwise from the first line you select.
Before you start, sketch the outline of the profile in the sketch editor.

1. Click the Sketch angle dimension button:
2. Select the first line (1).
3. Select the second line (2).

TIP If you are unable to see the angle symbol, scroll with the mouse wheel to zoom in.

See also
Add dimensions to a sketched profile (page 193)

Add a dimension between two points in a sketch
You can add a dimension to a sketched profile, between two points you pick.
Before you start, sketch the outline of the profile in the sketch editor.

1. Click the Sketch free dimension button:
2. Pick a point to indicate the start point of the dimension (1).
3. Pick a point to indicate the end point of the dimension (2).
4. Pick a point to indicate the location of the dimension lines and text.
Add a horizontal dimension to a sketch
You can add a horizontal dimension to a sketched profile, between two points you pick.
Before you start, sketch the outline of the profile in the sketch editor.

1. Click the **Sketch horizontal dimension** button:  
2. Pick a point to indicate the start point of the dimension (1).
3. Pick a point to indicate the end point of the dimension (2).
4. Pick a point to indicate the location of the dimension lines and text.
Add a vertical dimension to a sketch
You can add a vertical dimension to a sketched profile, between two points you pick.
Before you start, sketch the outline of the profile in the sketch editor.

1. Click the Sketch vertical dimension button:
2. Pick a point to indicate the start point of the dimension (1).
3. Pick a point to indicate the end point of the dimension (2).
4. Pick a point to indicate the location of the dimension lines and text.

See also
Add dimensions to a sketched profile (page 193)

Delete a dimension from a sketch
When you want to delete a dimension from a sketch, you can do it in the sketch editor view, in the Variables dialog box, or in the Sketch browser.

1. Select the dimension you want to delete.
2. Do one of the following:
   - In the sketch editor view or in the Sketch browser, right-click and select Delete.
   - In the Variables dialog box, click the Delete button.

See also
Add dimensions to a sketched profile (page 193)

Define positioning planes for a sketched profile
When you sketch a profile, you can define positioning planes for it. With positioning planes you can determine the planes Tekla Structures will use for positioning parts and components.
Part positioning planes

With part positioning planes you can determine how Tekla Structures positions parts that have a sketched profile. These planes are used for the **On plane** and **At depth** settings for parts, and also when placing custom components that are bound to boundary planes.

The part positioning planes are displayed in blue:

The **On plane** options **Left** and **Right** are set according to the vertical blue planes, and the **Middle** option is halfway between them.

The same principle applies to the **At depth** setting: the **Front** and **Behind** options are set according to the horizontal blue planes, and the **Middle** option is halfway between them.

<table>
<thead>
<tr>
<th>Position</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>On plane</td>
<td>Middle</td>
</tr>
<tr>
<td>Rotation</td>
<td>Top</td>
</tr>
<tr>
<td>At depth</td>
<td>Middle</td>
</tr>
</tbody>
</table>

**Example**

You can define part positioning planes so that an asymmetric profile will be positioned according to its web only. In the following example, the **Middle** option is illustrated in gray dotted lines:
See also
Define positioning planes for a sketched profile (page 197)

Connection positioning planes
With connection positioning planes you can determine how Tekla Structures positions components in relation to the component main part that has a sketched profile.

The connection positioning planes are displayed in green:

Example
The following image shows the default connection positioning planes of a double tee slab that was created as a sketched profile. The green line illustrates the default connection positioning planes.
To place connections according to the location of the stems of the double tee, move the connection positioning planes as shown below.

See also
Define positioning planes for a sketched profile (page 197)

**Show and hide positioning planes**

To show or hide the positioning planes, do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show or hide <strong>part</strong> positioning planes</td>
<td>Click [ hiding ]</td>
</tr>
<tr>
<td>Show or hide <strong>connection</strong> positioning planes</td>
<td>Click [ hiding ]</td>
</tr>
</tbody>
</table>

See also
Define positioning planes for a sketched profile (page 197)

**Move positioning planes**

You can move the positioning planes by moving their handles. Note that if you move the handles away from the outmost corners of the sketched profile, you must bind them by adding a dimension to each handle. Otherwise the positioning will not function correctly in the model.

1. Click the positioning plane to display the handles.
The handles are displayed in pink. By default, the handles are at the outmost corners of the sketched profile. For example:

2. Click a handle to select it.

   **NOTE** The same handle controls both the vertical and horizontal plane, so you can move them both at the same time.

3. Move the handle like any other object in Tekla Structures.
   For example, right-click and select **Move**.

4. If the handle is not at the outmost corner of the profile, add a dimension between the handle and the corner.

**Example**

In the following examples, the left handle of the positioning plane has been bound by using a horizontal dimension (b1):
Revert to default positioning planes
You can revert back to the default positioning planes of a sketched profile if you have moved the planes.

To revert to the default positioning planes, do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revert to the default <strong>part</strong> positioning planes</td>
<td>1. Click to show the part positioning planes.</td>
</tr>
<tr>
<td></td>
<td>2. Select the part positioning planes.</td>
</tr>
<tr>
<td></td>
<td>3. Right-click and select <strong>Delete</strong>.</td>
</tr>
<tr>
<td></td>
<td>4. Click again to check that the planes have reverted back to the default.</td>
</tr>
<tr>
<td>Revert to the default <strong>connection</strong> positioning planes</td>
<td>1. Click to show the connection positioning planes.</td>
</tr>
<tr>
<td></td>
<td>2. Select the connection positioning planes.</td>
</tr>
<tr>
<td></td>
<td>3. Right-click and select <strong>Delete</strong>.</td>
</tr>
<tr>
<td></td>
<td>4. Click again to check that the planes have reverted back to the default.</td>
</tr>
</tbody>
</table>

See also
Define positioning planes for a sketched profile (page 197)

Check a sketched profile
You can check that the constraints and dimensions in a sketched profile work correctly.

1. Double-click a dimension line to open the **Distance Properties** dialog box.
2. Change the **Value** box.
3. Click **Modify**.
   Tekla Structures updates the profile in the sketch editor.
4. Check that the shape of the profile does not change and that the dimensions adjust correctly.
5. Click **Cancel** to close the **Distance Properties** dialog box.

**See also**

*Use sketched profiles in a model (page 206)*

**Save a sketched profile**

Tekla Structures saves the sketched profiles in the current model folder, in the `xslib.db1` file, which is a library file containing custom components and sketches. Sketched profiles are available in the **Others** section in the profile catalog.

**NOTE** Note the following limitations when naming sketched profiles:

- You cannot use the name of a fixed profile.
- You cannot include numbers, special characters, or blank spaces in the profile name.
- Lower case letters are automatically converted into upper case letters.

To save a sketched profile, do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Save a new profile                      | 1. Click **Save sketch**.  
|                                         | 2. Enter a name in the **Prefix** box, and then click **OK**. |
| Update an existing profile              | 1. Click **Save sketch**.  
|                                         | 2. Click **Yes** when prompted to update the existing cross section. |
| Save a copy of the profile under a different name | 1. Click **Save sketch as**.  
|                                         | 2. Enter a new name in the **Prefix** box, and then click **OK**. |

**See also**

*Import and export sketched profiles (page 164)*
Modify a sketched cross section
You can modify existing sketched profiles, for example, by modifying chamfers or dimensions. You can also move corners or holes by moving the handles. The chamfers are moved automatically when you move the handles.

**NOTE**
• You cannot change dimensions that have been calculated using formulas in the **Variables** dialog box.
• Constraints may also prevent you from changing dimensions.

1. On the **File** menu, click **Catalogs --> Profile catalog** to open the **Modify Profile Catalog** dialog box.
2. Open the **Others** branch at the end of the profile tree.
3. Right-click a sketched profile, and then select **Edit profile** to open the profile in the sketch editor.
4. Double-click a sketch object to modify its properties.
   The sketch objects you can modify appear in yellow.
5. Modify the properties and then click **Modify**.
6. Close the sketch object properties dialog box.
7. Click the **Save sketch as** icon to save the changes.

See also
Modify chamfers in a sketch (page 204)
Set the sketch thickness (page 204)

Modify chamfers in a sketch
You can change the shape and dimensions of chamfers in a sketched profile. For example, you can create rounded profile corners.

1. Double-click a chamfer symbol in the sketch editor.
2. In the **Chamfer Properties** dialog box, change the shape and dimensions of the chamfer.
3. Click **Modify**.
4. Click **OK** to close the dialog box.
5. Click the **Save sketch as** icon to save the changes.

See also
Modify a sketched cross section (page 203)
Set the sketch thickness
If you have sketched an open shape, such as a cold-rolled section, you must define the extrusion type and thickness of the sketch in the Sketch Browser. The thickness can be either fixed or parametric.

1. In the sketch editor, sketch an open polyline.
2. Do one of the following:
   - To set a fixed thickness:
     a. In the Sketch Browser, right-click Thickness and select Add Equation.
     b. Enter the value of the thickness after =.
   - To define a parametric thickness:
     a. In the Variables dialog box, add a new parameter variable for Length (for example, P1).
     b. In the Formula column, define the default value for the parameter variable.
     c. In the Sketch Browser, right-click Thickness and select Add Equation.
     d. Enter the name of the parameter variable (for example, P1) after =.
3. To define the extrusion type:
   a. In the Sketch Browser, right-click Extrusion Type and select Add Equation.
   b. Enter the extrusion type number (0, 1, or 2) after =.
4. Click the Save sketch as icon to save the changes.

See also
Modify a sketched cross section (page 203)
Extrusion types (page 206)
**Extrusion types**
The extrusion type defines how a sketched profile of a consistent thickness is extruded. When you change the thickness, the profile grows inwards, outwards, or symmetrically in both directions, depending on the extrusion type. You must define the extrusion type for sketches that consist of an open polyline.

The extrusion types are:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The sketch is extruded symmetrically to the outside and inside of the polyline. (Default)</td>
<td><img src="image1.png" alt="Image" /></td>
</tr>
<tr>
<td>1</td>
<td>The sketch is extruded to the outside of the polyline.</td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td>2</td>
<td>The sketch is extruded to the inside of the polyline.</td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
</tbody>
</table>

**See also**
*Set the sketch thickness (page 204)*

*Use sketched profiles in a model*
Once you have created a sketched profile and saved it, you are ready to use it in the model. If you have applied constraints correctly, the shape of the profile will be maintained when you change its dimensions.

To use a sketched profile for a new part in a model:
1. Open the part properties dialog box.
   For example, to open the beam properties dialog box, on the Steel tab, hold down **Shift** and click ![Beam Icon](beam.png).
2. Click Select next to the Profile box. The Select Profile dialog box appears.
3. Open the Others branch at the end of the profile tree.
4. Select a sketched profile.
5. If the profile is parametric, you can define its dimensions in the Value column on the General tab.
6. Click OK to close the Select Profile dialog box.
7. Click Apply to use the selected profile in the model.
8. Pick points to place the part in the model.

See also
Create an image of a profile (page 217)

Example: Create a symmetric C-shaped profile
This example shows how to create a sketched profile using variables. The workflow consists of five tasks:
1. Example: Sketch a C-shaped profile (page 208)
2. Example: Add dimensions to the sketched profile (page 209)
3. Example: Set the sketch thickness (page 210)
4. Example: Modify the chamfers of the sketched profile (page 211)
5. Example: Use the sketched profile in a model (page 212)

After completing the tasks, you will have a symmetric C-shaped profile with the dimensions \( b_1 = b_2 \) and \( h_2 = h_3 \). When you use the profile in the model, you can change the following dimensions:
- Width (\( b_1 \))
- Total height (\( h_1 \))
- Height (\( h_2 \))
- Thickness (\( P_1 \))
- Chamfers (\( P_2 \))
See also

Create parametric profiles by sketching (page 184)

Example: Sketch a C-shaped profile

Start by sketching the outline of the profile. This task is phase 1 in the workflow Example: Create a symmetric C-shaped profile (page 207).

To sketch the outline of a C-shaped profile:

1. Open the sketch editor.
2. Use the Sketch polyline command to create a rough C-shaped profile.
   At this stage, the profile does not have to be symmetric or have the right dimensions.
3. Straighten the lines using the Add horizontal constraint and Add vertical constraint commands.
4. Save the profile and name it CSHAPE.

Example: Add dimensions to the sketched profile

After sketching the outline of the profile, you can continue by adding dimensions. This task is phase 2 in the workflow Example: Create a symmetric C-shaped profile (page 207).

To add dimensions to the sketched profile:

1. Use the Sketch horizontal dimension command to create the distances b1 and b2.

2. Use the Sketch vertical dimension command to create the distances h1, h2, and h3.
3. In the **Variables** dialog box, enter the following values for the distances:

<table>
<thead>
<tr>
<th>Name</th>
<th>Formula</th>
<th>Value</th>
<th>Value type</th>
<th>Variable type</th>
<th>Visibility</th>
<th>Label in dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>b1</td>
<td>150.00</td>
<td>150.00</td>
<td>Length</td>
<td>Distance</td>
<td>Show</td>
<td>Width</td>
</tr>
<tr>
<td>b2</td>
<td>=b1</td>
<td>150.00</td>
<td>Length</td>
<td>Distance</td>
<td>Hide</td>
<td>Width</td>
</tr>
<tr>
<td>h1</td>
<td>300.00</td>
<td>300.00</td>
<td>Length</td>
<td>Distance</td>
<td>Show</td>
<td>Height</td>
</tr>
<tr>
<td>h2</td>
<td>70.00</td>
<td>70.00</td>
<td>Length</td>
<td>Distance</td>
<td>Show</td>
<td>Height</td>
</tr>
<tr>
<td>h3</td>
<td>=h2</td>
<td>70.00</td>
<td>Length</td>
<td>Distance</td>
<td>Hide</td>
<td>Height</td>
</tr>
</tbody>
</table>

4. Ensure that **Visibility** is set to **Show** for the distances b1, h1, and h2.

5. Save the sketched profile.

**Example: Set the sketch thickness**

After adding dimensions to the sketched profile, you can continue by defining the thickness of the sketch. This task is phase 3 in the workflow **Example: Create a symmetric C-shaped profile (page 207).**

To set the thickness of the sketch:

1. In the **Variables** dialog box, do the following:
   a. Click **Add** to add a parameter variable P1.
   b. In the **Formula** box, enter 20.00.
   c. In the **Visibility** box, select **Show**.
   d. In the **Label in dialog box** box, enter **Thickness**.

2. In the **Sketch Browser**, set the thickness using the parameter variable P1.
   a. Right-click **Thickness**, select **Add equation**, and then enter =P1.
b. Right-click ExtrusionType, select Add equation, and then enter =2 to get the sketch extruded to the inside of the polyline.

3. Save the sketched profile.

**Example: Modify the chamfers of the sketched profile**

After setting the thickness of the sketch, you can continue by modifying the chamfers of the sketched profile. This task is phase 4 in the workflow Example: Create a symmetric C-shaped profile (page 207).

To modify the chamfers of the profile:

1. In the sketch editor, do the following:
   a. Double-click a chamfer symbol.
   b. In the Chamfer properties dialog box, change the chamfer type to Line, and then click Modify.
   c. Repeat steps 1a–b for all the chamfers.

2. In the Variables dialog box, do the following:
   a. Click Add to add a parameter variable P2.
   b. In the Formula box, enter 10.00.
   c. In the Visibility box, select Show.
   d. In the Label in dialog box box, enter Chamfer.

3. In the Sketch Browser, do the following:
a. Double-click **Chamfer constraint** to open the chamfer properties.
b. Right-click **Chamfer X**, select **Add equation**, and then enter \( =P2 \).
c. Enter the same value for **Chamfer Y**.
d. Repeat steps 4a–c for all the chamfers.

4. Save the sketched profile.

**Example: Use the sketched profile in a model**

Your sketched profile is now completed and you can use it in a model. This task is phase 5 in the workflow **Example: Create a symmetric C-shaped profile** (page 207).

To use the sketched profile in a model:

1. On the ribbon, hold down **Shift** and click an appropriate part command to open the part properties dialog box.
2. Click **Select** next to the **Profile** box.
   The **Select Profile** dialog box appears.
3. Open the **Others** branch at the end of the profile tree, and select the **CSHAPE** profile.
4. If needed, modify the dimensions of the profile on the **General** tab.

<table>
<thead>
<tr>
<th>Property</th>
<th>Symbol</th>
<th>Value</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>b1</td>
<td>150.00</td>
<td>mm</td>
</tr>
<tr>
<td>Height</td>
<td>h1</td>
<td>300.00</td>
<td>mm</td>
</tr>
<tr>
<td>Height</td>
<td>h2</td>
<td>70.00</td>
<td>mm</td>
</tr>
<tr>
<td>Thickness</td>
<td>P1</td>
<td>20.00</td>
<td>mm</td>
</tr>
<tr>
<td>Chamfer</td>
<td>P2</td>
<td>10.00</td>
<td>mm</td>
</tr>
</tbody>
</table>

5. Click **OK** to apply the changes.
6. Pick points to place the part in the model.
Create parametric profiles with variable cross sections
You can create parametric user-defined profiles with variable cross sections using the Profile Editor. You can use a profile with variable cross sections like any other parametric profile.

You can:
• Use a cross section with different dimensions at different locations in a profile.
• Modify the variables of the cross sections and the profile.
• Save the profile and use it as a parametric profile through the profile catalog.
• Import and export variable cross section profiles.

NOTE When you use this method, only the dimensions of a variable cross section can vary, not the actual shape of the cross section. If you want to use several different cross section shapes in the profile, create a fixed profile with multiple cross sections instead.

See also
Create a profile with variable cross sections (page 214)
Modify a profile with variable cross sections (page 216)
Create a fixed profile (page 172)

Create a profile with variable cross sections

Before you start:

- Create a sketched profile using the sketch editor.
- In the Variables dialog box in the sketch editor, set Visibility to Show for the dimensions that you want to change when using the profile in a model.

1. Go to Quick Launch, start typing define profile with variable cross section, and select the Define Profile with Variable Cross Section command from the list that appears.

   The Define Profile with Variable Cross Section dialog box opens.

2. Select the sketch you want to use as the start and end cross section of the profile.

3. Click OK.

   The Profile Editor and the Profile preview view appear.

4. Under Cross sections of the profile, add cross sections or remove selected cross sections by clicking Add or Remove.

   When you click Add, Tekla Structures adds a new cross section at the end of the profile, at the location 1.0, and moves the existing cross sections.
towards the start of the profile. By default, cross sections are located at 0.1 intervals in the profile.

5. Under **Cross section variables**, define the following:
   - The relative location of each cross section in the profile.
     Use the *.Location variables. For example, start=0.00, middle=0.5, end=1.00.
   - How the cross sections are aligned in the horizontal and vertical direction.
     Use the *.HorPos and *.VerPos variables.
   - How much the cross sections are offset from the alignment.
     Use the *.HorOffset and *.VerOffset variables.

6. If you have added new cross sections, check that they do not overlap any existing cross sections.

7. Set **Visibility** to **Show** for the dimensions that you want to change when using the profile in a model.

8. If you want to use parameter variables and equations to define the cross section dimension, click **Add variable** and define the variable values.

9. Save the profile.
   a. Click **Save**.
   b. In the **Save profile as** dialog box, enter a unique name for the profile.

      You cannot include numbers in the profile name, or use the name of a standard profile.
   c. Click **OK**.
      Tekla Structures saves the profile in the current model folder.
See also
Create parametric profiles with variable cross sections (page 213)
Modify a profile with variable cross sections (page 216)
Create parametric profiles by sketching (page 184)

Modify a profile with variable cross sections
1. On the File menu, click Catalogs --> Profile catalog to open the Modify Profile Catalog dialog box.
2. Open the Others branch at the end of the profile tree.
3. Right-click a profile with variable cross sections, and then select Edit profile to open the profile in the Profile Editor.
4. Modify the profile properties.
5. Click Save.

See also
Create a profile with variable cross sections (page 214)

7.5 Define standardized values for parametric profiles
You can define standardized values for the dimensions of parametric profiles. The standardized values are visible in the profile catalog where you can select suitable dimension values for the profiles.

1. Go to the ..\ProgramData\Tekla Structures\<version>\environments\<environment>\system folder.
2. Open the industry_standard_profiles.inp file using any standard text editor, for example, Microsoft Notepad.
3. Modify the file.
   The file has the following format:
   • profile and profile subtype
   • parameters separated by spaces
   • units for each parameter
   • standardized values for each parameter.
   Each dimension combination has its own row.
4. Save the file.
Example

For example, the standardized combinations of dimension values for a C profile are as follows:

<table>
<thead>
<tr>
<th>C</th>
<th>h</th>
<th>b</th>
<th>t</th>
</tr>
</thead>
<tbody>
<tr>
<td>mm</td>
<td>mm</td>
<td>mm</td>
<td></td>
</tr>
<tr>
<td>75</td>
<td>35</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>75</td>
<td>35</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>75</td>
<td>35</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>40</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>40</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>40</td>
<td>9</td>
<td></td>
</tr>
</tbody>
</table>

7.6 Create an image of a profile

To illustrate the shape and dimensions of a profile you have created, you can create an image of it. Tekla Structures displays the image when you browse for profiles in the profile catalog. The image must be in Windows bitmap (.bmp) format and can be created with any bitmap editor, for example Microsoft Paint.

1. Take a screenshot of the profile you have drawn or sketched.
   For example, press the Print Screen (Prt Scr) key to take a screenshot of your entire desktop. To take a screenshot of an active window, press Alt+Print Screen. The screenshot is placed on the clipboard.
2. Open the screenshot in any bitmap editor (for example, Microsoft Paint) and modify the image if necessary.
3. Save the image in .bmp format in the ..\ProgramData\Tekla Structures\<version>\Bitmaps folder.
   The file name must match the actual profile name. For example, if the profile name is mysketch, the image must be named mysketch.bmp.
4. Restart Tekla Structures.
7.7 **Predefined parametric profiles available in Tekla Structures**

The following predefined parametric profiles are available in Tekla Structures.

- I profiles (page 219)
- I beams (steel) (page 219)
- L profiles (page 220)
- Z profiles (page 221)
- U profiles (page 221)
- C profiles (page 222)
- T profiles (page 223)
- Welded box profiles (page 223)
- Box profiles (page 225)
- WQ profiles (page 226)
- Rectangular sections (page 226)
- Circular sections (page 227)
- Rectangular hollow sections (page 227)
Circular hollow sections (page 227)
Cold rolled profiles (page 228)
Folded plates (page 231)
Hat profiles (page 237)
I beams (concrete) (page 238)
Ledger beams (concrete) (page 239)
T profiles (concrete) (page 240)
Irregular beams (concrete) (page 242)
Panels (page 245)
Variable cross sections (page 248)
Others (page 250)

I profiles

<table>
<thead>
<tr>
<th>Profiles</th>
<th>Predefined parametric profiles available in Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Diagram" /></td>
<td>Hlh-s-t*b (symmetric)</td>
</tr>
<tr>
<td><img src="image2" alt="Diagram" /></td>
<td></td>
</tr>
<tr>
<td><img src="image3" alt="Diagram" /></td>
<td>Hlh-s-t1<em>b1-t2</em>b2</td>
</tr>
<tr>
<td><img src="image4" alt="Diagram" /></td>
<td></td>
</tr>
<tr>
<td><img src="image5" alt="Diagram" /></td>
<td>Hlh1-h2-s-t*b</td>
</tr>
<tr>
<td><img src="image6" alt="Diagram" /></td>
<td></td>
</tr>
<tr>
<td><img src="image7" alt="Diagram" /></td>
<td>Hlh1-h2-s-t1<em>b1-t2</em>b2</td>
</tr>
</tbody>
</table>
### I beams (steel)

<table>
<thead>
<tr>
<th>Diagram</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="I Beam Diagram" /></td>
<td>I_BLT_A (h)-b1-s1-t1*h2-b2-s2-t2</td>
</tr>
<tr>
<td><img src="image2" alt="I Beam Diagram" /></td>
<td>I_BLT_B (h)-b1<em>t1</em>s-b2*t2</td>
</tr>
<tr>
<td><img src="image3" alt="I Beam Diagram" /></td>
<td>I_HEM (h)-b<em>c</em>s*t</td>
</tr>
<tr>
<td><img src="image4" alt="I Beam Diagram" /></td>
<td>I_VAR_A (h)-t<em>b1-bt</em>s*t</td>
</tr>
</tbody>
</table>

### L profiles

<table>
<thead>
<tr>
<th>Diagram</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5" alt="L Profile Diagram" /></td>
<td>Lh<em>b</em>t</td>
</tr>
</tbody>
</table>
### Z profiles

<table>
<thead>
<tr>
<th>Zh<em>b</em>t</th>
<th>Z_VAR_Ah1<em>b1</em>b2-s-h2*b3</th>
<th>Z_VAR_Bh1<em>b1</em>b2-s-h2*b3</th>
<th>Z_VAR_C h1<em>b1</em>b2-s-h2*b3</th>
</tr>
</thead>
</table>

### U profiles

<table>
<thead>
<tr>
<th>Uh<em>b</em>t</th>
<th></th>
</tr>
</thead>
</table>
### C profiles

<table>
<thead>
<tr>
<th>Profile Description</th>
<th>Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ch<em>b</em>t</td>
<td><img src="image1" alt="Chbt Diagram" /></td>
</tr>
<tr>
<td>C_BUILTh<em>b</em>s*t</td>
<td><img src="image2" alt="C_BUILThbs*t Diagram" /></td>
</tr>
<tr>
<td>C_VAR_Ah1<em>b1-s-h2</em>b2</td>
<td><img src="image3" alt="C_VAR_Ah1b1-s-h2b2 Diagram" /></td>
</tr>
<tr>
<td>C_VAR_Bh1<em>b1-s-h2</em>b2</td>
<td><img src="image4" alt="C_VAR_Bh1b1-s-h2b2 Diagram" /></td>
</tr>
<tr>
<td>C_VAR_Ch1<em>b1-s-h2</em>b2</td>
<td><img src="image5" alt="C_VAR_Ch1b1-s-h2b2 Diagram" /></td>
</tr>
</tbody>
</table>
### T profiles

<table>
<thead>
<tr>
<th>Diagram</th>
<th>Th-s-t-b</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="T profile diagram" /></td>
<td>![Th-s-t-b profile]</td>
</tr>
</tbody>
</table>

### Welded box profiles

<table>
<thead>
<tr>
<th>Diagram</th>
<th>HK h-s-t*b-c</th>
<th>HKh-s-t1<em>b1-t2</em>b2-c</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Welded box profile diagram" /></td>
<td>![HK profile]</td>
<td>![HKh profile]</td>
</tr>
</tbody>
</table>

### Welded beam profiles

<table>
<thead>
<tr>
<th>Diagram</th>
<th>B_WLD_A h<em>b</em>s*t</th>
<th>B_WLD_B h<em>b</em>s*t</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Welded beam profile diagram" /></td>
<td>![B_WLD_A profile]</td>
<td>![B_WLD_B profile]</td>
</tr>
<tr>
<td>Profiles</td>
<td>Predefined parametric profiles available in Tekla Structures</td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>----------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="Diagram A" /></td>
<td>B_WLD_C h*s</td>
<td></td>
</tr>
<tr>
<td><img src="image2.png" alt="Diagram B" /></td>
<td>B_WLD_D h<em>b</em>s*t</td>
<td></td>
</tr>
<tr>
<td><img src="image3.png" alt="Diagram C" /></td>
<td>B_WLD_E h<em>b</em>s*t</td>
<td></td>
</tr>
<tr>
<td><img src="image4.png" alt="Diagram D" /></td>
<td>B_WLD_F h<em>b</em>s*[t]</td>
<td></td>
</tr>
<tr>
<td><img src="image5.png" alt="Diagram E" /></td>
<td>B_WLD_G h<em>b</em>s<em>t</em>a</td>
<td></td>
</tr>
<tr>
<td><img src="image6.png" alt="Diagram F" /></td>
<td>B_WLD_H h<em>bo</em>bu<em>s</em>to*tu</td>
<td></td>
</tr>
<tr>
<td>Box profiles</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B_BUILTh<em>b</em>s*t</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Profiles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predefined parametric profiles available in Tekla Structures</td>
</tr>
</tbody>
</table>
WQ profiles

Rectangular sections

Profiles 226 Predefined parametric profiles available in Tekla Structures
## Circular sections

<table>
<thead>
<tr>
<th>Dd</th>
<th>( Dd1 \times r1 \times d2 \times r2 )</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Circular section diagram]</td>
<td>![Circular section diagram]</td>
</tr>
</tbody>
</table>

## Rectangular hollow sections

<table>
<thead>
<tr>
<th>( Ph \times t ) (symmetric)</th>
<th>( Ph \times b \times t )</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Rectangular hollow section diagram]</td>
<td>![Rectangular hollow section diagram]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>( Ph1 \times b1 \times h2 \times b2 \times t )</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Rectangular hollow section diagram]</td>
</tr>
</tbody>
</table>
### Circular hollow sections

<table>
<thead>
<tr>
<th>Diagram</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="PDd" /></td>
<td>PDd</td>
</tr>
<tr>
<td><img src="image2" alt="PDd1d2t" /></td>
<td>PDd1<em>d2</em>t</td>
</tr>
<tr>
<td><img src="image3" alt="EPDd1r1d2r2t" /></td>
<td>EPDd1<em>r1</em>d2<em>r2</em>t</td>
</tr>
</tbody>
</table>

### Cold rolled profiles

<table>
<thead>
<tr>
<th>Diagram</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![ZZh-t-e-b (symmetric)](image4) | ZZh-t-e-b (symmetric)  
ZZh-t-e1-b1-e2-b2 |
| ![CCh-t-e-b (symmetric)](image5) | CCh-t-e-b (symmetric)  
CCh-t-e1-b1-e2-b2 |
<table>
<thead>
<tr>
<th>Profiles</th>
<th>Predefined parametric profiles available in Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>CW h-t-e-b-f-h1 (symmetric)</td>
<td>CW h-t-e1<em>b1-f1-f2-e2</em>b2</td>
</tr>
<tr>
<td>CUh-t-h1-b-e (symmetric)</td>
<td>CUh-t-h1-b1-h2-b2-e</td>
</tr>
<tr>
<td>EBh-t-e-b-a</td>
<td>EBh-t-e1-b1-e2-b2-a</td>
</tr>
<tr>
<td>Reference points: 1=right</td>
<td>2=left</td>
</tr>
<tr>
<td>BFh-s-b-h1</td>
<td></td>
</tr>
<tr>
<td>SPDd*t</td>
<td></td>
</tr>
<tr>
<td>SPDd2<em>d2</em>t</td>
<td></td>
</tr>
<tr>
<td>Profiles</td>
<td>Predefined parametric profiles available in Tekla Structures</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>ESPD d1-d2*t</td>
<td></td>
</tr>
<tr>
<td>ECh-t-e-b-a</td>
<td></td>
</tr>
<tr>
<td>ECh-t-e1-b1-e2-b2-a</td>
<td></td>
</tr>
<tr>
<td>EDh-t-b-e-h1-h2-f1-f2-a</td>
<td></td>
</tr>
<tr>
<td>EEh-t-e-b-f1-f3-h1-f2-a</td>
<td></td>
</tr>
<tr>
<td>EFh-t-e-b1-b2-f1-f2/h1-a</td>
<td></td>
</tr>
</tbody>
</table>
### Folded plates

<table>
<thead>
<tr>
<th>Diagram</th>
<th>Profile Code</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Diagram 1" /></td>
<td>EZh-t-e-b-f1-f3-h1-f2-a</td>
</tr>
<tr>
<td><img src="image2.png" alt="Diagram 2" /></td>
<td>EWh-t-e1-b2-f1-f2-h2-h1-a</td>
</tr>
<tr>
<td><img src="image3.png" alt="Diagram 3" /></td>
<td>FFLAa-b-t</td>
</tr>
<tr>
<td><img src="image4.png" alt="Diagram 4" /></td>
<td>FPANBh-b-t</td>
</tr>
<tr>
<td><img src="image5.png" alt="Diagram 5" /></td>
<td>FPANB_h-b-t</td>
</tr>
<tr>
<td><img src="image6.png" alt="Diagram 6" /></td>
<td>FPANBAh-b-t</td>
</tr>
<tr>
<td><img src="image7.png" alt="Diagram 7" /></td>
<td>FPANB_A-h-b-t</td>
</tr>
<tr>
<td><img src="image8.png" alt="Diagram 8" /></td>
<td>FPANBBh-c-d-t</td>
</tr>
</tbody>
</table>

Predefined parametric profiles available in Tekla Structures
<table>
<thead>
<tr>
<th>Profile</th>
<th>Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>FPANCVb-c-d-t</td>
<td><img src="image1" alt="Diagram" /></td>
</tr>
<tr>
<td>FPANGh-b-c-t</td>
<td><img src="image2" alt="Diagram" /></td>
</tr>
<tr>
<td>FPANGAh-b-c-t</td>
<td><img src="image3" alt="Diagram" /></td>
</tr>
<tr>
<td>FPANJa-b-c-t</td>
<td><img src="image4" alt="Diagram" /></td>
</tr>
<tr>
<td>FPANJa-b-c-t</td>
<td><img src="image5" alt="Diagram" /></td>
</tr>
<tr>
<td>FPAN a-b-c-t-g</td>
<td><img src="image6" alt="Diagram" /></td>
</tr>
<tr>
<td>FPANVVa-b-c-t-g</td>
<td><img src="image7" alt="Diagram" /></td>
</tr>
</tbody>
</table>

Profiles 232
Predefined parametric profiles available in Tekla Structures
<table>
<thead>
<tr>
<th>Profiles</th>
<th>Predefined parametric profiles available in Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>FP_{Ah-b-c-d-g}</td>
<td></td>
</tr>
<tr>
<td>FP_{AAh<em>b2</em>t*a}</td>
<td></td>
</tr>
<tr>
<td>FP_{Bh-b-c-d-g-i}</td>
<td></td>
</tr>
<tr>
<td>FP_{BBh-b-d}</td>
<td></td>
</tr>
<tr>
<td>FP_{Cb-h-c}</td>
<td></td>
</tr>
<tr>
<td>FP_{CCh-b-a-d-s}</td>
<td></td>
</tr>
<tr>
<td>Profiles</td>
<td>Predefined parametric profiles available in Tekla Structures</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td>FP_Db-h-c-d-f-g-i-j-s</td>
<td>![Diagram of FP_Db-h-c-d-f-g-i-j-s]</td>
</tr>
<tr>
<td>FP_Eb-h-c-d-f-g-s</td>
<td>![Diagram of FP_Eb-h-c-d-f-g-s]</td>
</tr>
<tr>
<td>FP_Fb-h-c-d-f-g-s</td>
<td>![Diagram of FP_Fb-h-c-d-f-g-s]</td>
</tr>
<tr>
<td>FP_Gb-h-c-d-f-g-s</td>
<td>![Diagram of FP_Gb-h-c-d-f-g-s]</td>
</tr>
<tr>
<td>FP_Hb-h-c-d-f-s</td>
<td>![Diagram of FP_Hb-h-c-d-f-s]</td>
</tr>
<tr>
<td>FP_Ib-h-c-d-f-s</td>
<td>![Diagram of FP_Ib-h-c-d-f-s]</td>
</tr>
<tr>
<td>Profiles</td>
<td>Predefined parametric profiles available in Tekla Structures</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Diagram" /></td>
<td>FP_Jb-h-c-d-a</td>
</tr>
<tr>
<td><img src="image2.png" alt="Diagram" /></td>
<td>FP_Kb-h-c-d</td>
</tr>
<tr>
<td><img src="image3.png" alt="Diagram" /></td>
<td>FP_Lb-h-c-d-f-s</td>
</tr>
<tr>
<td><img src="image4.png" alt="Diagram" /></td>
<td>FP_Mb-h-c-d-s</td>
</tr>
<tr>
<td><img src="image5.png" alt="Diagram" /></td>
<td>FP_Nb-h-c-d</td>
</tr>
<tr>
<td><img src="image6.png" alt="Diagram" /></td>
<td>FP_Ob-h-c-d-s</td>
</tr>
<tr>
<td>Profiles</td>
<td>Predefined parametric profiles available in Tekla Structures</td>
</tr>
<tr>
<td>----------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Profiles</td>
<td>236 Predefined parametric profiles available in Tekla Structures</td>
</tr>
</tbody>
</table>

\[
\begin{align*}
\alpha_1 &= \text{Alpha 1} \\
\alpha_2 &= \text{Alpha 2} \\
\beta_1 &= \text{Beta 1} \\
\beta_2 &= \text{Beta 2} \\
\end{align*}
\]

- \( FP_{Pa1} \cdot a^2 \cdot h - b1 \cdot b2 - \text{Alpha1} - \text{Alpha2} - \text{Beta1} - \text{Beta2} - s \)
- \( FP_{Qb} \cdot h - c - d - s \)
- \( FP_{Rb} \cdot h - c - d \)
- \( FP_{Sb} \cdot h - c - s \)
- \( FP_{Tb} \cdot h - a - d - s \)
- \( FP_{Ub} \cdot h - a - d - s \)
<table>
<thead>
<tr>
<th>Profile</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FP_Vb-h-s-c</td>
<td>Predefined parametric profile available in Tekla Structures</td>
</tr>
<tr>
<td>FP_Wb-h-a-d-s</td>
<td></td>
</tr>
<tr>
<td>FP_WWh-b-a-c-s</td>
<td></td>
</tr>
<tr>
<td>FP_Yh-b-c-d</td>
<td></td>
</tr>
<tr>
<td>FP_Zd-h-b-s-a-f</td>
<td></td>
</tr>
</tbody>
</table>
## Hat profiles

<table>
<thead>
<tr>
<th>Diagram</th>
<th>Profile Notation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Diagram 1" /></td>
<td>HAT h<em>a</em>c*t</td>
</tr>
<tr>
<td><img src="image2.png" alt="Diagram 2" /></td>
<td>HATCa-b-c-b1-h-b3-b4-b5-s</td>
</tr>
<tr>
<td><img src="image3.png" alt="Diagram 3" /></td>
<td>HATAb1<em>h1</em>h2<em>h3</em>h4<em>h5</em>h6<em>b2</em>t<em>f</em>a<em>h</em>b</td>
</tr>
<tr>
<td><img src="image4.png" alt="Diagram 4" /></td>
<td>HATBb<em>b1</em>b2<em>h</em>h1<em>h2</em>h3<em>h4</em>t<em>f</em>a</td>
</tr>
</tbody>
</table>

 Profiles 238  Predefined parametric profiles available in Tekla Structures
### I beams (concrete)

<table>
<thead>
<tr>
<th>Image</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="I Beam Diagram" /></td>
<td>Hlh₁<em>b₁</em>t₁-h₂-s-b₂*t₂[-sft[-sfb]]</td>
</tr>
<tr>
<td><img src="image2.png" alt="I Beam Diagram" /></td>
<td>Ih₁<em>b₁</em>t₁-s-b₂*t₂[-sft[-sfb]]</td>
</tr>
<tr>
<td><img src="image3.png" alt="I Beam Diagram" /></td>
<td>Sh₁<em>b₁</em>t₁-h₂-s-b₂*t₂[-sft[-sfb]]</td>
</tr>
</tbody>
</table>

### Ledger beams (concrete)

<table>
<thead>
<tr>
<th>Image</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image4.png" alt="Ledger Beam Diagram" /></td>
<td>RCLₜ<em>h-b</em>t</td>
</tr>
</tbody>
</table>

Profiles 239 Predefined parametric profiles available in Tekla Structures
### T profiles (concrete)

<table>
<thead>
<tr>
<th>Diagram</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Diagram 1](image1.png) | RCDLs*h-b*t
RCDLs*h-b*t1*t2 |
| ![Diagram 2](image2.png) | RCDXs*h-b*h2*h1
RCDXs*h-b*h4*h3*h2*h1
RCDXs*h-b*h4*h3*h2*h1-ex |
| ![Diagram 3](image3.png) | REXXs*h-b*t*h1-h2-ex |
| ![Diagram 4](image4.png) | RCXs*h-b*h2*h1 |
| ![Diagram 5](image5.png) | HTTh*b-s-t-b2-h2 |

Profiles 240 | Predefined parametric profiles available in Tekla Structures
<table>
<thead>
<tr>
<th>Profiles</th>
<th>Predefined parametric profiles available in Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>TCh-b-t-s</strong></td>
<td><img src="Image1" alt="Diagram of TCh-b-t-s" /></td>
</tr>
<tr>
<td><strong>TRlh<em>b-b2</em>t1-h3-t2</strong></td>
<td><img src="Image2" alt="Diagram of TRlhb-b2t1-h3-t2" /></td>
</tr>
<tr>
<td><strong>TTh*b-s-t-b2</strong></td>
<td><img src="Image3" alt="Diagram of TTh*b-s-t-b2" /></td>
</tr>
<tr>
<td><strong>TTTh*b-bl-br-hw-bwmin-bwmax</strong></td>
<td><img src="Image4" alt="Diagram of TTTh*b-bl-br-hw-bwmin-bwmax" /></td>
</tr>
<tr>
<td><strong>T_VAR_Ah1<em>h2</em>s<em>b1</em>t1-sft</strong></td>
<td><img src="Image5" alt="Diagram of T_VAR_Ah1h2sb1t1-sft" /></td>
</tr>
</tbody>
</table>
Irregular beams (concrete)

<table>
<thead>
<tr>
<th>Diagram</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Diagram" /></td>
<td>T_VAR_Bh-b-c-d</td>
</tr>
<tr>
<td><img src="image2.png" alt="Diagram" /></td>
<td>IRR_Ab-h-g-c-d</td>
</tr>
<tr>
<td><img src="image3.png" alt="Diagram" /></td>
<td>IRR_Bh-b-c-d-f-g</td>
</tr>
<tr>
<td><img src="image4.png" alt="Diagram" /></td>
<td>IRR_Ch-b-c-d</td>
</tr>
</tbody>
</table>

Profiles | 242 | Predefined parametric profiles available in Tekla Structures
<table>
<thead>
<tr>
<th>Profile</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Profile 1" /></td>
<td>IRR_Db1<em>b2-h1</em>h2</td>
</tr>
<tr>
<td><img src="image2" alt="Profile 2" /></td>
<td>IRR_Eh-b-c-d-h2-h3-h4</td>
</tr>
<tr>
<td><img src="image3" alt="Profile 3" /></td>
<td>IRR_Fa*b</td>
</tr>
<tr>
<td><img src="image4" alt="Profile 4" /></td>
<td>IRR_Gh<em>b</em>h2*b2</td>
</tr>
<tr>
<td><img src="image5" alt="Profile 5" /></td>
<td>IRR_Hh<em>b</em>h2*b2</td>
</tr>
<tr>
<td><img src="image6" alt="Profile 6" /></td>
<td>IRR_Ih<em>b</em>b2</td>
</tr>
<tr>
<td><img src="image7" alt="Profile 7" /></td>
<td>IRR_Jh<em>b</em>b2</td>
</tr>
</tbody>
</table>

Profiles | 243 | Predefined parametric profiles available in Tekla Structures
<table>
<thead>
<tr>
<th>Diagram</th>
<th>Profiles</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="OCTB*b1-H*h1" alt="Diagram" /></td>
<td>OCTB<em>b1-H</em>h1</td>
</tr>
<tr>
<td><img src="REC_Ah-b" alt="Diagram" /></td>
<td>REC_Ah-b</td>
</tr>
<tr>
<td><img src="REC_Bh-b-b1" alt="Diagram" /></td>
<td>REC_Bh-b-b1</td>
</tr>
<tr>
<td><img src="REC_Ch-b-b1" alt="Diagram" /></td>
<td>REC_Ch-b-b1</td>
</tr>
<tr>
<td><img src="REC_Dh-b-b2" alt="Diagram" /></td>
<td>REC_Dh-b-b2</td>
</tr>
<tr>
<td><img src="REC_Eh-b" alt="Diagram" /></td>
<td>REC_Eh-b</td>
</tr>
<tr>
<td><img src="REC_Fh-b" alt="Diagram" /></td>
<td>REC_Fh-b</td>
</tr>
<tr>
<td><img src="REC_Gh-b" alt="Diagram" /></td>
<td>REC_Gh-b</td>
</tr>
<tr>
<td>Profiles</td>
<td>245</td>
</tr>
<tr>
<td>---------</td>
<td>-----</td>
</tr>
<tr>
<td>REC_Hh-b</td>
<td></td>
</tr>
<tr>
<td>REC_I a-b*H</td>
<td></td>
</tr>
<tr>
<td>TRI_Ah-b</td>
<td></td>
</tr>
<tr>
<td>TRI_Ba1</td>
<td></td>
</tr>
<tr>
<td>TRI_Cb-h</td>
<td></td>
</tr>
<tr>
<td>TRI_Dh*b</td>
<td></td>
</tr>
<tr>
<td>TRI_Eb<em>h</em>h2*b2</td>
<td></td>
</tr>
</tbody>
</table>
## Panels

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>PNL_Ah*b</td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>PNL_Ch<em>b-a-ht</em>bt</td>
<td><img src="image4.png" alt="Image" /></td>
</tr>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td>PNL_Eh<em>b-a-ht</em>bt</td>
<td></td>
</tr>
</tbody>
</table>

**Profiles**

Predefined parametric profiles available in Tekla Structures
<table>
<thead>
<tr>
<th>Profiles</th>
<th>Predefined parametric profiles available in Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>PNL_Fh<em>b-a-h</em>t<em>b</em>t</td>
<td><img src="image1" alt="Image of PNL_Fhb-a-htbt" /></td>
</tr>
<tr>
<td>PNL_Gh*b</td>
<td><img src="image2" alt="Image of PNL_Gh*b" /></td>
</tr>
<tr>
<td>PNL_Hh<em>b-a-h</em>t</td>
<td><img src="image3" alt="Image of PNL_Hhb-a-ht" /></td>
</tr>
<tr>
<td>PNL_Ih<em>b-a-h</em>t<em>b</em>t</td>
<td><img src="image4" alt="Image of PNL_Ihb-a-htbt" /></td>
</tr>
<tr>
<td>PNL_Jh<em>b-a-h</em>t<em>b</em>t</td>
<td><img src="image5" alt="Image of PNL_Jhb-a-htbt" /></td>
</tr>
<tr>
<td>PNL_Kh*b</td>
<td><img src="image6" alt="Image of PNL_Kh*b" /></td>
</tr>
</tbody>
</table>
### Variable cross sections

<table>
<thead>
<tr>
<th>Profile</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PNL_Lh-b-c-f</td>
<td><img src="image1.png" alt="Diagram" /></td>
</tr>
<tr>
<td>PNL_Mh-b-c-f-d</td>
<td><img src="image2.png" alt="Diagram" /></td>
</tr>
<tr>
<td>PNL_Nh-b-d-f-g-j</td>
<td><img src="image3.png" alt="Diagram" /></td>
</tr>
<tr>
<td>PNL_Oh-b-d-f-g-i-t</td>
<td><img src="image4.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Profile</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HEXRECTh-b-br-hr</td>
<td><img src="image5.png" alt="Diagram" /></td>
</tr>
<tr>
<td>HXGONb</td>
<td><img src="image6.png" alt="Diagram" /></td>
</tr>
<tr>
<td>Profiles</td>
<td>249</td>
</tr>
<tr>
<td>----------</td>
<td>-----</td>
</tr>
<tr>
<td><strong>OBLINCLh1-h2-h3-h4-b</strong></td>
<td><img src="image1" alt="Diagram" /></td>
</tr>
<tr>
<td><strong>OBLRIDh1<em>b1</em>b2-h2-h3-l2-l1</strong></td>
<td><img src="image3" alt="Diagram" /></td>
</tr>
<tr>
<td><strong>OBLVAR_Ah1<em>b1</em>b2-h2</strong></td>
<td><img src="image5" alt="Diagram" /></td>
</tr>
<tr>
<td><strong>OBLVAR_Bh1-h2-b</strong></td>
<td><img src="image7" alt="Diagram" /></td>
</tr>
<tr>
<td><strong>OBLVAR_Ch-b-a-i-j-k-m-n</strong></td>
<td><img src="image9" alt="Diagram" /></td>
</tr>
<tr>
<td><strong>OBLVAR_Dh-c-b</strong></td>
<td><img src="image11" alt="Diagram" /></td>
</tr>
<tr>
<td><strong>OBLVAR_Eh-b-a-c-d-i-j-k-l-m-p-o</strong></td>
<td><img src="image13" alt="Diagram" /></td>
</tr>
<tr>
<td>Shape</td>
<td>Equation</td>
</tr>
<tr>
<td>-------</td>
<td>----------</td>
</tr>
<tr>
<td>OCTAGON b-b2</td>
<td></td>
</tr>
<tr>
<td>PRMDAS h<em>b-he</em>be</td>
<td>PL_Vh<em>b-he</em>be</td>
</tr>
<tr>
<td>PRMD h<em>b-h2</em>b2</td>
<td></td>
</tr>
<tr>
<td>ROUNDRECT d-Rb<em>Rh-t</em>ye-ze</td>
<td></td>
</tr>
</tbody>
</table>

**Others**

| BLKSD1-d2 | |

**Profiles**

250 Predefined parametric profiles available in Tekla Structures
<table>
<thead>
<tr>
<th>Profile</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAPd</td>
<td>Predefined parametric profiles available in Tekla Structures</td>
</tr>
<tr>
<td>HEMISPHERd</td>
<td></td>
</tr>
<tr>
<td>NUT_Md</td>
<td></td>
</tr>
<tr>
<td>RCRWh*b-b2-b3-b4-t1-t2-t3-t4</td>
<td></td>
</tr>
<tr>
<td>SKh*b-h2-t-b2-b3</td>
<td></td>
</tr>
<tr>
<td>SPHEREd</td>
<td></td>
</tr>
</tbody>
</table>
The Shape Catalog dialog box contains information on shapes. It is used for viewing shape properties, and for importing and exporting shapes.

The shapes you download from Tekla Warehouse are also displayed in the Shape Catalog dialog box.

The catalog includes two default shapes: Default and Concrete_Default. Shapes are used in defining items. In Tekla Structures, items are similar to other parts, such as beams and columns. The main difference between items and other types of parts is that a 3D shape defines the geometry of an item, whereas a part has a 2D profile that is extruded to create the length of the part.

The shapes you import to the shape catalog are stored in the current model folder. There are two .xml files for each shape: one stored in the \Shapes folder and one in the \ShapeGeometries folder.

If you have shapes that you would like to have available in the Shape Catalog dialog box for all new models that are created in your project or company, copy the corresponding .xml files to the correct subfolders (\Shapes and \ShapeGeometries) in the \profile folder under your project or firm folder.

See also

Import a shape (page 252)
Export a shape (page 253)
Delete a shape (page 254)
Import a shape

You can import the following types of shape files: dgn, tsc, skp, dxf, dwg, ifc, ifcZIP, ifcXML, igs, iges, stp, and step.

When using other modeling software to model shapes that you want to import into Tekla Structures, we recommend that you center parts around the origin and direct the parts along the x axis.

1. On the **File** menu, click **Catalogs --> Shape catalog**.
   The **Shape Catalog** dialog box opens.
2. Click **Import**.
3. Select the import file.
4. Click **OK**.
   Importing a large file can take several minutes.

Shape import has three possible results:

- Tekla Structures imports the shape as a watertight solid shape. All solid operations are available.
- Tekla Structures imports the shape as a non-solid shape. A non-solid shape means that the object may not be watertight. For example, it has holes, or is missing a face or an edge.
- Import fails. This can happen, for example, if the shape is very complex or has no volume. There may also be a tolerance difference between Tekla Structures and the original software that was used to create the shape. To find out why the import failed, check the session history log by clicking **File menu --> Logs --> Session history log**.

When you import a shape into the **Shape Catalog**, Tekla Structures creates two .xml files: one for shape attributes, such as name and GUID, and one for geometric properties, such as coordinates. The files are saved in the current model folder under the \Shapes and \ShapeGeometries subfolders.

**TIP** You can also download shapes from Tekla Warehouse.

**See also**

- Example: Import a shape from SketchUp Pro (page 255)
- Export a shape (page 253)
- Delete a shape (page 254)
- Shapes (page 252)
Export a shape

1. On the File menu, click Catalogs --> Shape catalog.
   The Shape Catalog dialog box opens.
2. Select the shape to export.
   To select multiple shapes, hold down Ctrl or Shift.
3. Click Export.
4. If you are exporting only one shape, select the folder where you want to export the shape, and enter a name for the export file in the Selection box.
5. If you are exporting multiple shapes, select the folder where you want to export the shapes.
   Tekla Structures will create a separate export file for each shape using the shape name as the file name.
6. Click OK.
   The shapes are saved in the destination folder as .tsc files.

TIP You can also upload shapes to Tekla Warehouse.

See also

Import a shape (page 252)
Delete a shape (page 254)
Shapes (page 252)

Delete a shape

Before you start, ensure that the shape you want to delete is not used in your Tekla Structures model. When you delete a shape from the Shape Catalog, the shape is no longer available anywhere in the model. If a model includes a deleted shape, it is only shown as a straight line between its original reference points.

1. On the File menu, click Catalogs --> Shape catalog.
   The Shape Catalog dialog box opens.
2. Right-click the name of the shape.
3. Click Delete.
   Tekla Structures deletes the shape.
Example: Import a shape from SketchUp Pro
In this example, you import a solid 3D shape from Trimble SketchUp Pro to a Tekla Structures model.

1. Create an empty model in SketchUp Pro.
   Delete any extra entities, such as the default person on the drawing area.

2. Create a group of entities.
   Although Tekla Structures supports importing separate individual entities, we recommend you create a group of entities or a component in SketchUp.

   All SketchUp groups and components should form watertight solids. Select the group or component and open **Entity Info** to check that the selection is a solid. SketchUp solids have a volume. If there is no volume listed, the selection is not a solid.

3. Select the group and click **Solid Tools --> Union** to make the group of entities into a union of solids.
   Your group becomes a single solid volume: a solid.

4. Place the solid in SketchUp so that it lies along the positive x axis (red), and halfway on both y (green) and z axes (blue). In Tekla Structures, the yellow and magenta part handles will align with the x axis used in SketchUp.

   The location and rotation of the solid in SketchUp are important, since they determine how an item is inserted and positioned in Tekla Structures. Different positioning in SketchUp causes an offset in Tekla Structures.

5. Save the SketchUp file.

6. In your Tekla Structures model, open the **Shape Catalog** and click **Import**.
7. Select the SketchUp file.
8. Click OK.

Tekla Structures imports the shape to the **Shape Catalog** and you can use it to define the shape of an item or a concrete item.

**See also**

- Shapes (page 252)
- Import a shape (page 252)
The material catalog contains information on material grades. Materials are displayed in a hierarchical tree grouped according to material types, for example, steel and concrete. Material grades are located under each material type in the tree.

By default, the material catalog contains standard, environment-specific materials. You can add, modify, and delete material grades.

Tekla Structures stores the material information in the matdb.bin file.

See also
Material types (page 257)
Manage material grades (page 258)
Import and export material grades (page 262)
Create user-defined material definitions (page 264)

8.1 Material types
You cannot add new material types to the material catalog. The following material types are available:

• Steel
• Concrete
• Reinforcing bar
• Timber
• Miscellaneous

See also
Material grades (page 257)
8.2 Manage material grades

You can manage existing material grades using the material catalog. For example, you can add, modify and delete material grades.

Click the links below to find out more:

Important buttons in the material catalog (page 258)
Add a material grade (page 259)
Modify a material grade (page 260)
Copy a material grade (page 259)
Delete a material grade (page 261)
Add user attributes to material grades (page 261)

Important buttons in the material catalog

When you work with the material grades, note the usage of the following buttons in the Modify Material Catalog dialog box:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update</td>
<td>Saves the changes of a single edited material grade to the computer’s memory until you click OK.</td>
</tr>
<tr>
<td>OK</td>
<td>Saves the changes in the model folder. Tekla Structures saves the modified catalog on the hard disk when you click OK to close the dialog box and then click OK in the Save confirmation dialog box.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the Modify Material Catalog dialog box without saving the changes. Note that all changes made to the catalog will be lost even if you have clicked Update, because the changes have not been saved on the hard disk. The changes made to the catalog are visible during one session, because the catalog is using the computer’s memory. When you start Tekla Structures the next time, the previous data is restored from the hard disk.</td>
</tr>
</tbody>
</table>

Tekla Structures stores the material information in the matdb.bin file. When you first open a model, Tekla Structures reads the data from the hard disk and stores it in the computer’s memory.

When you select a material, Tekla Structures reads the data from the computer’s memory and displays it in the Modify Material Catalog dialog box. This is faster than accessing the data from the hard disk.
Add a material grade

1. On the File menu, click Catalogs --> Material catalog to open the Modify Material Catalog dialog box.
2. Select a material type, for example, steel.
3. Right-click and select Add Grade.
   A new material grade is added under to the material type you selected.
4. Change the material grade name by clicking the grade and entering a new name for it.
5. Enter the material grade properties.
6. Click OK to save the material grade and close the Modify Material Catalog dialog box.
7. Click OK in the Save confirmation dialog box to save the changes.

See also
Copy a material grade (page 259)
Modify a material grade (page 260)
Delete a material grade (page 261)
Import and export material grades (page 262)

Copy a material grade

You can add new material grades by modifying a copy of an existing, similar material grade.

1. On the File menu, click Catalogs --> Material catalog to open the Modify Material Catalog dialog box.
2. Select a material grade that is similar to the one you wish to create.
3. Right-click and select Copy Grade.
   A copy of the material grade with the name COPY is added to the material tree.
4. Change the material grade name by clicking the grade and entering a new name for it.
5. Modify the material grade properties.
6. Click **OK** to save the material grade and close the **Modify Material Catalog** dialog box.

7. Click **OK** in the **Save confirmation** dialog box to save the changes.

**See also**

- Add a material grade (page 259)
- Modify a material grade (page 260)
- Delete a material grade (page 261)

**Modify a material grade**

You can modify existing material grades using the material catalog.

1. On the **File** menu, click **Catalogs --> Material catalog** to open the **Modify Material Catalog** dialog box.

2. Select a material grade in the tree and modify its properties.
   - Use the **General** tab for entering three alternative names for the material. The names are usually the material names used in different countries or standards. The tab also contains the profile and plate density values.
   - Use the **Analysis** tab for entering information on the properties used in structural analysis.
   - Use the **Design** tab for entering information on the design-specific properties, such as strengths and partial safety factors.
   - Use the **User attributes** tab for creating your own attributes for material grades.
     For example, you can define a paint layer thickness, or the maximum grain size of concrete using a user-defined attribute.

3. When you have finished modifying the material grade, click **Update**.

4. Click **OK** to close the **Modify Material Catalog** dialog box.
   Tekla Structures asks if you want to save the changes to the model folder.

5. Click **OK** in the **Save confirmation** dialog box to save the changes.
   The modified material catalog is saved in the current model folder and is available only for that model. To make the modified catalog available for all the other models, use export and import.

**See also**

- Add a material grade (page 259)
- Copy a material grade (page 259)
Delete a material grade (page 261)

Delete a material grade
1. On the File menu, click Catalogs --> Material catalog to open the Modify Material Catalog dialog box.
2. Select the material grade that you want to delete.
3. Right-click and select Delete Grade.
4. Click OK to close the Modify Material Catalog dialog box.
5. Click OK in the Save confirmation dialog box to save the changes.

See also
Add a material grade (page 259)
Copy a material grade (page 259)
Modify a material grade (page 260)

Add user attributes to material grades
You can add user attributes and their values to the material grades. The user attributes can then be used, for example, in filtering.
1. On the File menu, click Catalogs --> Material catalog to open the Modify Material Catalog dialog box.
2. On the User attributes tab, click Definitions to open the Modify Material Properties dialog box.
3. Click Add to add a new row.
4. To define a user attribute, click each item on a row.
   a. In the Category list, select a material category to which the user attribute is applied.
   b. In the Design code list, select a design code to which the attribute is added.
   c. In the Material type list, select a material type for the attribute.
   d. In the Quantity type list, select the type of information that the user attribute contains, for example, weight, area, ratio, or string.
   e. In the Order column, define the order in which the user attributes are shown in the dialog box. Smaller values are shown first.
   f. In the Property name column, define a name for the property.

   The name is saved in the catalog and can be used in reports and templates. When Property name is used in a template,
MATERIAL.PROPERTY_NAME indicates where the property name appears.

g. In the **Label** column, define a label for the attribute.

5. Click **Update**.
6. Click **OK** to close the **Modify Material Properties** dialog box.

**See also**

Modify a material grade (page 260)

### 8.3 Import and export material grades

Use importing and exporting for merging material catalogs. Material catalogs are imported and exported as `.lis` files.

Importing and exporting is useful when you:

- upgrade to a newer version of Tekla Structures and want to use a customized material catalog from a previous version
- want to combine material catalogs that are stored in different locations
- want to share material catalog information with other users
- want to combine material catalogs across different environments.

**TIP** You can also download or share material grades using Tekla Warehouse.

**See also**

Import a material catalog (page 262)
Export an entire material catalog (page 263)
Export a part of the material catalog (page 264)
Units used in import and export (page 163)

### Import a material catalog

Material catalogs are imported to Tekla Structures models as `.lis` files. You can move an exported `.lis` file to any model folder and import it to an existing material catalog.

1. Open the model to which you want to import a material catalog.
2. On the **File** menu, click **Catalogs** --> **Material catalog** to open the **Modify Material Catalog** dialog box.
3. Click **Import**.
4. Browse for the folder that contains the import file, and select the file.

5. Click OK.

If a material with a same name as the material being imported already exists, the **Import confirmation** dialog box appears and you have three options:

- **Replace**: The existing material is replaced with the imported material.
- **Merge**: Material properties that are different in the import file are added to the existing material. All the other properties remain unchanged.
  
  Use this option to import only certain elements of the material catalog, such as user attributes.
- **Leave**: The existing material is not replaced and the material definitions in the import file are ignored.

If you select the **Apply for all** check box, Tekla Structures uses the same option (Replace, Merge, or Leave) for all the existing materials that have the same name as the one being imported.

If a user attribute with a different definition already exists, you are prompted to Replace or Leave the existing attribute.

6. Click OK to close the **Modify Material Catalog** dialog box.

7. Click OK in the **Save confirmation** dialog box to save the changes.

**See also**

- Export an entire material catalog (page 263)
- Export a part of the material catalog (page 264)
- Units used in import and export (page 163)

---

**Export an entire material catalog**

Exporting and importing are used to merge material catalogs. Material catalogs are exported from Tekla Structures models as .lis files. Note that the **Export** command exports the entire catalog.

1. On the **File** menu, click **Catalogs --&gt; Material catalog** to open the **Modify Material Catalog** dialog box.

2. Click **Export**.


   By default, the file is saved to the current model folder.

4. Enter a name for the file and click **OK**.

5. Click **OK** to close the **Modify Material Catalog** dialog box.
6. Click **OK** in the **Save confirmation** dialog box to save the changes.

**See also**
Import a material catalog (page 262)
Units used in import and export (page 163)

**Export a part of the material catalog**
If you do not want to export the whole material catalog, you can export a branch of the material tree, meaning all the material grades grouped under one material type, or a single material grade. Material catalogs are exported from Tekla Structures models as **.lis** files.

1. On the **File** menu, click **Catalogs --> Material catalog** to open the **Modify Material Catalog** dialog box.
2. Select material grades to be exported.
   - To export a branch of the material tree, right-click the branch and select **Export Grades**.
   - To export a single material grade, right-click the material grade and select **Export Grade**.
3. Browse for the folder where you want to save the export files.
   By default, the file is saved to the current model folder.
4. Enter a name for the file and click **OK**.
5. Click **OK** to close the **Modify Material Catalog** dialog box.
6. Click **OK** in the **Save confirmation** dialog box to save the changes.

**See also**
Export an entire material catalog (page 263)
Import a material catalog (page 262)
Units used in import and export (page 163)

### 8.4 Create user-defined material definitions
You can replace the existing material definitions with your own definitions and use them, for example, in drawing part marks. Material definitions can contain text, numbers and symbols.

1. **Save the symbol file** `user_material_symbols.sym` **in the symbol folder** (usually the folder `..\ProgramData\Tekla Structures\<version>\environments\common\symbols\`).
2. Create a text file that contains your material definitions.

Create the file using a text editor, for example Microsoft Notepad.

Each row in the file defines a material. Use the following syntax:
material_name symbol_file_name\n, where

- material_name is the name of the material used in the material catalog
- symbol_file_name is the symbol file name to be used
- n is the number of the symbol.

For example:

S235JRG1 user_material_symbols\n81 B
S235JRG2 user_material_symbols\n82 C
S235JR user_material_symbols\n80 A
S275JR user_material_symbols\n83 D
S355JR user_material_symbols\n84 E

**WARNING** The order of material names in the definition file is relevant to the conversion. Materials with more specific names need to be listed before the ones with similar, but simpler names, for example, S235JRG1 must be listed before S235JR. Otherwise they both get the same symbol.

3. Save the file for example with the name
user_material_definitions.txt.

All the named materials in the material catalog will be replaced with the ones defined in this file.

4. Set the name of the file as a value for the advanced option
XS_MATERIAL_SYMBOL_REPRESENTATION_FILE in File menu -- Settings -- Advanced options -- Drawing Properties as follows:

set
XS_MATERIAL_SYMBOL_REPRESENTATION_FILE=user_material_definitions.txt

You can also enter a full path to the material definition file. Without the path Tekla Structures searches for the file in the model, firm, project, and system folders.

**See also**

Material grades (page 257)
The individual *bolt assembly elements*, such as bolts of different sizes and lengths, nuts and washers, are listed in the bolt catalog. Each *bolt assembly* then consists of these bolt assembly elements. You cannot use a bolt if it does not belong to a bolt assembly. The bolt assemblies are listed in the bolt assembly catalog.

Tekla Structures stores the bolt catalog information in the `screwd.db` file and the bolt assembly catalog information in the `assdb.db` file.

**See also**

- How the bolt catalog and bolt assembly catalogs work together (page 266)
- Manage bolts and bolt assemblies (page 268)
- Import and export bolts and bolt assemblies (page 273)
- Bolt length calculation (page 278)
9.1 How the bolt catalog and bolt assembly catalogs work together

The Bolt standard options are read from the bolt assembly catalog.

1. The bolt assembly catalog defines which bolt standard is used in the bolt assembly.

2. The bolt catalog contains the different bolt diameters, lengths, and other properties used in the bolt standard.

3. The Bolt size options are read from the bolt catalog depending on the selected Bolt standard option.

See also

Bolt assemblies (page 266)
Bolt catalog properties (page 281)
Bolt assembly catalog properties (page 282)
9.2 Manage bolts and bolt assemblies

This section describes how to manage bolts and bolt assemblies using the bolt catalog and the bolt assembly catalog. You can add, modify, and delete bolts and bolt assemblies.

Click the links below to find out more:

Add a bolt to the catalog (page 268)
Add a stud bolt to the catalog (page 269)
Modify bolt information in the catalog (page 270)
Delete a bolt from the catalog (page 271)
Add a bolt assembly to the catalog (page 271)
Modify bolt assembly information in the catalog (page 272)
Delete a bolt assembly from the catalog (page 272)

Add a bolt to the catalog

You need to add individual bolt elements, such as bolts, nuts, and washers, to the bolt catalog before you can define bolt assemblies and use them in a model.

The following steps are for adding bolts, but they also apply to adding nuts and washers.

1. On the File menu, click Catalogs --&gt; Bolt catalog to open the Bolt Catalog dialog box.
2. Enter the name of the bolt in the following box:

   ![Bolt Catalog Dialog Box]

   You can enter a maximum of 40 characters in the name box.
3. In the Type list, select an option to define the bolt element type.
4. Define the other properties of the new bolt.

   You can enter a maximum of 25 characters in the Standard box.

   Use different names for bolt, nut, washer, and stud standards to distinguish bolt element types from each other when defining bolt assemblies.
5. Click **Add** to add the bolt to the bolt catalog.

You cannot use a bolt if it does not belong to a bolt assembly. Therefore, we recommend checking that the catalog also includes nuts and washers that work with the new bolt so that you can create a bolt assembly. If the catalog does not include suitable nuts and washers, add them the same way as you added the new bolt.

6. Click **OK**.

The **Save** confirmation dialog box appears.

7. Select **Save changes to model folder** to save the changes in the `screwdb.db` file in the current model folder, and then click **OK**.

**TIP**

You can also add bolts by importing them to the bolt catalog.

---

**See also**

- Import bolts to the catalog (page 273)
- Add a stud bolt to the catalog (page 269)
- Modify bolt information in the catalog (page 270)
- Delete a bolt from the catalog (page 271)
- Bolt length calculation (page 278)
- Bolt catalog properties (page 281)
- Add a bolt assembly to the catalog (page 271)

---

**Add a stud bolt to the catalog**

A stud is special type of bolt that is welded to steel parts to transfer loads between steel and concrete. You cannot use studs unless you have defined a stud assembly that contains the assembly's name and material.

1. On the **File** menu, click **Catalogs --&gt; Bolt catalog** to open the **Bolt Catalog** dialog box.

2. Enter values for the following properties:

   - **Name**: Name for the stud bolt.
   - **Type**:  
   - **Standard**: This name is needed when creating a bolt assembly for the stud.
   - **Diameter**: Shank diameter.
   - **Length**: Stud length.
• **Weight**: Stud weight.
• **top thick**: Head thickness.
• **top diameter**: Head diameter.

The units depend on the settings in **File menu -- Settings -- Options -- Units and decimals**.

3. On the **File** menu, click **Catalogs -- Bolt assembly catalog** to open the **Bolt Assembly Catalog** dialog box.
4. Select the standard for the stud bolt.
5. Set all the other bolt assembly elements to **None**.

6. To create studs in the model, create bolts and select the stud assembly standard.

**See also**

*Bolt catalog properties (page 281)*

**Modify bolt information in the catalog**

1. On the **File** menu, click **Catalogs -- Bolt catalog** to open the **Bolt Catalog** dialog box.
2. Select a bolt from the list.
3. Modify the properties.
4. Click **Update**.
5. Click **OK**.
   
   **The Save confirmation** dialog box appears.
6. Select **Save changes to model folder** to save the changes in the **screwdb.db** file in the current model folder, and then click **OK**.
Delete a bolt from the catalog

1. On the File menu, click Catalogs --> Bolt catalog to open the Bolt Catalog dialog box.
2. Select a bolt from the list.
   Use the Shift and Ctrl keys to select multiple bolts.
3. Click Delete.
4. Click OK.
   The Save confirmation dialog box appears.
5. Select Save changes to model folder to save the changes in the screwdb.db file in the current model folder, and then click OK.

See also
Add a bolt to the catalog (page 268)
Modify bolt information in the catalog (page 270)

Add a bolt assembly to the catalog
You can add new bolt assemblies to the bolt assembly catalog. Note that the bolt assembly can contain only bolts or studs, not both of them.

1. On the File menu, click Catalogs --> Bolt assembly catalog to open the Bolt Assembly Catalog dialog box.
2. Enter the name of the bolt assembly in the following box:
3. Define the other properties of the new bolt assembly.
   You can enter a maximum of 30 characters in the Standard box. For all the other properties, you can enter a maximum of 25 characters.
4. Click Add to add the bolt assembly to the catalog.
5. Click OK.
   The Save confirmation dialog box appears.
6. Select **Save changes to model folder** to save the changes in the assdb.db file in the current model folder, and then click **OK**.

**See also**
- Import bolt assemblies to the catalog (page 275)
- Modify bolt assembly information in the catalog (page 272)
- Delete a bolt assembly from the catalog (page 272)
- Bolt assembly catalog properties (page 282)

### Modify bolt assembly information in the catalog

1. On the **File** menu, click **Catalogs --> Bolt assembly catalog** to open the **Bolt Assembly Catalog** dialog box.
2. Select a bolt assembly from the list.
3. Modify the properties.
4. Click **Update**.
5. Click **OK**.
   - The **Save confirmation** dialog box appears.
6. Select **Save changes to model folder** to save the changes in the assdb.db file in the current model folder, and then click **OK**.

**See also**
- Add a bolt assembly to the catalog (page 271)
- Delete a bolt assembly from the catalog (page 272)

### Delete a bolt assembly from the catalog

1. On the **File** menu, click **Catalogs --> Bolt assembly catalog** to open the **Bolt Assembly Catalog** dialog box.
2. Select a bolt assembly from the list.
3. Click **Delete**.
4. Click **OK**.
   - The **Save confirmation** dialog box appears.
5. Select **Save changes to model folder** to save the changes in the assdb.db file in the current model folder, and then click **OK**.
9.3 Import and export bolts and bolt assemblies

Use importing and exporting for merging bolts and bolt assemblies across catalogs. Bolts are imported and exported as .bolts files, bolt assemblies as .bass files, and bolt catalogs as .lis files.

When you export single bolts or bolt assemblies, you can select the bolts or bolt assemblies you want to include in the .bolts or .bass file. When you import and export bolt assemblies, also the related bolts are included in the .bass file.

You can import and export an entire bolt catalog. You can also import a part of an exported bolt catalog.

Importing and exporting bolt catalogs is useful, when you:

• Upgrade to newer version of Tekla Structures and you want to use a customized bolt catalog from a previous version.
• Want to combine bolt catalogs that are stored in different locations.
• Want to share bolt catalog information with other users.

TIP You can also download or share bolt assemblies using Tekla Warehouse.

See also
Import bolts to the catalog (page 273)
Export bolts from the catalog (page 274)
Import bolt assemblies to the catalog (page 275)
Export bolt assemblies from the catalog (page 275)
Import a bolt catalog (page 276)
Import a part of the bolt catalog (page 276)
Export an entire bolt catalog (page 277)
**Import bolts to the catalog**

Bolts are imported and exported as `.bolts` files. A `.bolts` file can include one bolt or several bolts.

1. On the **File** menu, click **Catalogs --> Bolt catalog** to open the **Bolt Catalog** dialog box.
2. Right-click in the **Bolts** list and select **Import**.
3. Select the import file.
4. Click **OK**.
   
   The bolts are displayed on the **Bolts** list by their original names.
5. Click **OK**.
   
   The **Save confirmation** dialog box appears.
6. Select **Save changes to model folder** to save the changes in the `screwdb.db` file in the current model folder, and then click **OK**.

**See also**

- Add a bolt to the catalog (page 268)
- Import a bolt catalog (page 276)
- Import a part of the bolt catalog (page 276)
- Import bolt assemblies to the catalog (page 275)
- Export bolts from the catalog (page 274)

**Export bolts from the catalog**

Bolts are imported and exported as `.bolts` files. A `.bolts` file can include one bolt or several bolts.

1. On the **File** menu, click **Catalogs --> Bolt catalog** to open the **Bolt Catalog** dialog box.
2. Select bolts from the **Bolts** list.
   
   Use the **Shift** and **Ctrl** keys to select multiple bolts.
3. Right-click in the **Bolts** list and select **Export**.
4. Browse for the folder where you want to save the export file.
5. Enter a name for the file in the **Selection** box.
6. Click **OK**.

**See also**

- Export bolt assemblies from the catalog (page 275)
Import bolt assemblies to the catalog

Bolt assemblies are imported and exported as .bass files. A .bass file can include one bolt assembly or several bolt assemblies.

1. On the File menu, click Catalogs --> Bolt assembly catalog to open the Bolt Assembly Catalog dialog box.
2. Right-click in the Bolt assemblies list and select Import.
3. Select the import file.
4. Click OK.
   The bolt assemblies are displayed on the Bolt assemblies list by their original names.
5. Click OK.
   The Save confirmation dialog box appears.
6. Select Save changes to model folder to save the changes in the assdb.db file in the current model folder, and then click OK.

See also
Add a bolt assembly to the catalog (page 271)
Import a bolt catalog (page 276)
Import bolts to the catalog (page 273)
Export bolt assemblies from the catalog (page 275)

Export bolt assemblies from the catalog

Bolt assemblies are imported and exported as .bass files. A .bass file can include one bolt assembly or several bolt assemblies.

1. On the File menu, click Catalogs --> Bolt assembly catalog to open the Bolt Assembly Catalog dialog box.
2. Select bolt assemblies from the Bolt assemblies list.
   Use the Shift and Ctrl keys to select multiple bolt assemblies.
3. Right-click in the Bolt assemblies list and select Export.
4. Browse for the folder where you want to save the export file.
5. Enter a name for the file in the Selection box.
6. Click OK.

See also
Export an entire bolt catalog (page 277)
Export bolts from the catalog (page 274)
Import bolt assemblies to the catalog (page 275)

**Import a bolt catalog**

Bolt catalogs are imported to Tekla Structures models as .lis files.

1. Open the model to which you want to import a bolt catalog.
2. Copy the screwdb.lis file that you want to import to the current model folder.
3. To import the bolt catalog file screwdb.lis from the current model folder, go to Quick Launch, start typing import bolt catalog, and select the Import Bolt Catalog command from the list that appears. Tekla Structures does not replace the entries that have the same names as the entries in the import file.
4. Check the status bar for error messages.
   To view errors, go to the File menu and click Logs --> Session history log.

See also
Import a part of the bolt catalog (page 276)
Export an entire bolt catalog (page 277)

**Import a part of the bolt catalog**

If you do not want to import the entire bolt catalog, you can select the parts to be imported.

TIP If you only want to import a few bolts or bolt assemblies, use the import and export commands of the corresponding catalogs.

1. Open the model that contains the bolt catalog you want to use.
2. Go to Quick Launch, start typing export bolt catalog, and select the Export Bolt Catalog command from the list that appears.
   The bolt catalog is saved as the screwdb.lis file in the current model folder.
3. Open the `screwdb.lis` file using a text editor, for example, Microsoft Notepad.
   Each entry is listed on a separate row.
4. Delete the unwanted rows from the file.

**WARNING** Do not delete the `STARTLIST` and `ENDLIST` rows.

5. Save the file with the name `screwdb.lis`.
6. Open the model to which you want to import the bolt catalog.
7. Copy the `screwdb.lis` file that you want to import to the current model folder.
8. To import the bolt catalog file `screwdb.lis` from the current model folder, go to Quick Launch, start typing `import bolt catalog`, and select the Import Bolt Catalog command from the list that appears.

**See also**
- Import bolts to the catalog (page 273)
- Import bolt assemblies to the catalog (page 275)
- Import a bolt catalog (page 276)
- Export an entire bolt catalog (page 277)

**Export an entire bolt catalog**
Bolt catalogs are exported from Tekla Structures models as `.lis` files.

1. Open the model that contains the bolt catalog you want to export.
2. Go to Quick Launch, start typing `export bolt catalog`, and select the Export Bolt Catalog command from the list that appears.

   The exported bolt catalog is the `screwdb.lis` file in the current model folder.

**TIP** The Export Bolt Catalog command exports the entire bolt catalog. To export only part of the bolt catalog, modify the export file to contain only the required elements. You can also export bolts from the Bolt Catalog dialog box or bolt assemblies from the Bolt Assembly Catalog dialog box.

**See also**
- Export bolt assemblies from the catalog (page 275)
- Export bolts from the catalog (page 274)
9.4 Bolt length calculation

Tekla Structures uses values from the bolt catalog and the bolt assembly catalog when calculating the bolt length. If the bolt catalog does not contain long enough bolts for your purposes, you need to add them to the bolt catalog.

The following settings in the **Bolt Properties** dialog box affect the bolt length calculation process. If the check box is selected, the part is used in the bolt assembly.

1. Washer (1)
2. Washer (2)
3. Washer (3)
4. Nut (1)
5. Nut (2)
6. If the check box is clear, only a hole is created

The chart and the detailed steps below explain the process of bolt length calculation.
1. Tekla Structures calculates the **minimum possible length** of the bolt as follows:
   - washer (1) thickness (if the check box is selected) +
   - material thickness +
   - washer (2) thickness (if the check box is selected) +
   - washer (3) thickness (if the check box is selected) +
   - nut (1) thickness +
   - nut (2) thickness +
   - extra length

2. Tekla Structures searches for the **closest match** in the bolt catalog.

3. Tekla Structures calculates the **number of washers required** (must not exceed 10) so that the **length of the shaft is less than**:
   - nut (1) thickness +
   - material thickness +
   - nut (2) thickness +
   - washer (1) thickness +
   - washer (2) thickness +
   - (number of washers * washer (3) thickness)

4. Tekla Structures checks that the **bolt found in step 2 is longer than**:
   - extra length +
   - nut (1) thickness +
material thickness +
nut (2) thickness +
add. dist (from the bolt catalog) +
washer (1) thickness +
washer (2) thickness +
(number of fitting washers * washer (3) thickness)

5. If the selected bolt does not fulfill the criteria in step 4, Tekla Structures returns to step 2, otherwise it continues on to step 6.

6. Tekla Structures checks that the selected bolt fulfills **all the following conditions**:

   - Can the thread be inside the material to be connected? Even if this is **not** allowed, the calculation always allows 3 or 4 mm of thread to be inside the material, depending on the bolt diameter. If the bolt diameter is ≥ 24 mm, it allows 4 mm, otherwise it allows 3 mm.
   
   - Shaft length must be more than:
     
     material thickness +
     extra length +
     washer (1) thickness (if checked) -
     maximum thread in material allowed (if thread in material = no) =
     3 mm or 4 mm
   
   - Shaft length is calculated as:
     
     Screw length - screw thread length - thread end.
   
   - Thread end is the part of the bolt between the shaft and the thread. It is calculated as follows:

<table>
<thead>
<tr>
<th>Diameter of bolt (mm)</th>
<th>Thread end (mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;33.0</td>
<td>10.0</td>
</tr>
<tr>
<td>&gt;27.0</td>
<td>8.0</td>
</tr>
<tr>
<td>&gt;22.0</td>
<td>7.0</td>
</tr>
<tr>
<td>&gt;16.0</td>
<td>6.0</td>
</tr>
<tr>
<td>&gt;12.0</td>
<td>5.0</td>
</tr>
<tr>
<td>&gt;7.0</td>
<td>4.0</td>
</tr>
<tr>
<td>&gt;4.0</td>
<td>2.5</td>
</tr>
<tr>
<td>≤4</td>
<td>1.5</td>
</tr>
</tbody>
</table>

7. If the selected bolt does not fulfill **all** the above conditions, Tekla Structures returns to step 2 and tries the next longest bolt.
8. If the advanced option `XS_BOLT_LENGTH_EPSILON` is set, the epsilon thickness is added to, or subtracted from, the material thickness to avoid inaccurate bolt length calculation.

For example, if this value is not taken into account, and the calculated length is 38.001 mm, a 39 mm bolt might be selected.

See also
How the bolt catalog and bolt assembly catalogs work together (page 266)
Add a bolt to the catalog (page 268)

9.5 Bolt catalog properties

Use the Bolt Catalog dialog box to view and modify the properties of individual bolt elements, such as bolts, washers, and nuts. The units depend on the settings in File menu --> Settings --> Options --> Units and decimals.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type of the bolt element. The options are:</td>
</tr>
<tr>
<td></td>
<td>![Image of bolt types]</td>
</tr>
<tr>
<td>Standard</td>
<td>The name of the bolt element standard.</td>
</tr>
<tr>
<td></td>
<td>Used in the Bolt Assembly Catalog dialog box for defining bolt elements in a bolt assembly.</td>
</tr>
<tr>
<td></td>
<td>Use different names for bolt, nut, washer, and stud standards to distinguish bolt element types from each other.</td>
</tr>
<tr>
<td>Diameter</td>
<td>The diameter of the bolt element.</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the bolt element.</td>
</tr>
<tr>
<td>Weight</td>
<td>The weight of the bolt element.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>add. dist</td>
<td>The length of the part of the bolt that protrudes from the nut.</td>
</tr>
<tr>
<td></td>
<td>The value is used in bolt length calculation.</td>
</tr>
<tr>
<td>top thick</td>
<td>The thickness of the bolt head.</td>
</tr>
<tr>
<td>thread len</td>
<td>The length of the threaded part of the bolt shaft.</td>
</tr>
<tr>
<td></td>
<td>The value is not used in bolt length calculation (value is 0) if the bolt is fully-threaded.</td>
</tr>
<tr>
<td>washer tol</td>
<td>The tolerance between the washer inner diameter and the bolt diameter.</td>
</tr>
<tr>
<td></td>
<td>The value is used when searching for the correct-sized washer for the bolt. Not used in bolt length calculation.</td>
</tr>
<tr>
<td>span size</td>
<td>The size of the wrench needed.</td>
</tr>
<tr>
<td>calc thick</td>
<td>The calculation thickness of a nut or a washer.</td>
</tr>
<tr>
<td></td>
<td>This value is used in bolt length calculation.</td>
</tr>
<tr>
<td>real thick</td>
<td>The true thickness of a nut or a washer.</td>
</tr>
<tr>
<td></td>
<td>This is for information only.</td>
</tr>
<tr>
<td>inner diam</td>
<td>The inner diameter of a nut or a washer.</td>
</tr>
<tr>
<td></td>
<td>This is for information only.</td>
</tr>
<tr>
<td>outer diam</td>
<td>The outer diameter of a nut or a washer.</td>
</tr>
<tr>
<td></td>
<td>This is for information only.</td>
</tr>
<tr>
<td>top diam</td>
<td>The diameter of the hexagon.</td>
</tr>
<tr>
<td></td>
<td>This is for information only.</td>
</tr>
</tbody>
</table>

See also

Add a bolt to the catalog (page 268)

How the bolt catalog and bolt assembly catalogs work together (page 266)

### 9.6 Bolt assembly catalog properties

Use the Bolt Assembly Catalog dialog box to view and modify the properties of bolt assemblies. The units depend on the settings in File menu --> Settings --> Options --> Units and decimals.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short name</td>
<td>This name is used in drawings and reports. It is usually the commercial name for a specific bolt.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Standard</td>
<td>This name is the full name which is shown in the bolt assemblies list in the <strong>Bolt Assembly Catalog</strong> dialog box, and in the <strong>Bolt standard</strong> list in the <strong>Bolt Properties</strong> dialog box. The value is used in bolt length calculation.</td>
</tr>
<tr>
<td>Material</td>
<td>The material of the bolt assembly.</td>
</tr>
<tr>
<td>Finish</td>
<td>The type of the finish.</td>
</tr>
<tr>
<td>Grade</td>
<td>The grade of the bolt assembly.</td>
</tr>
<tr>
<td>Tolerance</td>
<td>The tolerances of the bolt assembly.</td>
</tr>
</tbody>
</table>

**Additional length for bolt calculation**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add. dist...</td>
<td>The <strong>Additional Distance</strong> option controls how much of the bolt protrudes from the nut. <strong>Additional Distance</strong> updates the <strong>Additional Distance</strong> values of all bolts that use the selected bolt standard and have the selected diameter. The value is used in bolt length calculation.</td>
</tr>
</tbody>
</table>

![Additional Distance dialog box](image)

1. Select whether the value of the additional length affects all or individual diameters of one bolt assembly.
2. Enter the additional length value.
3. Select whether the value is absolute or relative to the diameter.
See also
Add a bolt assembly to the catalog (page 271)
10 Disclaimer

© 2017 Trimble Solutions Corporation and its licensors. All rights reserved.

This Software Manual has been developed for use with the referenced Software. Use of the Software, and use of this Software Manual are governed by a License Agreement. Among other provisions, the License Agreement sets certain warranties for the Software and this Manual, disclaims other warranties, limits recoverable damages, defines permitted uses of the Software, and determines whether you are an authorized user of the Software. All information set forth in this manual is provided with the warranty set forth in the License Agreement. Please refer to the License Agreement for important obligations and applicable limitations and restrictions on your rights. Trimble does not guarantee that the text is free of technical inaccuracies or typographical errors. Trimble reserves the right to make changes and additions to this manual due to changes in the software or otherwise.

In addition, this Software Manual is protected by copyright law and by international treaties. Unauthorized reproduction, display, modification, or distribution of this Manual, or any portion of it, may result in severe civil and criminal penalties, and will be prosecuted to the full extent permitted by law.

Tekla, Tekla Structures, Tekla BIMsight, BIMsight, Tekla Civil, Tedds, Solve, Fastrak and Orion are either registered trademarks or trademarks of Trimble Solutions Corporation in the European Union, the United States, and/or other countries. More about Trimble Solutions trademarks: http://www.tekla.com/tekla-trademarks. Trimble is a registered trademark or trademark of Trimble Inc. in the European Union, in the United States and/or other countries. More about Trimble trademarks: http://www.trimble.com/trademarks.aspx. Other product and company names mentioned in this Manual are or may be trademarks of their respective owners. By referring to a third-party product or brand, Trimble does not intend to suggest an affiliation with or endorsement by such third party and disclaims any such affiliation or endorsement, except where otherwise expressly stated.

Portions of this software:

D-Cubed 2D DCM © 2010 Siemens Industry Software Limited. All rights reserved.
Index

..clb files..............................................176,177,180

4

4D tool, see visualizing project status...... 140

A

adding
bolt assemblies to catalog............... 271
bolts to catalog.............................. 268
material grades................................ 259
profiles........................................... 172
stud bolts to catalog...................... 269
user attributes to material grades..... 261
user attributes to profiles................. 153
angle dimensions............................ 195
arcs.................................................... 188
assemblies
bolt assemblies............................... 266,271
lotting.............................................. 133

B

bolt assemblies.............................. 271
deleting........................................... 272
exporting.......................................... 275
importing......................................... 275
modifying.......................................... 272
properties........................................ 282
bolt assembly.................................... 266
bolt assembly catalog..................... 266
bolt assembly element...................... 266
bolt catalog...................................... 266
bolts
adding bolt assemblies to catalog..... 271
adding to catalog............................ 268
bolt assemblies.............................. 266,272
bolt assembly catalog..................... 266
bolt catalog...................................... 266
creating studs.................................. 269
deleting from catalog...................... 271
exporting......................................... 273,274,277
importing......................................... 273,276
length calculation............................ 278
modifying bolt information............... 270
box profiles.................................... 225

C

c profiles........................................... 222
calculating
bolt length....................................... 278
cast units
lotting.............................................. 133
catalogs
bolt assembly catalog..................... 266,282
bolt catalog...................................... 266,281
exporting material catalog............... 263
material catalog............................... 257
profile catalog.................................. 149
chamfers
in sketching.................................... 204,211
checking
sketched profiles............................ 202
circles.............................................. 188
circular hollow sections................... 227
circular sections............................. 227
clb, see .clb files................................. 176
coincident constraints..................... 190
cold rolled profiles......................... 228
colors
settings.......................................... 143
components.clb................................. 176
constraints
coincident....................................... 190
deleting.......................................... 193
fixed.............................................. 191
handles of positioning planes ........................................... 200
hat profiles........................................................................ 237
hiding positioning planes................................................... 200
horizontal constraints ..................................................... 192
dimensions ......................................................................... 196

i beams (concrete).......................................................... 238
i beams (steel).................................................................. 219
i profiles........................................................................... 219
image of profile ................................................................ 217
importing bolt assemblies................................................. 275
bolts.............................................................................. 273,276
material grades ................................................................. 262
profiles ........................................................................... 158,159,164
shapes ............................................................................. 252
sketched profiles ............................................................. 164
SketchUp .......................................................................... 255
irregular beams (concrete) ................................................. 242

L
I profiles ........................................................................... 220
ledger beams (concrete) .................................................. 239
length bolt length calculation............................................ 278
locking model objects by phase........................................ 131
lotting ............................................................................. 133
adding parts .................................................................. 134
creating .......................................................................... 134
deleting .......................................................................... 135
removing ......................................................................... 134

M
material catalog, see material grades............................... 257
material catalog exporting.................................................. 263
material grades ................................................................. 257
adding ............................................................................. 259
adding user attributes...................................................... 261
copying .......................................................................... 259
deleting ........................................................................... 261
exporting ........................................................................ 262,263,264
important buttons .......................................................... 258
importing ......................................................................... 262
importing and exporting.................................................. 163
material types .................................................................. 257
modifying ......................................................................... 260
saving changes ................................................................. 258
user-defined material symbols ....................................... 264
models dividing into phases .............................................. 130
modifying bolt assembly information............................... 272
b bolt information ............................................................. 270
cross sections ................................................................. 171
material grades ................................................................. 260
profile with variable cross sections .................................. 216
profiles ........................................................................... 175
rules ................................................................................. 152
sketched profiles ............................................................. 203

N
non-solid ......................................................................... 252
numbering sequences ....................................................... 136

O
object groups example ...................................................... 143
object representation settings .......................................... 143
Organizer .......................................................................... 9
calculating property values ............................................. 19
categories ........................................................................ 34
classification code .......................................................... 86
creating categories .......................................................... 36,41,42,46,49
creating color sets ........................................................... 31
creating custom formulas ................................................. 29
creating custom properties .............................................. 28
creating property templates ............................................. 25
creating subcategories ..................................................... 49
customizing ................................. 56
deleting categories .................. 55
deleting property templates ........ 32
example of creating categories .... 66
example of creating categories for
architectural design................... 93
example of creating categories for
structural design...................... 92
example of Organizer workflow.... 66,92,93,95,97,99
element of tracking object properties. 79
example of using Organizer for precast
management ........................................... 99
example of using Organizer to manage
assemblies........................................... 97
example of using Organizer to manage
bolts................................................. 95
excluding objects......................... 58
export to IFC................................. 86
exporting categories............... 62
exporting object properties.......... 21
exporting property templates........ 33
grouping object properties.......... 17
importing categories............... 64
importing IFC categories............ 65
importing property templates........ 33
missing objects......................... 58
Model Organizer categories........ 65
modifying categories............... 50
multi-user mode......................... 66
refresh ........................................ 58
reload .......................................... 58
reporting ................................. 58
setting units............................. 20
setting up .................................. 56
synchronize ................................ 58
update database ...................... 58
viewing object properties ........... 10
others ........................................ 250

parametric
profiles ....................................... 176
parts
defining the material of profile types. 156
lotting .......................................... 134
sequences ............................. 136,137
perpendicular constraints ............ 190
phases ................................... 130,132
polylines .................................. 187
positioning planes..................... 197,198,199,200
moving .................................... 200
reverting to default .................. 202
profile catalog, see profiles........ 149
Profile cross section from plate (10)........ 168
properties ................................. 169
profiles .................................... 150,258
adding rules .............................. 151
adding user attributes ............... 153
adding user attributes to profiles .. 153
associating with certain material ... 156
converting .................................. 175
copying ................................. 174
creating ................................. 165,172,176,184
creating image of profile ............ 217
defining cross sections .............. 166,168,169,170,171
deleting ................................ 157
exporting ............................... 158,160
fixed ..................................... 149,172,174,175
grouping .................................. 151,152
importing .................................. 158,159
importing and exporting .......... 163
modifying .............................. 175
parametric .......................... 149,176,177,180,182,218
predefined ......................... 218
profile catalog ...................... 149
profile definitions................... 182
Profile Editor ......................... 214
profile export file ................. 161
rules ....................................... 151
saving changes ....................... 150
sketching .................................. 184
user-defined ......................... 165
with variable cross sections.. 213,214,216
profitab.inp ......................... 176,182
properties ..................... 183
project status visualizations ........ 140
copying ............................... 141

panels ..................................... 245
parallel constraints ................. 189
parametric profiles .................. 149,175,216
available in Tekla Structures .... 218
creating ........................ 176,177,180,182,184
predefined ......................... 218

P
creating................................................... 140
deleting................................................... 141
example................................................... 142,144
properties
bolt assembly catalog......................... 282
bolt catalog............................................ 281
DWG profile to library (6)..................... 171
Profile cross section from plate (10)..... 169
profitab.inp............................................. 183
R
radial dimensions.................................... 194
rectangular hollow sections.................. 227
rectangular sections............................. 226
reverting
to default positioning planes............... 202
rules
in profile catalog................................. 151,152
profile catalog rules............................. 151
S
saving
profiles................................................ 150
sketched profiles.................................. 203
sequences............................................ 136
adding parts........................................ 137
creating.............................................. 136
deleting.............................................. 139
inquiring............................................. 138
modifying............................................ 138
settings
bolt assembly catalog properties.......... 282
bolt catalog properties......................... 281
color settings...................................... 143
transparency settings.......................... 143
shape catalog...................................... 252,253,254
shapes
deleting.............................................. 254
exporting............................................ 253
importing............................................ 252
shape catalog...................................... 252
showing
positioning planes............................... 200
sketch editor........................................ 184
sketched profiles.................................. 184
T
t profiles............................................. 223
t profiles (concrete)............................... 240
Task Manager........................................ 103
adding objects to tasks....................... 119
calendar.............................................. 106
creating scenarios............................. 120
creating tasks..................................... 108
customizing........................................ 104
defining additional task information...... 118
defining contractors............................ 110
defining order of objects in tasks........115
defining task dependencies...............117
defining task properties..................111
defining task schedules..................112
defining task types.......................109
exporting.......................................126
filtering tasks..............................121
Gantt chart....................................104
importing........................................124
linking tasks to model.....................119
managing objects in tasks................113
printing........................................126
tracking task schedules..................114
user interface...............................104
user-defined attributes...................109,113
viewing tasks...............................121
visualizing schedule........................127
testing
  sketched profiles.........................202
thickness
  sketch thickness..........................204,210
transparency
  settings....................................143

U
u profiles......................................221
units
  in importing and exporting.............163
unlocking
  model objects by phase...............131
updating
  material catalog.........................258
  profile catalog..........................150
user attributes
  adding to material grades..............261
to profiles................................153
user-defined material symbols
  creating...................................264
user-defined profiles....................165

V
variable cross sections....................213,248
variables
  in sketching................................186
  vertical

W
welded beam profiles.....................223
welded box profiles........................223
wq profiles..................................226

Z
z profiles....................................221

constraints....................................192
dimensions....................................196
viewing
  sequence numbers.........................138
visualizing project status................140